


Innovation Versus Invention

Editorial

“Innovation is
the process of

applying
ingenious

ideas to great
inventions... ”

WHY IS IT that technology
products’ life cycles are
measured only in months?

Why are some of their amazing features
almost impossible to use?

Let’s consider cell phones. Ever
tried to use the acclaimed Web
browsing feature from a cell phone?
Or tried to plug it in to your notebook?
Or ever counted how many clicks and
sub-commands it takes to access the
calendar function on your cell phone?
Tried using it to make a ‘conference
call’? You do know that this feature
exists, don’t you?

Let’s talk about cameras. I am sure
many of you use multi-million pixel
cameras. Once you are back from your
vacation, how do you sort the pictures?
How do you actually know what the
picture contains given that all of them
have cryptic numbers as file names?
Tried to arrange them and make an
album out of them? Or if you are using
a much-vaunted camera phone, should
it not be easier to download these
pictures directly to a wire-free device
that can make prints for you?

Printing should be the easiest task.
After all, how difficult can it be to print
address labels in fabulous 300-dpi
colour at 10 pages per minute?  But
wait. If you want to print directly on
envelopes using Microsoft Outlook’s
contacts list, you cannot do it unless you
first create a mail-merge document—a
task about as easy and enjoyable as
changing the spark plugs on your car
every time you want to start it.

The lesson is that while hardware
and software technology companies are
far more sophisticated today than they
were a decade ago, they have still left
users more confused. They have been so
busy ‘Inventing’ that they have not paid
enough attention to ‘Innovation’.

Innovation is the process of
applying ingenious ideas to great
inventions so that they become usable
by normal people like us. For example
when Tim Berners Lee ‘invented’ the
Internet, it was largely useless to most
of us till innovators like Marc
Andreessen of Netscape, Jerry Yang of
Yahoo! and dozens of others created
applications that opened doors to this
brand new world. It was the
‘Innovative’ adaptation of a simple
hard drive technology that brought us
the iPod.

So let’s hope that this coming
decade is one where Innovation finally
overtakes Invention!

Maulik Jasubhai Publisher
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25 Prototypes Today, Gadgets Tomorrow 
Everyone’s got a dream gadget.
What happens if you put all of them
together?

Enter

16 
We find out
what Boman
Irani has to say
about tech in
his life

16
Intel to get
inside Apple!

20
The state of
broadband
deployment
around the
world

24
Why do we need
dual-core
processors?

Digital Passion

Contents Magazine

96 News You Can Use 
RSS is something everyone seems to be
talking about. So how do you add an RSS
feed to your site?

43 Aim For The Stars
Opportunities in the field of multimedia trans-
formed Ranjana Kanti from a simple housewife to
an entrepreneur in education 

31 Are You Game?
Gaming consoles have outstepped their
conventional domain. We look at what’s
available and for how much, we also peek
under their hoods—the Cell processor,
vertex shaders, the works...

38 Geek Dreams
The Nokia N91 smartphone might be
expensive, but that’s why it’s a dream. It
isn’t the only reason though—imagine a 4
GB hard drive and much, much more

40 Take A Crack
Ever needed to print out the contents of a
directory? If you did, you’ll be glad to know
it can be done with two clicks. But how?
Tell us and you could win!

42 30 Days With...
Our reviewer calls his experience with the
Apple 23-inch cinema HD display one of
the “high points” of his life!

Digital Tools

80 New And Notable
In our list of great products this month is the
Samsung Miniket VP-M110S—a camcorder, digicam,
MP3 player, Web cam, voice recorder and mass storage
device all rolled into one!

46 All-A-Board!
It’s a great time to upgrade your
motherboard. Digit found that budget
motherboards aren’t behind on features and
performance in any way, in a shootout of 36
boards from the best manufacturers

62 Building A Better Website
With PHP-Nuke, it’s easy to build a professional
looking Web site with all the bells and whistles



9JULY 2005 DIGIT

Digital Leisure
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104 Money At The Gates 
With credit cards growing in ubiquity all over
India, the natural step for an online business is
to begin accepting cards online. Find out how

110 Should You IT-Enable Your
Sales Force?
Does your sales force need to be equipped with
technology? We present two differing views 

111 A Think-Tank For Students
Think.com makes learning a fun process,
increases student-teacher-parent interaction
and provides opportunities for collaboration
with their global counterparts

132 Britney Tops Virus Charts 
Panda Software has created a list of famous
people whose names have been used to
spread viruses. Britney Spears now has the
dubious distinction of topping that list

108 Blogvertising, Anyone? 
Is blogging big enough in India for you to seriously
consider advertising on them? And what does the
future look like? Answers to these and other questions...

Digital Business

Escape

117
Meet Bjarne
Stroustrup,
inventor of the
C++ program-
ming language

117
If you find you’re
addicted to
e-mail, you’re
not alone, finds
a study

Three Incredibly Useful Sites ..........18
The Digital World ............................18
Beat That ........................................20
Gender Benders ..............................22
Buzzword Of The Month ..................22

Tips & Tricks ....................................69
Q&A ................................................84
Agent001 ........................................89
Tech Quiz ........................................113 
Mediawise/Adwise ..........................114

Bluff Your Way Through..................118
Digit Diary ......................................118
Blogwatch ......................................119
Digit Forum ....................................130
Inbox..............................................130R
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101 Broad-Basing Management
A management institute, a telecom major and a
high-spped Internet connection is enough to learn
management—no matter where you are in India 
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Area 51 Single Player
Game Demo 
Work your way through the heavily
guarded military installation to
discover the secrets it holds

WebLogic Server 9.0 Diablo Beta
Diablo squarely tackles the most
difficult problems enterprises are
facing today

Anarchy Online
Prepare to immerse yourself in this
popular sci-fi RPG

DEVELOPER TOOLS
■ DevPlanner 2.0.753
■ EditiX 4.0 Build 090505
■ Fusion Professional 3.2

■ Lanap BotDetect for ASP 1.1.2
■ Neuron Java Disassembler 1.0 b7
■ PDF ReDirect 2.0.15
■ SWiSHmax 2005.05.05
■ IDA—The Interactive Disassembler 4.7

GAMES
■ Juiced
■ London Taxi Rush Hour

DIGITAL PASSION DIGITAL TOOLS DIGITAL BUSINESS DIGITAL LEISURE

Adobe
Photoshop 
CS2 Tryout 
The new professional
standard in digital
imaging comes with
an endless selection
of drawing tools

Adobe GoLive
CS2 Tryout
Unlock the power of
CSS objects—drag
and drop to build
sophisticated sites

Dreamweaver
MX 2004
A powerful combo 
of layout tools,
enabling developers
to create powerful
applications

MULTIMEDIA
■ DVD Shrink 3.2.0.15
■ Macromedia Flash MX
2004 Updater 7.2
■ Musicmatch Jukebox
Basic 10.00.2058b
■ Nero Media Player
1.4.0.32
■ RealPlayer 10 Gold Build 6.0.12.1069
■ SuperAVConverter 5.35.660
■ Video Edit Magic 4.08
■ Winamp 5.091 Full
■ iTunes for Windows 4.8

INTERNET
■ Free Download Manager 1.7
■ Google Web Accelerator 0.1.52.58 Beta
■ Opera for Windows with Java 
Opera 7.54u2
■ Maxthon Combo 1.3.1 build 20
■ MSN Messenger 7
build 0813
■ HijackThis 1.99.1
■ MSN Winks Plus 1.00
■ Skype 1.2.0.48
■ Yahoo! Messenger
7.0.0.242
■ Mozilla Firefox 1.1 Alpha 1 RC 
(Deer Park)

SYSTEM
■ Anti Trojan Elite 3.0
■ AntiVir Personal Edition 6.30.00.191
■ Anti-Virus & Trojan 7.02
■ AutoPatcher XP May 2005
■ Buddy Spy 2.1.9a
■ DAEMON Tools 3.47
■ Ewido Security Suite 3.0
■ eScan Corporate Edition 2.6.518.8
■ GMail Drive shell extension 1.0.5
■ Longhorn Transformation Pack 9.0
■ Malware Scanner 2.1.0.9
■ Microworld Anti-Virus Toolkit

Utility 6.2.4
■ Nero Burning Rom 6.6.0.13
■ SpywareBlaster 3.4

AtPresent Editor 1.3.1
Create Flash-based highly interactive
presentations, simulations, demos,
tutorials, and more

Contact
Magnet 2.2.3
build 158
It captures contact
info from e-mails,
Web pages, Word,
Excel, or any 
other document

Easy Flowchart 1.5
Easy Flowchart is
the easy-to-use,
drag-and-drop
software used in
order to create
professional
flowcharts

PRODUCTIVITY TOOLS 
■ Conferral 1.0
■ Inform! 1.0 build 51
■ Graphic Accounts 1.3.186

■ WinPresenter 1.6
■ M-Files 1.016.0
■ OfficeFIX Office Data Recovery 4.11
■ Qurio Home Photo Center 1.4
■ RBackup Remote Backup 8.5

WHITEPAPERS
■ Net in a
Network
■ Bulletproof
Java Coding
■ Connecting 
business-
criticial
applications
across and
beyond 
yourenterprise

■ Concepts to Enhance Web Security
■ Effective Use of Authentication
■ Email Security
■ Microsoft and Java

VIDEOS AND GAMES TRAILERS
Minimum
Overdrive
This cleverly edited
short film is a comedy
where a man is taunted
via a remote control car

Spider-Man:
The Peril Of Doc Ock
This is exciting new
animated short film
commisioned where
lego animated Spider
Man takes on Doc Ock
on the streets of NYC

WALLPAPERS 
■ 100+ Wallpapers

VIDEOS
■ Minimum Overdrive
■ Batman: New Times
■ The Beast Within

■ Spider-Man: The Peril Of Doc Ock.
■ Knights Of The Old Republic II:

Sith Lords

DESKTOP THEMES
■ StyleXP
■ Winter
■ Plastic Silver
■ Shine
■ XP Buttons
■ Abstract
■ Windows Blinds
■ Benchwarmer 1.2 (Chrome)
■ Elfin WB

■ Inspirat Full Start Menu
■ Nuker Blue
■ Tronnix

E-BOOKS
■ C++ From Scratch
■ C/C++ Programming

Style Guidelines by
Fred Richards

■ C++ tutorial for C
users by Eigene
Dateien

■ C++ Unleashed
■ C++ By Example by

Greg Perry
■ Budhism as a Religion by Dr K

Shridhammananda
■ CGI Programming Unleashed
■ Introduction to Structured Query

Language by James Hoffman
■ The Oracle/PL SQL CD Bookshelf

NNoottee::  If you do not want to boot from the DVD, remove it from the drive at startup
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By Demand
You get to choose what goes in Digit
Interactive. This month, you chose:

Area 51 Single Player Demo
Adobe Photoshop CS2 Tryout

Online Digit Patrons
It really does

pay to be loyal!

Find out more

on www.
thinkdigit.com

Digit Reader Poll

This Month’s Question

Will tabbed browsing
in IE7 entice you to
migrate to it?

Yes
No
IE, are you crazy?
I love IE anyways
I don’t use Windows

Log on to www.thinkdigit.com
and vote

July 2005

There’s something for everyone on the Digit Forum www.thinkdigit.com/forum

Last Month’s Question:

How much of a difference do you think
convergence will make in your daily lives?



16 DIGIT JULY 2005

Boman Irani
Actor

Boman Irani has done it
all—fashion photography,

theatre and Bollywood. The
veteran actor’s take on
technology:

What does technology mean
to you?

Whether we like it or not,
technology is all-

pervasive in our lives
today—from the
kitchen to the
home 
entertainment

system. One simply
can’t deny the role it

plays in our daily lives. 

Where do you use
technology the most? 
As a professional, you need to
stay connected, and the mobile
phone is like a lifeline. While I
cannot answer each and every
call, callers can at least reach
me through SMS so I can get
back to them later.  

Do you own other gadgets?
I am not a gadget freak, but I
have a camera phone. I use the
camera feature often—more so
when I am in a certain get-up,
and I would like to store that
image for some other occasion
to show it to my make-up man. 

How often do you surf?
I travel extensively, and surf the
Internet primarily to look for
holiday destinations. 

An instance where
technology has saved lives?  
Undoubtedly, modern
medicine. Surgery is now less
painful and far quicker thanks
to advancements in
technology. Why, you see
people who have undergone
major surgery walking the
very next day!

Funding For Linux-Based OS
A British company, Netproject, will develop a secure Linux-
based desktop OS. The British Department of Trade and
Industry has contributed £132,000 (Rs 1.04 crore) to the
Secure Open Source Desktop programme. A similar sum has
been donated by members of Netproject’s Incubator Club.

Not Mine
Microsoft plans to do away with the ‘My’ prefix in Longhorn.
Longhorn will have just ‘Documents’, ‘Music’ and so on as
folder names. The longstanding tradition of naming the
folders with the ‘My’ prefix was an attempt to create a
personal connection between people and their computers.

Apple’s decision to use
Intel microprocessors

and dump IBM’s PowerPC
chip is the biggest piece of
news in the tech world this
month. While the move
may not have much of an
impact on Intel’s
bottomline, given the fact
that the Mac has just over
two per cent of the world’s
desktop marketshare, it will
definitely be a big boost
to the troubled
chip maker.

The Apple
Mac is viewed
as the über-cool
of the computer
world, and an
alliance with
them will help
leverage Intel’s
position in the
microprocessor
market. The move
will also help Apple
address key
portability issues
that has plagued it
in the past.

At a keynote
address announcing
the PowerPC-to-
Intel transition,
Apple CEO Steve
Jobs revealed that
Apple and Intel will provide
developers with tools to
help port code from the
existing chip architecture to
the new one. 

Apple said it was
making the move to x86
architecture chips because
of more power and better
stability. But according to
experts, one of the main
reasons behind the switch is
IBM’s inability to develop
versions of the G5 chip,

used in Apple’s desktop G5
machines, which are
suitable for Apple laptops
without overheating.
Applications will continue
to work on both types of
chipsets for some years. 

Analysts, though, are
seeing this move as a means
to creating confusion in the
minds of consumers. Some
analysts have suggested that
the transition

could further damage
Apple’s low 2.3 per cent
global market share, while
others argue that this is a
logical decision. Resistance
is also expected from the
Mac fanatic—the hardcore
user of Macs and Apple
Corp. would need to work
overtime to ward this off. 

Market analysts largely
feel this will help Apple
more than Intel. “We are
thrilled to have the world’s

most innovative personal
computer company as a
customer,” said Paul
Otellini, President and CEO
of Intel. “Apple helped
found the PC industry and
throughout the years has
been known for fresh ideas
and new approaches. We
look forward to providing
advanced chip technologies,
and to collaborating on new

initiatives, to help Apple
continue to deliver

innovative products
for years to come.”

Apple has used
IBM’s PowerPC
processors since
1994. It plans to

move lower-end
computers such as the

Mac Mini to Intel chips
in mid-2006, and
higher-end models such
as the Power Mac in
mid-2007. Reports about
a project that
maintained parallel
Apple OSes that
worked on x86
architecture—
codenamed Marklar—
are surfacing and, if

true, would mean that
the transition will be

easier than expected.

HERE, LINUX!

Puppy Linux
For Your PC

Aretired lecturer from
Australia has come up

with the latest morph of
Linux, a distribution of the
Open Source OS that takes
little memory and can 

Enter
PIECE OF THE PIE

Intel To Get Inside Apple 



boot directly off a USB
thumb drive. 

Dubbed the ‘Puppy’
Linux, the OS is one of
dozens of custom and
guerilla variants on Linux
circulating across the
software community. The
developer of the OS, Barry
Kauler, says one of the main
advantages of Puppy Linux is
its simplicity. “When other
distributions start up, you
see all these servers loading,
but in Puppy, it’s really basic,
and bootup is remarkably
fast. However, I still managed
to stick to the requirement
of it all loading into RAM
and freeing up the CD drive,”
claims Kaluer.

Puppy began as a hand-
built distro, which Kauler
pieced together file by file.
“For example, my unique
printing system uses PDQ
and the Gimp-print IJS
drivers, but is tied together
with my own Printer
Wizard, written in Ash,”
Kauler said. (PDQ is a print
utility; Gimp is an image-
manipulation program) 

FOX IN DEER’S CLOTHING

Preview To
Firefox 1.1
Released

The Mozilla Foundation
has released the first

preview of Firefox 1.1,
dubbed ‘Deer Park Alpha 1’.
The name ‘Deer Park’,
according to the
Foundation, is to ward off
end-users from
downloading and trying the

early version. The alpha is
aimed at developers,
particularly those who
create plug-ins—called
extensions in the Firefox
world—to enhance the
browser. Several release
candidates, including one
posted prior to a recent
three-day weekend in the
US, led to the release of the
alpha version. 

“Deer Park has been
made available for testing
purposes only, with no end-
user support,” Mozilla
wrote on its site. “If that
sounds scary, you’d
probably be better off with
the latest final release
Firefox 1.0.4.” 

Among the visible
changes in Deer Park is a
‘sanitise’ tool that deletes
all evidence of browsing.
Other enhancements
include image thumbnails
on tabs, and a revamped
‘Options’ dialog box. 

Those ready to ignore
Mozilla’s warning can
download the Windows,
Linux, or Max OS X versions
from the foundation’s site.
The final Firefox 1.1 aimed at
end-users will be available in
July, according to
information on the Web site.

CHIPPING AWAY

A Supercomp
Sans Micro-
processors 

An experimental
supercomputer

constructed from hardware
that can reconfigure itself

to tackle software problems
is being built by researchers
in Scotland. The system
under construction at the
Edinburgh Parallel
Computing Centre at
Edinburgh University will
use Field Programmable
Gate Array (FPGA) chips
instead of conventional
microprocessors.

FPGAs can be
reconfigured using software
to mimic computer
processing equipment that is
physically designed to take
on specialised tasks. In
contrast, conventional
microprocessors are
designed to act as fixed,
general purpose processing
devices. Each FPGA chip
consists of a block of
programmable logic gates
that can be electronically
organised into different
types of circuits.

Pooja Wadhwa, Mumbai
Harsh Unadkat, Mumbai

Tabbed
Browsing In IE
The upcoming IE7
is supposed to
have the tabbed
browsing feature,

and now, it turns out that you
can have tabbed browsing in
IE6 itself. Tabbed browsing
has long been a feature of
Safari, Firefox, and Opera.

The Need For
The MSN
Toolbar!
Tabbed browsing is available
within IE6 only through the
MSN Search toolbar. You need
to download it and install it
for tabbed browsing to work—
not to mention that you need
to keep it installed!

“Speed up the release of Longhorn”

“Stop working”

Kanchi Gandhi, Mumbai

Vinod Darole, Nashik
“Make Microsoft Open Source”

Rohit Rangnathan, Chennai
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Security Watch
Frame Injection
Vulnerability
The problem
A seven year-old type of
vulnerability has been
inadvertently re-introduced in
the latest versions of several
browsers. The flaw could be
used by hackers or potential
fraudsters to spoof the contents
of Web sites, according to
security alert firm Secunia. The
security bug is “moderately
critical”, Secunia says. It stems
from a failure to check if a
target frame belongs to a
particular opened Web site. This
allows one browser window to
load content into a named
frame of another window.

Opera, Mozilla, Firefox, IE,
Safari and more are all
affected.

The Damages
If the contents of a Web page
are ‘spoofed’, you could be
misled into thinking that the
content belongs to a different,
more trusted site. Successful
exploitation allows a malicious
Web site to load arbitrary
content in an arbitrary frame in
another browser window
owned by, for example, a
trusted site. This might lead
you to give out personal details
that will fall into the wrong
hands, for example, or believe
something that’s not true.

Precautions
Secunia has a test so you can
check if your browser is affected.
The test is at http://secunia.
com/multiple_browsers_frame_inj
ection_vulnerability_test/

If your browser is affected,
there’s not much you can do
except wait for a patch and
browse only trusted sites.

One Silly Question

“Make a software that iscompletely bug-free”

What would you do if you were to become Microsoft’s CEO for a day?

“Spend as much money asI can!”
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For nerds and for the rest of us

NNeerrddwwoorrlldd..ccoomm
This is a Web site about nerd culture
for the burgeoning nerd community.
Nerdworld.com celebrates nerd
lifestyle and popular culture, including
nerd work, fashion, dating, cooking,
sports and entertainment. The site also
features nerd chat rooms and
assemblies, nerd IQ tests, calendar
services, and even a nerd store!

HHyyppeerrddiiccttiioonnaarryy..ccoomm
This site provides free dictionary
services, and has a neat interface. The
English Dictionary contains 150,000
terms with examples, synonyms,
antonyms, and related words. The
Computer Dictionary consists of almost
14,000 computer-related terms. There
is also a Thesaurus, Medical Dictionary
and even a Dream Dictionary! 

PPccsshhoowwaannddtteellll..ccoomm  
Get ‘answers on the fly’ with this site,
one of the largest multimedia libraries
out there with over 40,000 animated
voiced tutorials on more than 100 of
your favourite software applications.
The small (average filesize is 100k) and
quick multimedia tutorials provide
task-specific application help in one-
minute modules. All this for only $30
(Rs 1,300) a year! 

www.hyperdictionary.com

www.pcshowandtell.com 

www.nerdworld.com

The supercomputer will
be more powerful and
efficient than a
conventional system of
similar physical size. If it
can be made easy enough to
program, the researchers
behind the machine say it
could usher in a new
generation of compact and
energy-saving
supercomputers over the
coming decade.

Conventional
microprocessors consume
thousands of watts of power

and require specialised
cooling. Once configured, a
FPGA chip is faster, smaller
and less power-hungry.

The researchers at the
Centre are building a
computer that will
incorporate 64 FPGA
processing units and would
be capable of operating at 1
teraflop—one trillion
mathematical operations
per second, a fairly modest
speed by modern
supercomputing standards,
as the fastest machines can

operate at hundreds
of teraflops. 

However, the
Edinburgh system
will be up to 100
times more energy-
efficient than a
conventional
supercomputer of
equivalent

computing
power. The 64-
node FPGA
machine will

also need only
as much space

as four
conventional PCs,
while a normal 1-
teraflop
supercomputer
would fill
a room.

A Round-up Of Technology News From Across The GlobeThe Digital World
UNITED STATES

Three Incredibly Useful Sites

Microsoft is cooperating with the Chinese
government to censor the company's newly-
launched Chinese-language Web portal, a
spokesman said. The policy affects blogs created
through the MSN Spaces service, said Adam Sohn, a
global sales and marketing director at MSN.

SOUTH AFRICA

The country is about to
embark on its biggest hi-
tech training and job
creation push yet, with the
unveiling of the McKinsey
report into call centres. It
predicts that South Africa
can create 1,50,000 jobs in
the next three years if it
does what’s necessary to
lure outsourcers.

AUSTRALIA

IT is not hot in Universities
any more. Queensland's
Bond University has axed
its IT faculty in a move
reflecting a massive down-
turn in demand for
computing courses at
universities around
Australia. Applications for
IT courses have fallen by
almost 50 per cent in
some states.

MALAYSIA

In Malaysia, broadband is
practically a pre-requisite
for tech-savvy tourists.
Renovation and re-branding
to include trendy features
and facilities such as
broadband facilities, new
dining concepts, and spa
facilities are amongst the
measures local hotels are
looking at to enhance their
competitive edge.

GERMANY

For good Catholics, the search
for a spouse is like looking for
a needle in a modern haystack
of divorce, adultery, and
permissive social values. In
Germany, help is on the way in
the form of an online dating
portal, www.kathTreff.org.
Members thinking about
marriage fill in details such as
typical alcohol consumption
and even favourite saint!

UNITED STATES

eBay is no longer the domain of
the tech-savvy or even those with
a computer. Now, all you need is a
way to get to Melanie Meyers'
QuikDrop eBay store in Dallas,
which proudly proclaims under its
title: "We sell your stuff on eBay."

Illustrations Harsho  Mohan Chattoraj



But figuring out how to
make the FPGA chips work
together efficiently
represents a challenge.
FPGA hardware is more
difficult to program,
because a programmer
must understand how to
tweak the underlying
hardware to get the most
out of it. Once built,
designers will attempt to
transfer existing
supercomputer programs
onto the new hardware. 

BROADENING HORIZONS

Broadband
Around The
World

According to a recent
survey by research firm

eMarketer, South Korea is
the world’s biggest user of
high-speed Internet, and
China could soon overtake
the US with the greatest
number of high-speed
households. The research
firm said South Korea had
73 per cent of its Web users
utilising broadband
connections.

The US still had more
broadband households, at
34.3 million. The report
suggested that China would
soon be the top broadband
country in terms of total
households, even though
only 6.5 per cent of its
households have high-speed
connections. China, the
study said, had grown from
four million broadband
households in 2002 to over
23 million in 2004.

In percentage terms,
South Korea was followed by
Hong Kong, with 59.1 per
cent having high-speed
connections, Taiwan (50.8
per cent), Canada (42.7 per
cent), and The Netherlands
(41.3 per cent). The US
ranked 11th in percentage
terms at 29.9 per cent.

HARDWARE AT E3

Gadget and
Gizmo
Gazing (G3)

This year’s Electronic
Entertainment Expo (E3)

saw Playstation 3, Nintendo
Revolution and the Xbox

360 grab all the headlines.
However, these high-end
gaming consoles will be
released only much later.
While we await their
release, we felt we’d take
you on a tour of some other
eyeball-grabbing hardware
on show at E3.

Gizmondo: The handheld
gaming console battle has
been a slugfest between
Sony’s PlayStation Portable
and the interactive
Nintendo DS. However, the
Gizmondo from Tiger
Telematics will be a serious
contender if it delivers on
its innovative promise. 

The gizmo looks to be
the all purpose Swiss-Army
knife of handhelds with its
blend of technology that
includes GPS satellite
tracking, a digital camera
and a gyroscope. To add
to its repertoire, it
also plays digital
music, movies
and video
games on a
2.8-inch
colour
screen.
Already
available in
Europe, this

nifty console retails at
almost $230 (Rs 10,000).

Theater Experience PSP: 
The Sony PSP is an excellent
portable gaming and movie
viewing console. However,
the rapid battery drain and
poor audio are issues that
will frustrate any user. 

The Theatre Experience
PSP from Nyko Technologies
is out to remedy these
problems. The device
provides an extra five hours
of battery, boosts the PSP’s
tinny audio with a robust
set of stereo speakers, and
all this comes wrapped in a
flip-open aluminium
carrying case. 

One of the most
welcome inclusions is the
least techie: an adjustable
stand. No more straining

Pulse

Photograph Jiten Gandhi

Last Month’s Winner!
Vikas Gupta, Kota, Rajastan
“Boot polish, now in prepaid!”

e-mail your captions with
subject ‘Beat That’ and postal
address to
beatthat@thinkdigit.com
and win the 
Family UtilityCD 
from Numeric 
Power Systems Ltd

Every month, Digit will carry a caption for a photo. Come up with something funnier, 

and beat the Digit team at their own game!

Digit Caption
“Crash Testing Longhorn”
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your wrists trying to hold
the PSP at just the right
viewing angle for hours.
Launched in June, it costs
about $70 (Rs 3,050).

PowerPlay 5.1 Media
Chair:
Empower Technologies
PowerPlay 5.1 Media Chair
will make you hate your
office desk. As the name
suggests, the chair is the
centre of a surround sound
stereo system that’ll make
those shots fired in Doom 3

pierce your heart! The
setup is a prototype, and
the black and tubular
metal piece of furniture is
unlikely to be seen
anywhere but in the most
macho of bachelor pads.

Logitech Cordless:
Precision/Attack Controller
Gaming consoles with
wireless controls is old
news. Now two new
offerings from Logitech
bring the affordable
freedom of wire-free

gaming to the PlayStation 2
and Xbox. The semi-
translucent blue $30 (Rs
1,300) Precision is
compatible with the PS2,
while the see-through
green $40 (Rs 1,740) Attack
works with the Xbox. So
what’s new about the old
news? Logitech says the
Precision and Attack will
last 300 hours on just two
AA batteries. 

Saitek Pro Gamer
Command Pad:
This $40 (Rs  1,740) keyboard
ad-on will appeal to all the
fans of first-person shooters,
or any computer game
where you’ll need a nimble
keyboard to get around. The
accessory looks like a
separate numeric keypad
with a special thumb rest
however calculating is not
what Saitek have in mind
when they designed this
toy. The keys are laser-
etched and glow blue,
which should make it easier
to see what keys are being
frantically pounded during
those intense, late-night
Doom 3 battles.

SMALL GETS SMALLER

Nanotech
Gets Real

Engineers from Canada
have created the world’s

smallest transistor in which
electricity flows through
a molecule.

The device, which is
visible only through a
powerful microscope, may
be the biggest development
in nanotechnology so far.

“It’s a big step forward.
It could never have been

said before with certainty
that a molecule could be a
building block and now
there’s no doubt,” Robert
Wolkow, head of the
research team at the
University of Alberta, said.
The team’s results have
appeared in the scientific
journal Nature.

Wolkow’s gizmo consists
of one to 20 molecules
anchored to a silicon wafer,
and is nearly a thousand
times smaller than
conventional transistors—
and requires about a
millionth as much energy.

The breakthrough is the
result of five years of intense
work by Wolkow and his
colleagues. It took this long
to figure out how to line up
the molecules and the small
electrodes and control the
flow of electricity.

However, consumers
won’t find this microscopic
transistor in their desktops
any time soon as it takes
several minutes to turn the
processor on or off. To be
useful in a PC, it would
need to make the switch in
less than a microsecond.

NOW, PREMIUM PACKAGES

More To
Skype About

Skype, the much talked
about VoIP provider on

the Internet today, has
announced two premium
services. Currently, the
software lets Internet users
call one another for free
anywhere in the world and
works on the P2P model.

The premium packages—
SkypeIn and Skype
Voicemail—are built into the
latest version of the software,
available for the Linux, Mac
OS, Pocket PC and Windows.

GENDER 

BENDERS

Rahul, a law student, is confident and raring to go. First, he
right-clicks the desktop, and opens the 'Display Properties'
dialog box. Under the 'Desktop' and 'Appearance' headings,
Rahul hunts for an option that will enable him to conceal all
the desktop icons. Not finding any solution there, he
performs a series of rapid right-clicks on the desktop. Soon
enough, he deselects the 'Show All Icons' option. Well done
Rahul - just a tad late!

Vipra Guneta v/s Rahul Jindal  

Hiding All The Desktop Icons

1 min 
40 sec

1 min
20 sec

A collegian, Vipra looks very much at ease. She goes to the
Start Menu, then 'Programs', and enters the Control Panel.
Next, she clicks the 'Display' icon, upon which the 'Display
Properties' dialog box comes into view. After clicking the
numerous options to no avail, she exits the Control Panel. Vipra
remains undaunted, and finally right-clicks the desktop, goes
to 'Arrange Icons By', and deselects the option 'Show All Icons'.
Voilà, the desktop is icon-free, and Vipra smiles serenely. 

The Pentium D, the currently most-talked-
about processor by Intel, is a dual-core

processor for use mainly in desktop PCs. The
Pentium D does not support HyperThreading.

Complete with hardware DRM capabilities,
the new chip helps add support for surround-

sound audio, high definition video and
enhanced graphics. At the bottom of the pile is
the Pentium D 820, which runs at 2.8 GHz. Next
up is 830 at 3.0 GHz, and then there's the 840,
running at 3.2GHz. As an indicator, the PD 830
retails for $316 (Rs 13,750).

Pentium D
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The company already
has the SkypeOut feature
for making calls from
computers to regular
phones, which costs less
than 2 cents (Rs 0.87) a
minute. SkypeIn allows
incoming calls. With
SkypeIn, users get a
regular phone number and
can receive calls from a
landline or mobile phones
without having to pay
roaming charges.

Skype Voicemail lets
users receive a voice-mail
message up to 10 minutes
long from any user or
traditional phone.

According to Niklas
Zennstrom, CEO and co-
founder, both packages
would give family members
and friends of Skype users,
who are not connected to
the Internet, a way to
interact with them. 

The number of
downloads for the free
software has crossed 100
million, with more than
two million people using it
at any given moment.

Skype, based in
Luxembourg and founded in
Sweden, said SkypeIn will
cost $13 (Rs 565) for three
months and $40 (Rs 1,740)
for a year. A Skype Voicemail
subscription costs $7 (Rs 305)
for 3 months and $20 (Rs
870) for the year.

In related news,
unconfirmed reports
claimed that Yahoo Inc. was
planning on a merger or a
complete takeover of Skype.

FLASH ME AGAIN!

Macromedia
Unveils
Flash
Platform

Macromedia unveiled
the Macromedia Flash

Platform for delivering
effective experience for rich
content, applications, and
communications across
browsers, OSes and devices
of all kinds.

The Flash Platform is a
complete system, including

a universal
client
runtime, an
openly-
published file
format (.SWF)
specification, a
programming
model, developer
tools, integrated
solutions, and the
support of major
systems
integration
partners, ISVs, and
OEMs. A host of
third-party tools
and solutions
based on the Flash
platform leverage
the platform, such
as SAP NetWeaver
Visual Composer. The Flash
platform enables
differentiated experiences in
a variety of vertical markets.

The company also
previewed the next
generation of Macromedia
Flash Player, now in beta.
Code-named Maelstrom, the
updated player will
dramatically improve Flash
expressiveness and
performance. It will further
strengthen the Flash
Platform with improved
font display and a new,
higher-quality video codec.
Maelstrom will be available
for public download later
this year. 

TICKET TO SAFETY

Microchip In
The Passport

The German government
is using highly secure

chips developed by Infineon
Technologies in an effort to
make counterfeiting and
unauthorised use virtually
impossible in future
electronic passports, which
the German Passport Office
intends to issue starting
November 2005. 

Infineon will also be
supplying a special chip
package developed for
identity cards and
passports as well as the
inlay containing the
antenna and its connection
to the chip.

In the new electronic
passports, printed
information about the
holder’s identity—such as
name, date of birth and
photo, and the validity
period and number—will
also be stored in encrypted
format on a chip. 

Moreover, from March
2007, fingerprints of the
bearer’s index fingers will
also be stored in an
encrypted form. Plans to
invisibly integrate the chip
into the front cover are also
being discussed.

The data stored on the
chip can be accessed only
when the passport is
opened. This data is then
transmitted to an
authorised and certificated
read-write device. 

Over 50 individual
security mechanisms
integrated into the chip
technology will help ensure
that personal data is
protected against
unauthorised read-out and
manipulation. 

The German company
Bundesdrückerei will be
producing the passports
and providing the necessary
infrastructure including the
background system and
even the reading devices.
Infineon Technologies is
one of the two
semiconductor suppliers for
the German passport.

Compiled by Aditya Kuber,
Mithun Kidambi, Ram Mohan Rao

and Renuka Rane

Dual-core Processors

What are dual-core
processors?
A dual core processor is
two processor cores on one
die, essentially like having
a dual processor system in
one processor.

How will shifting to dual-
core help?
The problem with winding
up clock speeds is heat.
High heat means errors.
The heat comes from
power. It takes a lot of juice
to crank up a processor to
high clock speeds and a
processor with that much
electricity running around
the die is prone to
electrical noise, akin to
interference. The pathways
on a processor are very
close together. More power
running through these
pathways means there will
be electrical radiation from
one pathway to the next.
This leakage could corrupt
the data, and corrupted
data means errors.

Where can I find a dual-
core processor?
Expect to see dual-core
desktops in India soon! 

Why do we need dual-core
processors?
A properly-configured dual-
core system will react quicker
when lots of applications are
running simultaneously. The
OS can manage which
applications are sent to which
processor core—so if one core
is encoding a TV show, the OS
can send your command to
open up a Web browser to the
second CPU core. In short, a
dual-core processor will make
your PC multi-task better.

When was the first dual-
core processor launched?
The first dual-core processor
was IBM’s Power4 chip 
in 2001, beating Intel’s
Pentium Processor Extreme
Edition 840 by a few days.

Who manufactures dual-
core processors?
Most major chip
manufacturers, including
AMD and Intel, are in the
dual-core race.

Pulse
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Fuelling the pursuit of technology knowledgeApple 23-inch
Cinema Display

Nokia N9138
Passion
Digital

Are You Game?31 42

Tomorrow

Prototypes Today,
Gadgets Tomorrow

Robert Sovereign-Smith

he lines between functionality
of gadgets are being blurred.
Remember the days when savvy

executives were seen walking around
with so many gadgets strapped to

their belts that they looked more
like handymen than execu-

tives? A walkman for aural
entertainment on the move,

a pager to keep in touch
with the office and a dig-
ital diary to store their
contacts…

Fast forward a few
years into the present,
and the story isn’t too
different. MP3 players
are about the size of a
matchbox, and a lot
easier to carry around
than the huge
walkman of yore.
Pagers are passé, as the
latest mobiles come
equipped with cam-

eras, address books and
basic PDA functionality. 

An addition has been
the laptop, which is a lot

bigger than anything we
would carry around earlier,

but about as essential to our
fast-paced lives as our kidneys.

In essence, we’re having to
lug around a lot more gadgets, and

as a result, more weight than we did
before. Hopefully, this won’t last for

long and technology will find a way to
bring relief to our aching backs.

As always, the technology that we find cool today will hardly be given a glance tomorrow. 
Digit plays soothsayer and predicts what the personal gadget of the near future will look like...

T

Imaging Shyam Shriram Photgraph Jiten Gandhi
Model Sidharth Shukla JULY 2005 DIGIT



What’s New?
We still have the demarcations of products:
PDAs are still mainly PDAs, laptops are just
being segregated into tablet PCs and laptops,
but cell phones, however, are anything but just
plain cell phones today. Recently, cell phone
manufacturers seem to have caught the inno-
vation bug, and no one is complaining. If any-
thing, we wish the rest of the segments would
start innovating just as much.

This doesn’t mean that the big names in
technology have been sitting idle, churning
out boring gadgets. In fact, there are some very
exciting products scheduled to hit the markets
soon, or at least prototypes of gadgets con-
jured up by creative minds. Let’s take a look at
some cool gadgets that we think have the
potential to make it big.

BenQ’s P50
This PDA phone is 120 x 60 x 20 mm large and
weighs a mere 170 grams. It sports a 240 x 320
pixel touchscreen that displays 256K colours.
The OS is Microsoft Windows PocketPC 2003.
From the cell phone angle, it is quad-band (GSM

850/900/1800/1900), has 64-channel polyphonic
ringtones, supports GPRS class 10, MMS, infra-
red, Bluetooth, WAP 2.0, and a Li-Ion battery
with a standby time of 100 hours.

In terms of PDA functionality, it has hand-
writing recognition, inbuilt 64 MB memory,
SD/MMC slots, JAVA for downloadable games, a
USB port, 1.3 megapixel camera with a top reso-
lution of 1280 x 960 pixels, video capture, photo
album, MP3/MPEG-4 player, Wi-Fi, and not to
forget, the QWERTY keyboard.

If recent trends are anything to go by, this
device will fit right in when it is finally released.
As you can see, cell phones are becoming much
more powerful than ever before.

Samsung’s SCH-V770
It’s a phone with a camera! No, it’s a camera
with a phone… the argument continues, espe-
cially here at Digit. Whatever it is, it’s both, a
cellular phone as well as a camera—and a good
one at that!
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The phone boasts of a 7-megapixel camera
with 3x optical zoom and 5x digital zoom and
autofocus, and yes (finally!), a flash as well. In
fact, it’s the inclusion of the flash that’s got
people at Digit arguing over whether it’s a
camera-phone or a phone-camera. 

The camera supports the attachment of
teleconversion and wide-angle lenses—a first
on a phone, for sure. It offers a host of other
camera features, including manual control of
focus and focal length, shutter speeds, control
over exposure times and auto exposure
locking, and advanced features such as aper-
ture priority and shutter priority.

It also records video at QVGA resolution (16
million colours) at 15 to 30 frames per second,
and has a TV-Out connector so you can view
both, stills and movies with the family.

From the phone point of view, it’s pretty
standard—CDMA, 64-channel polyphonic ring-
tones, and so on. It also throws in an MP3 player
and a card reader!

Somehow, one gets the feeling Samsung is just
showing off their technical prowess by making
this gadget—not that anyone’s complaining, right? 

The BenQ P50 proves that
upcoming devices will be much
more than just ordinary cell phones

Nokia’s Internet Tablet PC is a step in the right direction, proving that the majority of
functions we do on the Internet don’t need a PC, or even a keyboard!

Samsung’s SCH-V770 will hardly be noticed as a phone, but does prove that high-
end cameras and mobile phones can be integrated as a sigle product



Nokia’s 770 Internet Tablet
This product is hardly a prototype as it’s avail-
able for purchase, but it’s a worthy mention
when talking about truly mobile gadgets.

The 770 boasts of 64 MB of DDR RAM and
128 MB of Flash memory (64 MB available to
users), and a 64 MB RS-MMC card. The dimen-
sions are 141 x 79 x 19 mm, with an 800 x 480
resolution touchscreen that can display 65K
colours. At 230 grams, it can hardly be consid-
ered heavy, and the black and matte silver
colour add style to its looks.

The OS is Linux-based Internet Tablet 2005
software edition. Applications bundled are a
Web browser, Flash player 6, an e-mail client,
a news reader, media players, an image reader,
file manager, PDF viewer, notes, sketch, games,
a calculator, and a clock. The playback of most
audio and video formats such as MP3, Real
Audio, MPEG4, AAC, WAV, AVI, MPEG1, MPEG4,
Real Video etc. are supported by the tablet.

It also supports popular image formats
such as JPEG, GIF, BMP, TIFF, PNG, Animated
GIF, SVG-tiny, and ICO.

It connects to your phone via Bluetooth,
and to a WLAN using Wi-Fi. It also connects
directly to your PC via USB, and offers a 3.5 mm
stereo output for audio. Overall, if surfing the
Net and checking your mail wherever you are
is something you just have to do, this is the
answer to your prayers.

Polymer Vision Rollable Display
Polymer Vision, a sort of subsidiary of Philips,
already has a product called PVQML5, which is
an ultra-thin (0.1 mm) QVGA (320 x 240 pixel)
monochrome display. It measures about 5
inches diagonally, and has only four grey levels,
but it’s a step in the right direction. 

There are already talks of mass producing
e-newspapers using this technology—connect
the display to the Net using a mobile phone,
and you get news content from your favourite
sources delivered to you, which you then read
like a regular newspaper.

E-Ink Corp’s (pioneers of paper displays) bi-
stable electrophoretic display effect is used
here, and this results in minimal power usage
by the display—ideal for mobile displays. The
contrast is high (10:1) which provides ideal
reading conditions, even under direct sun-
light. It’s slated to hit the production lines in
less than two years.

The ideal scenario for rollable display
implementation is in mobile devices that
require larger screens at times, such as when
viewing Web pages. Mobile devices can
increase display size on demand, and the
larger rollable display adds no weight or
dimensions. It doesn’t affect the device’s
power consumption either.

Such displays could also be used to make
stand-alone products. Think of a pen that rolls
out a display on which you can read stored e-
books, or perhaps even connect to a phone
using Bluetooth and download and view your
favourite e-books. And you need not worry
about your screen cracking, no matter how
often you drop your gadget! 
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Polymer Vision is working on larger
screens with colour capabilities and also a
touchscreen option—they aim to make all
this available at affordable prices. We can
easily imagine a smartphone that contains
one of these screens: just unroll the screen,
watch your favourite movie, and then roll it
back up and return to business on your
phone’s small screen!

Digital Passion l Lead Feature

Polymer Vision’s Rollable Display will break the shackles that gadget designers 
have had to endure, due to the limitations imposed on them by current generation
display technologies
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ICUITI’s V920 Display
Another form of display that has been around
for some time now, but just doesn’t seem to
have caught the fancy of geeks, is the wearable
display, or eyewear display. 

The concept is simple—just create a virtual
display in front of your eyes using spectacle-
like devices. As a result, various wearable dis-
plays offer various virtual screen
experiences—from the effect of a 17-inch dis-
play viewed from three feet away (the weirdest
we could find) to a 105-inch display viewed
from 10 feet away. We chose ICUITI’s products
only because their V920 display was chosen as
an Innovations 2005 Design and Engineering
Honouree, in the Personal Electronics Cate-
gory, at CES 2005.

The V920 connects to almost any video
source, using one of multiple cables provided.
It also features stereo headphones to offer you
both audio and video privacy when worn. It
claims to offer a viewing experience equivalent
to watching a 42-inch LCD monitor from 7.5
feet away. It weighs just 100 grams, and bun-
dles a controller weighing about 110 grams
(with batteries), which is used to set typical set-
tings such as brightness and contrast, and
volume for your headphones, and also connect
to your DVD player, game console, laptop or PC.

The displays are dual 640 x 480 resolution
backlit LCDs, with independent focus for left
and right eyes. The set can also be worn over
prescription spectacles, and the controller
uses 2 AA cells. When connected to a PC via

USB, it is powered by the USB port, so no bat-
teries are needed in this mode. 

Overall, this gadget seems great for home or
indoor use, but we doubt anyone would be
caught dead wearing these on the street, even
though they offer a 15-degree tilt for a non-
immersive view. 

What’s New Tomorrow?
Sure, we were salivating when we were reading
up on all these cool gizmos and technologies, but
something was missing. That’s the whole
problem actually—something’s always missing. 

When you see a cool smartphone with a
7-megapixel camera, PDA functionality, a hard
drive bigger than what desktops had five years
ago, and a mobile CPU faster than what was on
that same five-year old PC, you still end up
saying, “I wish it had a notebook’s function-
ality!” We’re geeks, and we’re happy to admit
that we’re never satisfied!

Well, whether any manufacturer bothers
to listen or not, we decided it’s OK to dream.
We sat down and tried to come up with our
dream gadget, or more correctly, every geek’s
dream gadget.

We called our gadget GOD. Now, before you
get all righteous, start screaming blasphemy, and
damn us to eternal torture in hell, you should
know that GOD, here, is an acronym for ‘Gadget
of Our Dreams!’

We decided we needed a gadget that obvi-
ously had the functionality of a cell phone,

This is not a real product! It’s Philips Polymer Vision’s idea of what their research aims
to accomplish. We hope to see such devices in the future, with light rollable
touchscreen displays that enhance the functionality of gadgets

ICUITI’s V920 Display has finally made the concept of virtual displays a reality. This is
another way of setting free the creativity of gadget designers—they no longer need to
worry about displays, and can focus on better, compact designs
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because mobility is pointless without communications. The
next thing we decided we needed was PDA functionality,
because things like address books and e-mail need to be avail-
able on demand and easily—as they are in PDAs. Then we
decided to get greedy, and wanted laptop functionality as well,
because, well, why not?

It would be nice to have a gadget that gave you the quick
usefulness of a PDA, but when required, would let you open
up Photoshop to edit the image you just clicked, or play your
favourite games! And while we’re adding a laptop, we thought,
“Oh what the hell, why not make it a tablet PC as well…”

GOD
We decided that GOD should be no bigger than a current PDA—
after all, why would anyone want to lug around a device any
larger than that in the first place? So the dimensions were
fixed at a maximum of 140 x 100 x 30 mm (h x w x d). We really
don’t like the idea of holding up such a gadget to our ears in
order to use the cell phone functionality, so the first thing we
did was add a Bluetooth headset. Ironic that we started on the
bundled goodies even before we started designing the device
itself, isn’t it?

Now that we had settled on how it would be used as a
phone, we decided we needed to have a look at the front facia.
Number keys were a must, and if it was going to be a PDA as
well, screen area was worth its space in gold. We decided to
offer most of the front face as a screen, no buttons at all.

This is an imaginary scenario, so we decided that batteries
are supercharged, and can last for days, even with the screen
and Bluetooth turned on all the time. Also, storage is not a
problem, as the device uses a non-volatile RAM/HDD (see
www.atomchip.com).

So we designed the front display to have two modes:
phone and PDA. In phone mode, the display is divided in two,
with one part displaying virtual QWERTY or number keys,
which can be used as normal keys thanks to touchscreens,
and the other part acting as the regular phone display. Only
when required, would GOD switch to PDA mode. Now the
problem was that we needed a trigger for this to happen.
Sure, we could just add a PDA mode virtual button, but that
wasn’t cool enough.

We decided that apart from adding a PDA mode switch into
the phone menu, we would also add a trigger in the stylus
mechanism—pull out the stylus, and GOD switches into PDA
mode. Cool, isn’t it? 

Gadget of Our Dreams—GOD! Here you can see GOD in phone mode.
Those buttons aren’t real buttons, instead they’re just images of 
buttons on the touchscreen display
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Pictures, we decided, could be clicked only
when in PDA mode, using the 5-megapixel
camera-PDA mode offered the best area for the
LCD viewfinder.

Someone pointed out that we needed to think
of what would happen if you got a call when in
PDA mode, so we decided that the calling number
would blink on one corner of the screen, and you
could choose to either switch back to phone
mode or just take the call using your Bluetooth
headset. Simple, huh?

That done, we now had to figure out a way of
cramming a tablet PC into this device. Easier said
than done: we had no space to work with. “What
about the length?” someone asked. “What about
it?” “Well, 140 mm isn’t bad for a monitor’s
width, settle for a small display… better than
nothing.” OK. So GOD would flip open on a hinge
attached along its length—much like Nokia’s
Communicator series. The whole inside face
would be made of a foldable display.

When half flipped open, GOD would function
as a laptop, again using one half of the display as
a virtual keyboard, and the other as a 140 x 100
mm screen. Somewhat like a tablet PC in laptop
mode. In order to convert GOD to full tablet mode,
all you need to do is open it up fully, at which
point, GOD automatically converts to a 200 x 140
mm tablet PC—switching display orientation.

We had our share of arguments, especially
over the small display when in laptop mode. One
other option that seemed to make sense was not
to have an intermediate laptop mode (with GOD
flipped half open). Instead, use Bluetooth-enabled
eyewear to project a virtual screen, and use GOD’s
internal touchscreen display as a keyboard
instead. This would keep users from having to
squint to find icons on the tiny desktop! It’s
already possible—there were no drawbacks in
terms of technology.

We decided that GOD was, well GOD, and
could do all the above. Besides, we now got to
include a cool pair of virtual display goggles in
the bundled accessories! Apart from the odd
dreamer-geek who screamed for a 3D holographic
display, most of us were satisfied with the results.

That was about it. We had included every-
thing we could think of, and it didn’t take us
more than a few hours—if only production lines
were as easy to calibrate as our imaginations!

GOD In A Box
Now that we’d made GOD, we needed to package
it, and that included a specification list. Here’s
what we came up with:
Hardware
2 GHz CPU
250 GB non-volatile RAM/HDD 
X850 XT/6800 GT GFx
100 x 150 front OLED touchscreen display
240 x 160 internal OLED foldable touchscreen
display
Software Bundle
Windows / Linux Tablet PC OS
Handwriting recognition
Driver CD
Features
128-channel polyphonic ringtones
Bluetooth / Wi-Fi / Gigabit Ethernet
5-megapixel digital / Web camera
Unlimited address book / SMS / MMS storage
Palm / PocketPC functionality
And much more…

As for GOD’s price, we decided people would
definitely be willing to pay even up to $5,000 (Rs
2,20,000) for this dream gadget. So the price was
set to Rs 2 lakh.

Back To Reality
Every good thing has to end sometime, but as we
reached the end of this article, we decided that
our dream hadn’t ended… in fact, it was just
beginning—thanks to some great work being done
by research labs and scientists around the world.

The reason we kept it believable—imagining
only the use of technologies that exist, or, at
most, are under development—is because GOD is
not fictional! The thought that within a few
years from now, we could be testing gadgets like
GOD in a shootout for our readers is what makes
our jobs—nay, our lives—worthwhile. 

robert_smith@thinkdigit.com

When GOD is opened, it converts into a decent 
sized tablet PC (200 x 140 mm). When opened, 
it can also be used as a keyboard along with 
the virtual display eyewear

The representation of a pair of virtual display spectacles shown here are not really
far-fetched. In fact, they already come in all shapes, sizes and display resolutions!
We’re just predicting that they’ll be designed to look cooler and become a fad!
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Imagine you are in the middle of a race and
suddenly, getting bored, decide to quit the
game and watch a movie. A little later, even

the movie turns out to be a drag and you decide
to listen to some music from your voluminous
MP3 collection. But suddenly you feel the need to
check your e-mail too. Now, you need not shuttle
between devices for performing these routine
tasks. The new incarnations of Xbox—the Xbox
360—and the PlayStation 3 (PS3) allow you to do
all this and more at the flick of a shiny button!

In this age of demanding consumerism and
cutthroat competition, you need not settle for
shoddy, below-par graphics and low-grade
gaming machines anymore. The next-generation
consoles are here, and they’re here with all their
guns blazing. Featuring more processing power
than yesteryear’s supercomputers, these
‘gaming’ consoles are fast becoming the ulti-
mate home entertainment solution.

These devices—the Xbox 360 and PS3—let you
play music, as well as movies on a screen, apart
from giving you a brilliant gaming experience.

The advancements in the hardware inside
these consoles is nothing short of path-breaking.
Let’s take a look under the bonnet of these babies.

The Cell Processor
The Cell Processor made headlines when it was
released, and is deemed to be the future of
computing. The basics of the Cell aren’t too diffi-
cult to understand—what is difficult to
understand is why didn’t they think of the
design earlier! 

The Cell was jointly developed by IBM, Sony
and Toshiba, and is touted to have cores operat-
ing in excess of 4 GHz! Remember that the fastest
Intel Processor is still at 3.8 GHz, and AMD’s Fx
55 runs at a mere 2.6 GHz!

To give a very basic idea of how the Cell
works, consider this: if you need to solve a
complex problem, you can do it in two ways—you
either call in a super-genius with an IQ of 160, or

‘Gaming’
consoles are fast
becoming the
ultimate home
entertainment
solution
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you call in three lesser geniuses with an IQ of
140 each. Obviously, three heads are better than
one, so you take the second route. This is
exactly what the people developing the Cell
did. They put in multiple processors so various
threads (streams of instructions) can be
processed simultaneously.

So how did they manage to make a ‘simpler’
processor much faster than its more complex
brethren? Well, surprisingly, they did it by
making the processor cores simpler. The Cell
processor has only a two-issue core, meaning, it
can process only two instructions at a time,
compared with the Athlon 64s, which are three-
issue cores. You can see that the Cell is a simpli-
fied processor, with slightly limited capabilities.

Now, why make something simpler when
millions of dollars were pumped into making
processor cores complex in the first place?

The answer, in a word, is performance.
Over the past 20 years, every processor evolu-

tion has managed to add more and more tran-
sistors to increase performance. Now all
instructions have various offshoots, as in every-
day life you may make decisions based on things
such as “if X happens, we’ll go with Y, but if Z
happens, we’ll go with A”, and so on.

The processor makes the same kind of deci-
sions and attempts to guess which is the right
way to go. Guessing wrong is costly in terms of
wasted instruction cycles, and, increases the
time taken to ‘process’ instructions.

To prevent this wrong guessing, or to at least
minimise it’s impact, processor dies are
crammed with branch predictors, caches, and
predictive cache pre-fetch units. This has no
doubt massively improved performance, but it
has also led to much higher power consumption
and hence excessive heating along with an

impossibly large number of transistors on the
processor chip.

A few years ago, the benchmark software
and applications were office suites and photo
editing software, which drove the development
of processors that were optimised for
single-thread (single application, single
task) operations.

The scenario now is vastly different with 3D
applications and gaming being the performance
benchmarks. More and more manufactures are
thinking of taking computers and the process-
ing power to grow beyond the purview of just
games and applications and enter the domain of
technology as an enabler.

At the latest Intel Developer’s Forum (IDF),
things such as real-time voice recognition,
unstructured search, and life-like in-game
physics and AI (artificial Intelligence) have
prompted manufacturers to look beyond single-
thread optimisation, and focus on parallel
computing where the PC either has multiple
processors or has a multi-core processor that can
process multiple threads simultaneously.

This approach is also important from a long-
term point of view. Considering the way in which
the demand for processing power has increased in
the last five years, there is no telling the amount
of power we would need five years from now.

This above-mentioned idea of increasing
parallel processing has been applied in the
creation of the cell processor. What follows is an
overview of how the cell processor works.

The PPE
The cell processor has a 64-bit PowerPC chip,
which has been termed as the PowerPC
Processing Element, or the PPE. The PPE is a
general-purpose CPU, which means that any-
thing you can do with your Athlon 64 or Intel
processors, you can do with the PPE. It features
64 KB of L1 cache and 512 KB of L2 cache. It also
incorporates something called ‘Simultaneous
Multi Threading’, or SMT, which is similar to
HyperThreading in Intel processors.

In terms of head-to-head performance,
there is nothing too special about the PPE, and
pitched against Intel EE and Athlon FX proces-
sors, it would surely lose. But what the PPE sig-
nifies is a shift in developers’ attitude—of mov-
ing away from complex, single-thread-opti-
mised processors to simpler processors work-
ing in parallel.

Apart from the PPE, the cell has eight
Synergistic Processing Elements (SPEs). These
are similar to the simpler processors of a few
years ago, except they’ve been designed from
the ground up with specific functions in mind.

Future of the gaming console: the PS3

The Cell Architecture In terms of
head-to-head
performance,
there is nothing
too special about
the PPE, and
pitched against
Intel EE and
Athlon FX
processors, it
would surely lose
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The reason we should get excited about the
Cell processor is not just from the scope of gam-
ing (which it will do immensely well as and
when games are written for it, as it can handle
and process multiple gaming instructions
simultaneously, thus being able to give a more
realistic appeal to the games) but also because
the design of the Cell is extremely modular. 

You can add more SPEs, or, in fact, remove
some of them. Computing will become very mod-
ular in the future, and will give rise to a whole
range of Cell-like processors depending on the
kind of work load they’re being targeted at.

Like the PPE, the SPEs have dual-issue cores,
do not have a branch predictor, and rely com-
pletely on software for that function. 

IBM calls the Cell a ‘system on a chip’
design, but it becomes a lot easier to under-
stand it if you think of it as a network on a chip.

The SPEs
Each of the SPEs has 256 KB of local memory.

This is different from cache, as local
memory can only be accessed by that
SPE to which that local memory has
been assigned.

All eight SPEs are connected to
each other and to the 512 KB system
cache via a data bus that’s called the
Element Interface Bus (EIB) 

The SPEs are very basic processors,
with the single-minded task of
running through single- and double-
precision mathematical calculations
as fast as they can. 

The SPEs are under direct control
of the PPE, and hence they do not
need to have their own personal
instruction queuing logic (this is
what decides what sequence the
instructions are processed in) and
hence are a lot smaller. 

It is the PPE that does the work of
scheduling, assigning and sending the
data to each SPE for further processing.

The EIB
The EIB is a set of four 128-bit-wide data chan-
nels that connects the SPEs to the PPE, the
Memory Interface controller as well as the Flex
I/O system (which handles communication
between the Cell chip and the rest of the
computer system).

The Memory Interface Controller (MIC)
connects to the EIB and handles the data trans-
fer functions of the main memory. The approach
taken here is the same as that of AMD, where the
memory controller is built on the processor die,
thus cutting out the need for data to be trans-
ferred from the processor to a separate memory
controller—thereby leading to an overall boost in
system performance. 

The Flex I/O
The Flex I/O bus is like a regular front side bus (FSB)
in a system and handles data transfer between the
Cell processor and the rest of the system. It
provides a whopping 76.8 GB/s data transfer rate,
but this capacity is split into two parts—the data

that is intended for the Cell processor (or, in fact,
other Cell processors in the system—termed as
coherent data), and the data meant for the rest of
the system (termed as incoherent data).

The RAM
Since the cell chip runs at 4 GHz and has massive
memory requirements, the Cell is not based on
the regular DDR (I, II or III), but on the RAMBUS
technology. It has a dual-channel XDR memory
bus running at 400 MHz.

Keep in mind two things: first, as has
already been explained, on-die implementa-
tion greatly reduces memory latencies; second,
XDR transfers data at eight times the memory
bus clock, so you get 3.2 GHz of effective data
signalling rates. While all this might be getting
a bit too complex, suffice it to say that the end
result of all this is a whopping 25.6 GB/s
memory bandwidth!

The Unified Shader Architecture
To understand and appreciate the true merit of
ATi’s achievement in being able to develop this for
the Xbox 360, let’s first understand the basics
behind shaders.

No gamer today can shy away from discussing
pixel shaders and vertex shaders and their cumu-
lative effect on the visual appeal of the game.

The pixel is the smallest element in an
image or graphic. Pixel shaders let program-
mers control the characteristics of the appear-
ance of the gaming environment on a per-pixel
basis. That is, they allow them to make graph-
ics look organic, instead of artificial and
computer-generated.

Vertex shaders, on the other hand, provide
the programmer with the ability to add special
effects by creating highly realistic animations,
such as deformation of a car’s bonnet in a crash.
Programmers use high-level languages such as
the DirectX API to give us the highly realistic
graphics we enjoy in games today.

With the Xbox 360, ATi has become the first
manufacturer to provide Pixel and Vertex shader
integration at a hardware level. This is different
from the trend so far, where Pixel and Vertex
shader integration was done at the software level
using device drivers.

All eight SPEs
are connected to
each other and
to the 512 KB
system cache via
a data bus that’s
called the
Element
Interface Bus
(EIB)

The Xbox 360

The Unified Shader Architecture
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The question arises again, how did they
manage to do it? 

The solution is quite innovative, actually.
The system consists of three main units:

The Reservation Station: This is where the
graphics instructions are saved. Now the reser-
vation system can store either pixel or vertex
shader commands.

The Arbiter: The Arbiter sits in Olympian
judgment over the Reservation Station and takes
and ‘intelligently’ transfers them to the
Command Processing Engine.

The Command Processing Engine: It
receives commands from the Arbiter, and after
execution, sends them back to the Reservation
Station—and includes some form of a flag
system that marks the command as ‘completed’
so as to avoid multiple execution.

Now, to complicate things, instead of having
a generic Reservation Station, let’s put two
Reservation Stations, where one stores vertex
commands and the other stores pixel
commands. These are directly connected to the
Arbiter, which in turn is connected to the ALU
and a Texture Processing Unit.

The Arbiter can now choose whether a
command from the Reservation Stations goes to
the ALU or the Texture Processing Unit, and the
processed results are then sent back to the
appropriate Reservation Station.

All this processing power and the spanking
new graphics core implantation from ATi will
ensure that the Xbox 360 stays competitive to
the PCs and other consoles for the regular life of
a console—around five years.

Sony and nVidia have been mum on the
Graphics engine used in the PS3 as it has not yet
been launched—it’s expected in 2006—so we
can’t talk about it here.

The Consoles
The consoles of today are morphing from pure
gaming devices into complete entertainment
hubs with the ability to play DVDs, music and
pictures. Let’s take them apart feature by feature
and see what’s on offer.

The Xbox 360
The 360 is called so for the single reason that
Microsoft thought calling it ‘Xbox 2’ would
make it seem outdated in front of a name like
‘PS3’ (2 comes before 3, right?)

But the name is apt, as it does provide for a
360-degree entertainment experience. If you buy
an Xbox, it will work as your music centre, DVD
Player (12x dual-layer), as well as a photo sharer. 

It comes with an inbuilt network adapter
that lets you chat (text and voice) with other 360
users, whether they’re watching a movie or
smoking fellow racers in NFS Most Wanted,
apart from connecting to your home network
and surfing the Internet wirelessly!

The device also has support for up to four
wireless controllers, and has three USB2.0
ports. An added attraction is the changeable
face plate (à la Nokia) which will let you
customise your Xbox 360 to match your décor
(it is definitely sleek enough to be put there!)
and taste.

The Controllers
Things haven’t changed too much (not counting
the pretty designs). The face is devoid of the ugly
black and white buttons, which have been relo-
cated onto the shoulder. Both wired and wire-
free controls will be available. The wirefree
versions will be powered by 2 AA batteries,
which you can recharge via a cable. The central
Xbox Guide button gives you instant access to
your favourite functions such as movies, music
or contacting friends over Xbox Live.

Xbox Live!
Xbox Live, the online service from Microsoft, is
now available in two avatars—Gold and Silver.
Each Xbox will come with a free subscription to
the Silver version, which allows players to share
their gamer’s profiles (consisting of stuff like
races won) and a customisable gamerstile

(marketing speak for display image!). It will also
allow you to chat (text/voice) and log on to Live
Marketplace, where you can download demos,
trailers, new levels/maps etc. and store them on
the detachable 20 GB hard disk.

Gold subscribers get the added benefit of
online multiplayer gameplay, as well as video
messaging. All Xbox 360 owners who sign on
to Xbox Live for the first time will get a free
month of the full subscription service, which
will let them experience the full power of Live.
Those who currently use Live on Xbox will also
be able to transfer their subscriptions straight
over to Gold.

In terms of availability, the Xbox 360 has
been showcased, but Microsoft has not yet
started shipping. The expected price would be
somewhere around $300, or roughly Rs 13,500.

The previous version is, of course, available
in India, and you can pick up an Xbox (not an

The Xbox 360 Gamer’s Profile window

The new  Xbox controller is a lot sleeker than its
predecessor

The 360 is called
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reason that
Microsoft
thought that
calling it ‘Xbox 2’
would make it
seem outdated in
front of a name
like ‘PS3’
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Xbox 360) for around Rs 12,000 (street price). The
package includes a Halo 1 DVD. Additional DVDs
can be bought for around Rs 2,200 each, with
Halo 2 and Doom III leading the sales charts.

The Xbox is the only legally available console
in India, and retails for Rs 12,999 all inclusive.
This is marginally higher than the grey market
price, but there are no game disks. The game
disks retail between two and four thousand
rupees, depending on the game’s fan following
(as an example, Halo 2 retails for Rs 3,999).

The Sony PS3
Sony has a whole line-up of consoles, right from
the PlayStation 1 (PS1) to the recently- launched
and runaway success (half a million sold in the
first week!) PlayStation Portable or PSP. Sony
knows just how to position its consoles and price
it just right. PlayStations also have the most
comprehensive list of game titles (did we

mention that you can’t play
games made for one console on
the other?), which would
satisfy even the most avid of
gamers.

But with the PS3, Sony has
outdone itself (or so the speci-
fications suggest!)

No console has generated as
much interest as has the

Sony PS3. Recently
showcased at E3 (see
the Enter section in this
issue for more), the
power potential of PS3
is simply mind-numb-
ing, the Cell processor
being the main reason.
The showcasing was a

complete brag show—as most showcasings are—
but the unveiled specs appear to be much better
than those of the Xbox 360.

We have already mentioned the RAM and
the Cell processor used before, so apart from all
that, it features Dolby 5.1 Channel sound where
the Cell processor doubles up as a sound card,
and supports full-scale HDTV video out at 1920
x 1080i and 1280 x 720p. 

It is also backward-compatible with the
previous PlayStations (both 1 and 2). In terms of
DVD support, it reads everything, from DVD+R,
-R, +RW, -RW to Blu-Ray Disks. (Sony leads the
consortium pushing it to make the entertain-
ment standard). In fact, most PS3 titles are
expected to be released on Blu-Ray.

Connectivity options are as extensive as the
media reading capabilities. It has four front and
two rear USB2.0 ports, as well as slots for
Memory Stick Standard/Duo/Pro (that’s pretty
much all sizes!). Sony decided to stay out of push-
ing proprietary stuff for once, and also gave PS3
support for SD (Secure Digital), SD-mini and CF
(Compact Flash) I and II memory cards.

In terms of networking capabilities, it
supports wired networking as well as Wi-Fi 802.11
b/g, and Sony has thrown in Bluetooth for good
measure. Interestingly, the controllers connect to
the console using Bluetooth and not Wi-Fi, as is
the case with the Xbox 360. This was done due to

the lower latencies of Bluetooth as compared to
Wi-Fi. You can connect up to seven controllers at
once, so that’s a great race right there!

An interesting implementation is that using
Wi-Fi, you can connect your PlayStation Portable
to your PS3 and thus have multiplayer without
having to buy two PS3s!

In terms of availability, the PS3 is expected to
be available in 2006. However, the other versions
are available, and at a damn good price at that!
You can buy the first PlayStation, PS1, for
roughly Rs 3,800 (street price) with gaming titles
for Rs 650 each.

The PS2 is for the serious gamers, and is
available for Rs 10,000 (street price). The titles
are more expensive at Rs 2,200 for a DVD.

A really great buy, however, is the PlaySta-
tion Portable, which is Sony’s foray into the
handheld gaming market. The PSP is dominated
by a large 4.3 inch 16:9 widescreen TFT LCD with
480 x 272 pixel resolution displaying 130k
colours. It has a USB2.0 port, Wi-Fi (strangely, no
browser though), and utilises proprietary Sony
media called UMD (Universal Media Disk), which
can store up to 1.8 GB of data, and looks like a
very cool mini disk.

Apart from the UMD (used for playing games,
much like DVDs in the PS 1, 2, and 3) it also
supports various Memory Stick types, and you can
use those to listen to music or, in fact, watch a
movie, so it does give you a complete entertain-
ment solution right there in your hands!

Surprisingly, the PSP is excellently priced.
We’re quite sure Sony is selling it at a loss to firm
up its market position. You can pick up a PSP for
around Rs 11,500 (street price) which is, in fact,
cheaper than what it retails for in the US—$275,
or Rs 12,375! Game titles are quite expensive,

though, at Rs 2,200 a piece, but
the sheer appeal of the

device is worth
shelling out 11

grand for!

Gamers have an insatiable appetite for a
better, faster and a richer gaming experience
and the manufacturers aren’t letting them
down either. They’re creating devices that meet
the gamers’ requirements and in most cases,
exceed them. 

If you are into gaming and already own a PS2
or an Xbox, well and good, you need not really
go and buy a PSP as well. But if you do not own
an Xbox or a PlayStation yet, we suggest you wait
a while and let the Xbox 360 and PS3 hit the
markets because when they do, they will change
the way you play games forever! 

varun_dubey@thinkdigit.com

The Sony PS3 with 
it’s game pad

The Sony PlayStation 
Portable (PSP)

You can pick up a
PSP for around
Rs 11,500 (street
price) which is,
in fact, cheaper
than what it
retails for in the 
US—$275, or 
Rs 12,375!



Say hello to the
daddy of all phones It’s about time! With all the iPods and Flash

devices circulating the globe, it was only a
matter of time for a mobile phone that 
could store a few GBs of MP3s to hit the
market. After all, it’s not like the technology
isn’t available!

Looks like a phone manufacturer finally did
just that. And so, ladies and gentlemen,
presenting a phone that has a 4 GB hard drive,
Wi-Fi 802.11b and g connectivity, 3G features, a
solid stainless steel body (now clumsy people
can think of spending half a year’s salary on
one) and support for MP3, AAC, WMA and M4A
format files.”

The Nokia N91 smartphone has that, plus
regular phone features. Nokia even realised that
we users hate buying proprietary headsets and
add-ons, so they provided the phone with a

standard 3.5 mm stereo headphone jack for any
regular pair of headphones!

The phone is smart enough to pause music
playback when you get a call, has a 2 megapixel
camera with a top still resolution of 1600 x
1200, and is capable to record video in the
MPEG4 and Real Video 8 formats. The icing on
the cake seems to be the bundled Opera browser
with its amazing rendering engine that’s
optimised for small screens!

Imaging Sivalal S

Nokia N91
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(Singapore) Pte Ltd

WINNER
Piyush Paliwal
hackerzone05@yahoo.co.in
27, Ahinsapuri, Fatehpura,
Udaipur (Rajasthan)

Rules and Regulations
Readers are requested to send

in their answers by the 15th of the
month of publication.

Employees of Jasubhai
Digital Media and their relatives
are not permitted to participate
in this contest.

Readers are encouraged to
send their replies by e-mail.
Jasubhai Digital Media will not
entertain any unsolicited
communication.

Jasubhai Digital Media is
not responsible for any damage
to your system that may be
caused while you are trying to
solve the problem.

Say you want a hard copy
of the contents of a
directory on your hard
disk. How would you go
about printing out the
directory listing—in
Windows XP—without
taking a screenshot?
Write in with subject ‘take
a crack’ to
takeacrack@thinkdigit.com
with your solution

You will need a Windows 95,
98 or ME startup disk. Insert
this in the floppy disk drive
and restart the computer.
When the Windows 98
startup menu is displayed,
select ‘Start computer
without CD-ROM support’.

At the command prompt,
type in “fdisk” and press
[Enter]. In what follows,
you’ll need to press [Enter]
after most commands, which
we won’t mention explicitly.

When “Do you wish to

enable large disk support?”
comes up, press [Y]. This will
enable FAT32. When the
fdisk options appear, choose
[3]. Then, the following
options are displayed:

“Delete Primary DOS
Partition

Delete Extended DOS
Partition

Delete Logical DOS Drive(s)
in the Extended DOS Partition

Delete Non-DOS
Partition”

Press [3]. You will be
presented with: “What drive
do you want to delete?” Press
[Z]. ‘Z’ represents the drive
letter that corresponds to
your logical drive.

The next thing that
comes up says ‘Enter Volume
Label’. Leave the volume
blank. Confirm this, then
press [Esc] twice to get back

to the main fdisk menu. Then
select the ‘Delete partition or
Logical DOS Drive’ menu
option. After that, select the
‘Delete Extended DOS
Partition’ option.

Confirm this and press
[Esc] to get back to the main
fdisk menu. Select the
‘Delete partition or Logical
DOS Drive’ option.

Now select ‘Delete
Primary DOS Partition’. You’ll
now see, “What primary
partition do you want to
delete..?”. Press [1]. The next
prompt states, “Enter Volume
Label”. You can choose to
leave this blank. Confirm

this, and then similarly,
delete the Non-DOS
partition, if it is NTFS. Now
press [Esc] twice. In the main
menu, press [1], and press
[Enter]. Now select ‘Create
Primary DOS Partition’.

When you’re asked, “Do
you wish to use the
maximum available size for
primary DOS partition?”,
press [Y] if you want all the
space on the hard disk to be
assigned to drive C. Go
directly to Step A below.

Press [N] if you do not
want all the space on the
hard disk to be assigned to
drive C. Enter the size of the
partition you wish to create.
Press [Esc].
Step A: Select the ‘Create DOS
partition or Logical DOS Drive’
option. Now select the ‘Create
Extended Partition’ option.
fdisk will automatically try to
create a logical DOS drive.

Enter the size of the
second partition you wish to
create. If you created your
second partition to use the
entire Extended DOS Partition,
then don’t take any action
here. If not, repeat Step A until
you have used up the rest of
the Extended DOS Partition.

Return to the command
prompt and reboot. You can
now format the partitions
you created. Finally, format
drive C:, and you are done.

Add an item to the
context menu to print
out a directory listing

THIS MONTH’S CHALLENGE

Create a FAT32 partition larger than 32 GB on your hard diskLAST MONTH’S CHALLENGE

Win!

Enable support for large disks in fdisk

Opt to create a DOS partition or
Logical DOS drive

Opt to use all the available space
on the drive to create a partition



Day 1:First Impressions
After my short interaction with the big momma ofLCDs, everything else seems tiny in comparison. Ergo,when I first reluctantly laid eyes on the 23-inch screen, Icouldn’t help but wonder if it would be worth thetrouble to set up and use, when I know that thiscoupling is doomed to separation. In retrospect, I haveto admit, continued exposure to top-of-the-linehardware has spoiled us reviewers rotten.After the trouble I had setting the 30-inch screenup, I’ve become a little wary of Apple’s LCD displays—Idecide to use it on a testbed first. Display connectedand system powered, the boot up and Windowswelcome screens reveal themselves as smoothly as theLCD’s metallic bezel.

Encouraged by this quick success, I hotfoot it to mysystem and perform the requisite rites, setting myDisplay Properties to 1920 x 1200 in anticipation. Apower-down and connection later, the PC is turned on.Then… nothing!. I can see the hard disk workingfuriously as Windows XP ostensibly loads, but all I getis a cold blank stare from the screen, with anoccasional wink of its LED, as if taunting me with itsreluctance to play ball.
A tense minute of waiting

follows, ending in the appearance
of the blazing welcome screen,

as if light at the end of the
tunnel. Success! 

Day 8: Apple’s On My
Desktop!

Time does fly when
you’re having fun. A

week has passed
like the blur of a

cheetah at full
flow, like a

McLaren F1
screaming

down the
home
stretch,
like Lalu

Yadav
when he spots

CBI officials. And yet, a
small voice at the back of my

head continues to nag me. “Why does the LCD neverdisplay the POST or Windows boot screens? Beware theallure of the big screen, my spellbound friend.” I haveno answer to its questions. All I can do is ignore thatlittle voice and pray that all goes well.

Day 16: So Far, So Good
All has indeed gone very well thus far. The displayhandles all the resolutions I throw at it withconsummate ease. Everything just looks better on anApple (Hey! Maybe they can use that as a caption inone of their ads). An Apple-standard 170-degreeviewing angle, aluminium bezel, all-digital interface,a minimum of buttons—the polished sophisticationthat is associated with an Apple product. I think I’min love. And yet…

Day 25: Looks Like The Honeymoon’s OverThe inevitable happens. One fine day, XP decides itneeds some excitement and crashes. Since my HDD hashad this kind of trouble before, I tighten its connectionsand restart. For five minutes, I look patiently towardsthe blank screen, hoping for signs of life. No luck.Another restart, yet the situation remains the same.What exactly is going on? Is the BIOS giving me anerror message, is Windows displaying a BSOD? Well,there’s only one way to find out.
I dig out my 17-inch CRT and hook it up. Twominutes later, the problem is solved and Apple’sdisplay stands exposed. Its inability to display theresolution required by the POST and boot screens is aflaw that can only be described as fatal. This deficiencyon its part seems unforgivable, especially when workpiles up and deadlines loom large.

Day 30: Time To Say Goodbye
But time is a great healer. When the folks at Applecome calling to claim their baby, I experience a lotmore than just a twinge of regret. I considerthreatening them with a bad review to buy me moretime with the device, but the concept of editorialintegrity comes to the rescue at the last moment.The 23-inch Cinema Display is most certainly adevice I would like to call my own. With somejudicious saving and patient waiting, the price mightjust be within my reach. Of course, I’ll have to save alittle extra for a backup display too… 

badri_narayan@jasubhai.com

Badri Narayan

The high points of my life can be counted on the fingers of half a hand. High up on that list—actually,
the only entries on that list—are my brief flings with Apple’s 30-inch monster LCD, and a slightly

longer relationship with its little sister, the 23-inch Widescreen Cinema HD Display...

Apple 23-inchCinema HD Display

Digital Passion l 30 days with...

Photograph: Jiten Gandhi Imaging Sivalal S
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Jumpstart

Preethi Chamikutty

hen Ranjana Kanti was
trying to help her son
with his computer

exams, he protested, “But Mom,
do you know anything about
computers?” That gibe is a
distant memory for Kanti today,
who not only uses computers,
but also teaches others how to
use them. And not just the

basics: Kanti is into teaching
animation and graphic design.

The Humble Housewife
After years of a demanding
family life, when Kanti wanted
to use her time more construc-

tively, the first thing she
thought of was computers, cour-
tesy her son, who had dubbed
her computer-illiterate! Kanti
also had a lot of free time on her
hands and was in a position to
take up a full-time career, which
seemed a more attractive option
than remain a housewife. So, in
1998, she started off with a
course in 3D and 2D animation

and graphic design.
“Computers is

one field where
prior education is

W

Technology For Personal And SoHo Productivity

Aim For The

96 News You Can UseAll-A-Board! How GPS
works

Opportunities in the field of multimedia transformed Ranjana Kanti from a simple housewife
to an entrepreneur in education

Imaging Atul Deshmukh
Photographs Sandeep Patil

STARS
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University, she jumped at it.
But after a few months at the

college, Kanti, “realised that the
teaching focus and syllabus was
not industry-relevant. And
despite my best efforts, I found I
could do nothing to change it. I
therefore felt I could not give
training honestly, and wanted to
move on”.

Enter E-dutainment
Unlimited
While at Rai University, Kanti
shared her concerns with her
husband. “My husband has been
very supportive; in fact, it was 
he who suggested that I start 
an institute.”

Kanti was sceptical about the
idea, but with some support
from her husband and a bit of
willpower, E-dutainment Unlim-
ited, her academy, began in
February 2005.

Although it’s yet to become a
profitable venture, the over-
heads have been taken care of,
insists Kanti, who trains her
students on Adobe Illustrator,
Adobe Photoshop, QuarkXPress,
Flash MX, HTML, Macromedia
Dreamweaver, Maya and more.

“My students get a free
overview of MS Office, the Inter-
net, and e-mail. This is because
many of my students are still in
school, and may not have been
exposed to computers before
this. I wouldn’t want them to
face the same problems I faced,”
says Kanti.

At the institute, students
decides what they want to learn.
At the end of the training and
assessment  they give a presen-
tation where the students’
parents are present.

Looking To The Future
“My wish is for multimedia to
reach every household in India.
All that is required is a little
imagination and the zest to
do something.”

Kanti’s husband is planning
to start his own production
house in some time, and she
hopes to be able to get work from
there as well. “My students who
are good will never have a short-
age of opportunities—there is so
much work coming into India,
for foreign films, Indian films,
TV serials, etc.

“There are options galore. It’s
only the individual who can
either make it or break it!” 

preethi_chamikutty@thinkdigit.com

not considered a qualifier.” This
graduate in English literature
from Delhi University had never
handled a computer until the
course had begun. But she learnt
fast. And she learnt how to send
e-mails, create folders and so on
at the same time that she was
learning multimedia.

“I never took another course
for learning the basics of
computing—I learnt it all
together.” A year later and armed
with skills in graphic design, 
2D and 3D animation, she was
raring to go. 

Today—seven years later—
Kanti imparts training to 12
students at her academy.

Opportunities Galore
Kanti never sat idle after having
completed her training. “I
started getting opportunities
that not only interested me but
also helped me earn a few decent
bucks,” she says. Kanti has given
guest lectures in colleges such as
SIES Nerul, Navi Mumbai, and JJ
School of Arts, Mumbai.

Apart from teaching, which
is her passion, she has also
worked on animation projects
for tele-serials such as Gharwali
Uparwali, Son Pari and Shararat.

Since such assignments
happened only occasionally,
Kanti had a lot of free time on
hand. And so, when she got the
opportunity to be a full-time
faculty member with the
computer department at Rai

Adobe Illustrator
CorelDraw
Adobe Photoshop
Adobe Imageready
QuarkXpress
PageMaker
Flash 5 and Flash MX
HTML
Dreamweaver
Director
Authorware
Premiere 6.5

Premiere Pro
SoundForge
3D Max
Maya 6.0
Maya Unlimited
Elastic Reality
After Effects
Animo
Autocad
Combustion
3DSoftimage
Indesign

The Tools

A still from an animation by Kanti

1 Col AD

All that is
required is
a little
imagination
and the
zest 
to do 
something
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THE AMD 
MOTHERBOARDS
AMD has four chipset manufac-
turers—ATi, nVidia, SiS and Via—
that create motherboard chipsets
for it. This obviously leads to a
variety of boards with large vari-
ances in performance.

Features
In terms of features, the boards
were so varied that we had a diffi-
cult time grouping them. Some
used the 939 socket, others used
754; then some had an AGP port,
others had PCI Express (PCIe); but
a lot of features were common
and can now be taken as standard
feature set even though they
seemed rather high end a few
months ago.

As these are entry-level moth-
erboards, we weren’t really
expecting too much, but half

Varun Dubey and Jayesh Limaye

A
computer for Rs 10,000 is
still a dream that will
take some time in
coming to fruition, but

there is absolutely no denying
that prices of computer compo-
nents have literally crashed from
the exorbitant rates that were
being charged some years ago.

Today, you can buy a decent
system that will let you run all
your office applications and let
you browse the Internet, as well
as indulge in moderate gaming,
for roughly Rs 25,000. We take a
look here at budget (within and
around Rs 5,000) motherboards,
one of the most significant
contributors to PC cost.

It is generally seen that
falling prices lead to cutting of

corners and a deterioration in
the overall quality of the prod-
uct. The case is slightly different
here—all the motherboards we
tested, though cheap, were
absolutely crammed with
features that would give more
expensive motherboards a run
for their money!

The Groups
We divided the motherboards we
received on the basis of the plat-
form they supported (AMD
and Intel).

The AMD boards were further
divided into those with onboard
graphics and those without. This
wasn’t required for the Intel
boards, as all Intel boards
(barring the Foxconn 915PL7AE-
8S, which is mentioned in a sepa-
rate box in this article) came
with onboard graphics.

All-A-Board!
Budget motherboards aren’t the el cheapo items they used to be. Here’s a shootout
of all the ‘budget’ boards out there for the cost-conscious 

Photogrph Jiten Gandhi Imaging Atul Deshmukh



these boards were PCIe-based, and
all the boards featured SATA
support—and most of them had
the standard four SATA connec-
tors found on the higher end
boards of six months ago!

While buying a motherboard,
you must keep in mind its form
factor (size). Boards primarily
come in two sizes, ATX (the regu-
lar big boards requiring a nice big
cabinet!) and Micro ATX (tiny
boards needing a relatively
smaller cabinet, and hence ideal
for office environments or places
where desk real estate is of
prime importance).

The Micro ATX form factor has
its own issues during assembly, as
a PC built on this form factor will,
in all probability, have a small
cabinet. A small cabinet implies
fewer avenues for proper
ventilation and hence
heating issues. 

This is not to say that
Micro ATX is useless. We are
just trying to emphasise that
while building a system of this
form factor, you must be attentive
to system ventilation. 

You also need to keep in mind
socket support. As of now, the
most common AMD sockets are
the 754 (the Athlon 64 range) and
the 939 (the Athlon 64 as well as
the Athlon 64 FX range).

939 is the latest socket for the
Athlon range (the Opteron runs
on 940 and is for servers anyway)

and it is advisable that you go for
this socket over the 754, as it will
give you a fair bit of future-
proofing.

Coming back to the feature
set, all the boards we received
supported at least 2 GB of DDR
400 RAM, a feat that was
commendable for high-end
boards a year ago! In fact, the MSI
RS480M2-IL and the ASRock
939A8X-M went a few yards
further and offered support for a
whopping 4 GB of RAM, plenty for
all you might want to do for at
least the next two years if not
more (we wouldn’t want to do a
Bill Gates by predicting how
much memory you might have
use for!)

We had three boards based on
the spanking new nForce 4 chipset
from nVidia—these were the
Winfast NF4K8AB, NF4K8MC and
the Gigabyte GA-K8NE, and all
these supported 3 GB of RAM—a
peculiar number if you ask us.

A lot of the boards we received
did not have onboard graphics,
which is rather strange as these
boards are targeted at an audi-
ence looking at complete on-
board solutions.

All the nForce4 boards, along
with the ATi RS 480-based board
from MSI (the MSI RS480 M)
lacked onboard video, but did
feature an x16 PCIe slot, and were
hence tested with a PCIe-based
nVidia 6200 graphics card. Their
AGP counterparts weren’t any
better, and we received no less
than six motherboards without
onboard video but featuring an
AGP slot. These were tested with
an nVidia 6200 AGP card.

Here, we must mention that
only the Krypton M7VIG400
featured an extremely dated AGP
4x, whereas all the others had at
least AGP 8x.

There were boards which were
extremely generous in terms of
their video solutions: both the
TUL boards came with onboard
video as well as an x16 PCIe slot.
This feature was also available on
the MSI RS480M2-IL.

Onboard sound has improved
by leaps and bounds from the 2.1
systems we used to get a couple of
years ago. Half the boards we
tested featured eight-channel (7.1)
audio support, and the other half
featured six-channel (5.1) audio
onboard, so basically, six-channel
has become pretty much a stan-
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Onboard
sound has
improved
by leaps
and bounds
from the 2.1
systems we
used to get
a couple of
years ago
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In order to judge which motherboard was best, they were
passed through a series of rigorous benchmarks. As many as

five test-bench setups had to be used due to the various types of
processor sockets on the motherboards that were tested.

Intel motherboard setups consisted of the Pentium IV 3.6
GHz processor for the LGA 775 socket, and the Pentium IV 3.2
GHz processor for Socket 478 boards. AMD motherboard setups
consisted of the Athlon64 FX-53 for Socket 939, Athlon64 3000+
for Socket 754 and Athlon XP 2500+ for Socket 462 boards. 

Other than that, the test setups consisted of 512 MB of DDR
400 MHz RAM as the need arose, a 250 GB 7200 rpm SATA
Maxtor hard drive, and an nVidia GeForce 6200 PCIe or AGP
display card where onboard display was not available. Windows
XP Pro with SP1 was freshly loaded along with DirectX 9.0c, and
the drivers from the driver CDs provided with the motherboards
were loaded.

The various features of the motherboards were noted and
rated accordingly. The tests and benchmarks consisted of
the following:

For the game tests, we used relatively lower resolutions—
640 x 480 and 800 x 600—as the onboard gaming/graphics
solutions on these boards, though quite good, were not what we
would term as powerful.
Serious Sam Second Encounter: This is a Direct3D game, and it
accurately measures the Direct3D gaming subsystem. This game

was chosen because it runs fairly well on systems that use
onboard graphics. 
Quake 3 Arena: This OpenGL game which is fairly old was
used to test the strength of the OpenGL graphics subsystem.
This game was chosen because it scales fairly well across
various systems.
3DMark 2001 SE: This is an industry-standard Direct3D
synthetic benchmark and measures the graphics performance
and capabilities of a system. This test gives one an indication
about the kind of graphics performance you can expect from
the system.
PC Mark 2004: This benchmark from FutureMark measures the
CPU, memory, graphics and hard disk performance of the system,
and hence is a good system-wide benchmark.
SiSoft Sandra 2005: SiSoft Sandra 2005 consists of benchmark
modules that measure CPU, file system and memory performance.
Ziff-Davis Business Winstone 2004: This benchmark suite runs
various applications such as WinZip, MSOffice 2002’s Word,
Excel, PowerPoint and Outlook, and other software, to measure
the real-world performance of the system.
Dr. DivX 1.06: This is a video-encoding application that is used to
encode DivX video files. Since video encoding is a processor-
intensive task, the time taken to encode a file pretty much reflects
how fast the processor is. A 100 MB DVD file was encoded to DivX,
and the time taken was noted.

How We Tested

TUL A480M7-V
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dard feature, with eight-channel
getting there really fast!

In terms of connectivity
options, the MSI RS480M2-IL was
slightly ahead of the rest. Like all
the others, it featured four USB
ports with support for four more,
but what it also had, unlike the
others, was an onboard
FireWire port. The other boards
had support for FireWire in
terms of pins on the board, but did
not have a physical port on the
back panel. The board featured a
10/100 Mbps Ethernet port, which
was disappointing, as a lot of the
other boards provided Gigabit
Ethernet. Gigabit Ethernet is very
helpful if you are working in a LAN
environment, as data transfers
would be, theoretically at least,
much faster.

The falling prices of storage
have not bypassed SATA drives,
and these, too, are witnessing
frequent price cuts along with
capacity increases. We were
amazed to see that every board,
apart from the Krypton M7VIG400,
provided support for at least two
SATA connectors—and half the
boards had four SATA connectors!

The features list doesn’t end
here. Half our boards also
supported RAID in 0, 1, and 0+1
configurations. The MSI k8mmv
did not support RAID, and hence

lost out on the features front.
In terms of pure features, the

most feature-rich was the MSI
RS480M2-IL (not to be confused
with the RS 480M).
The board

is based on PCIe, and features
support for 4 GB of RAM, has three
PCI slots, 5.1 channel integrated
audio, four USB ports and even a
FireWire port!

It features SATA with RAID (0,
1, 0+1) as well as 10/100 Mbps
LAN. The notable thing here is
that this board (as well as quite a
few of our other boards) requires
a 24-pin power supply instead of
the regular 20-pin, so you need to
be careful when purchasing the
power supply.

There is nothing dangerous
about plugging a 20-pin power
supply into a 24-pin socket, except
that you might not be able to give

the board enough power, and
might not be able to add other
components later due to lack of
power—so it’s wise to purchase a
24-pin power supply at the outset.

In terms of bundled acces-
sories, all boards came with the

standard cables and connectors
except the Gigabyte, which

also bundled in a USB LED
(for fun, we presume). The

other exception was the
Elite Group RS480M board. This

one came with nothing—no
manuals, no cables.

HOW THEY FARED
Graphics Performance
While testing these boards, we
kept in mind that the target audi-
ence will not be looking at a
gaming solution, so we ran less
demanding games (Quake 3 and
Serious Sam) at lower resolutions
(640 x 480 and 800 x 600).

The boards with onboard
graphics did a fairly commend-
able job, and gave more than
playable frame rates in most cases
(assuming anything above 30 fps
is playable).

In Serious Sam, the lowest
scores were logged by the Asus
K8SMX-UAYZ. This SiS 760GX
chipset-based motherboard could
just manage a paltry 26 fps at a
low resolution of 640 x 480 and
similar 22.6 at 800 x 600. 

Motherboards Without
Onboard Graphics
The newer chipsets from nVidia
do not feature support for
onboard video. Even the earlier
version of nForce3 lacked
onboard video and came with an
AGP slot. The motherboards based
on the nForce4 chipset were the
Gigabyte (the GA-K8NE) and the
two WinFast boards, the
NF4K8MC and NF4K8AB. 

After a long sabbatical, ULi
(earlier ALi) has come back with a
brand new chipset for AMD boards
(remember how, earlier, ALi and
Aladdin were the chipsets AMD
users swore by? Those guys are
back!)—the ULi M1689. The board
is AGP-based, and does not have
onboard video, which makes us
think that Ali is a little behind the
times here (PCIe is here, guys!).

Moving on and coming to
their graphics performances, the
first test we used was Serious Sam
First Encounter. 

The highest scores here were
recorded by the WinFast
NF4K8MC. This nForce4-based

Would you believe us if we told you
there's a motherboard available with

onboard video, audio, LAN and a CPU as
well, at a price as low as Rs 3,200? Yes,
you read it right—
Rs 3,200! The Mercury
PVCLE266M-L is a
Mini ATX board
that comes
with the
VIA C3
Samuel 2 CPU
(CX 800 MHz
overclocked to Pro 2000+)
onboard. The CPU operates at an
FSB of 133 MHz. The board is based on the
VIA CLE266 chipset. There is support for two
DDR memory modules running at up to 266
MHz. As much as 2 GB of memory is
supported.

There are two IDE connectors that can
support a maximum of four IDE devices with
speeds up to ATA133. Four USB2.0 ports are
provided. Connectivity is via a 10/100
LAN onboard.

The onboard VGA is a S3 display adapter
with primary 3D functions. The audio device
is an AC’97 supporting 6 channels.

Expansion slots are provided in the form of
2 PCI and one CNR slot.

The gaming tests proved that the display
adapter cannot aptly handle

demanding 3D games.
Serious Sam
logged a low 5.6,

while Quake 3
Arena logged an

equally low 17.9 at 800 x
600 at 32-bit colour. The

3DMark 2001 SE score was a
paltry 361.

The PCMark score was 451, which
is 15 per cent less than that of most other
boards we tested. In the SiSoft Sandra CPU
benchmark, the CPU was quite low, and the
memory benchmark was no different—5.5 in
the ZDBench Business Winstone.

The above tests prove that while the
motherboard is not well-suited for 3D
gaming at all, it can still be used in offices
where work is mostly limited to
spreadsheets and word processors. It can
also be used by cyber-cafés and computer
classes, where its specifications would be
more than sufficient to get the
job done.

The Mercury PVCLE266M-L

EliteGroup
RS480-M



49JULY 2005 DIGIT

Digital Tools l Test Centre

board logged a whopping 185 fps
at the lowest settings and 145.2
at 800 x 600.

The second-highest scores
were by a WinFast board again,
the NF4K8AB at 170.2 and 135.2
respectively. To compare these
scores to those of boards with
onboard graphics is not entirely
correct. These scores are slightly
deceiving as these boards were
tested with an external graphics
card which bumped up the scores. 

The Gigabyte GA-K8NE came
in second and logged 157.4 and
138.8 respectively, and hence
marginally beat the NF4K8AB at
the more demanding resolution
settings. The rear was brought up
by the nForce3-based Asus K8N.
This board logged a measly 44 and
35.6 in our tests, and was indeed
the worst performer in our tests
despite having a 6200 (AGP 8X) to
help it out! You must, however,
note that even though it scored
the lowest in our tests, it still 
gave a more-than-playable frame
rate, and hence must not be
discounted entirely.

All boards did a bit too well in
our Quake 3 Arena test. The
WinFast NF4K8MC raced ahead
with a score of 400 and 296.6 for
the same resolutions as above.
The gaming performance of the
nForce4-based motherboards
could also be high due to our
using an nVidia-based mother-
board with an nVidia-based
graphics card.

The second position was
taken up by another WinFast

motherboard, the
NF4K8AB. It scored

375.6 and 235.5,
and easily beat
the Gigabyte GA-

K8NE, which scored
335.2 and 209.4.
The final graphics

benchmark was 3DMark
2001 SE. The story here was the

same—the NF4K8MC came first,
but not by a long margin. It
scored 9350 where the NF4K8AB
scored a close 9146 and came in
second, just edging out the Giga-
byte GA-K8NE, which scored 9125.
This was pretty much a tie, as this
difference in scores is really
insignificant.

The ASRock did a commend-
able job and logged 7610 despite
being an AGP board. Other AGP
boards crashed out: 5849 for the
ATi RS480-based Elite Group
RS480 M, while the Asus K8N
was our worst performer once
again, scoring just 4939
3DMarks.

The board, while not being
too high on performance, was 
a mark above the others in 
terms of features, as it had five
PCI slots and eight-channel
onboard audio.

Motherboards With
Onboard Graphics
Amongst the motherboards
with onboard graphics, the
best scorer was the MSI RS480M2-

IL. It logged 62.7 and
45.8 for Serious Sam
at 640 x 480 and 800
x 600 respectively.

The second here,
and by a long way,
was the TUL
A480A7-VF. It logged
53 and 38.6 respec-
tively. The worst
performer was the
Asus K8SMX on the
SiS chipset, which

logged a very unplayable 26 fps at
the lowest graphics settings.

The story was replicated in
Quake 3, the RS480M2-IL beating
all the others comfortably.

In second place was the TUL
A480A7-VF. The loser here was the
MSI RS480M. The flip-flops done
by boards based on essentially the
same chipset (most of these are
based on the ATi RS480) really
highlighted how important
the process for chipset imple-
mentation is.

The story continued through
3DMark 2001 SE, where the
RS480M2-IL zoomed ahead with a
score of 5048. It was comfortably
ahead of the TUL A480A7-VF, which
scored a commendable 4611.

The worst performer here was
the MSI RS480M with a score of
1027. This board really was a
surprise, as MSI generally turns
out very good motherboards.

We now come to our first over-
all system test, PCMark 2004. 

Here, it needs to be clarified
that the scores depend a fair bit on
the processors used, and the 939
boards gained an advantage over

their 754 counterparts
due to the faster processors.
But this advantage is defi-
nitely warranted, as 939 is

the newer socket,

and if some
manufacturer

can give you a 939
board for the price someone else
is giving you a 754 for, then it
must reflect in the performance.
This is why we did not make
further segregations on the basis
of processor sockets.

JULY 2005

JULY 2005

Quake III (800x600)

3D Mark 2001 SE

Higher is better

Serious Sam (800x600)

FPS scores, higher is better

In
fo

gr
ap

hi
cs

 S
iv

al
al

. s

FPS scores, higher is better

Winfast
NF4K8MC
Nforce4

MSI
RS480M2-IL
ATi RS480
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Scoreboard                             AMD Motherboards With Onboard Graphics  
BRAND
Model
Chipset

Interface type(Socket)

Features

Memory Speed Supported/Max memory

Form Factor

Onboard/Graphics Port/Type

PCI Slots

Onboard Sound (Channels)

Onboard FireWire/Firewire b

USB

USB 1.1 (Nos)/USB 2.0 (Nos)

Ethernet/Gigabit Ethernet

RAID 0, 1, 0+1

SATA 

SATA RAID

HyperThreading Support 

Power Supply Type (Pins)

Component layout (SO5)

Capacitors near the CPU socket

Placement of IDE and SATA connectors 

Memory Slots and the lock on the AGP slot

Graphics slot with locks

Locking mechanism of the processor

Interference of AGP card with PCI card

Colour coding of Memory slots and front USB connectors

Package contents 

Manual

CD's 

Necessary cables

Other Miscellaneuos Features

Performance

Serious Sam Second Encounter

Normal (640x480x32) 

High (800x600x32)

Quake3 Arena

Normal (640x480x32)

High (800x600x32)

3D Mark 2001 SE (patched—for onboard without AGP slot) 

PC Mark 2004

CPU Index

Memory Index

Graphics

Disk Index

Total Score

Sisoft Sandra 2005 Professional

Memory sub-system

ALU/RAM

FPU/RAM

CPU sub—system

CPU Dryhstone

CPU Whetstone

Multimedia—CPU  Integer

Multimedia—FPU SSE

Disk drive 

Drive Index MB/sec

Sequential Read MB/sec

Random Read MB/sec

Sequential Write MB/sec

Random Write MB/sec

Average access time

Zdbench Business Winstone 2004

Video Encoding (Time in secs)

Price Index

Price (Rs)

Total Score (Out of 100)

JULY 2005

Krypton
K8M800
VIA K8M800
754

23.32

400/2GB

MicroATx

Y/8x/AGP

3

6

0

4

10/100

✖

2

✖

NA

20

4.25

3.75

2

4

3.5

3

0

✖

✔

✔

✖

19.05

43.9

31

59.38

45.4

2055

3717

3392

603

4498

2990

2794

2793

9171

3153

19034

20480

51

57

41

57

46

7

24.6

163

10.13

3750

52.50

Krypton
M7VIG400
VIA KM266
462

20.14

400/2GB

MicroATx

Y/4x/AGP

3

6

0

2

10/100

✖

✖

✖

NA

20

3.5

3

2.5

4

3.5

2.5

0

✔

✔

✔

✖

10.96

20.1

14.6

33.1

21.6

625

1860

1165

249

3175

1443

1252

1176

4550

1728

19456

20932

25

27

22

26

21

8

13.2

168

15.51

2450

46.61

MSI
K8MMV
VIA K8M800
754

25.30

400/2GB

Micro ATX

Y/8x/AGP

3

6

0

4

10/100

✖

2

✖

NA

20

2

3.5

3

5

3.5

3

2.5

✔

✔

✔

✖

19.62

47.3

33.8

63.9

48.2

2230

3730

3426

659

4660

3085

2830

2830

9098

3127

18840

20314

51

57

63

57

46

7

25.2

163

9.74

3900

54.66

MSI
RS480M
ATI RS480
754

25.50

400/2GB

ATX

Y/x16/PCIE

3

6

1

4

10/100

✖

4

✖

NA

24

3

4

3.5

3.5

3.5

2.5

2.5

✖

✖

✖

✖

14.89

29.6

8.6

45.2

16.1

1027

2996

1865

1025

3163

2125

1142

1143

9126

3136

18940

20378

38

56

28

56

47

7

17.6

135

5.51

6900

45.90

MSI
K8M Neo-v
VIA K8M800
754

27.96

400/2GB

ATX

Y/8x/AGP

4

6

0

4

Gigabit

0,1

2

✔

NA

20

3

3

3.5

5

3.5

3

2.5

✔

✔

✔

✖

17.94

32

24.8

52.1

35.4

1796

3394

3268

507

4701

2715

2824

2824

8186

2814

16993

18279

51

57

41

57

46

7

23.4

182

8.28

4590

54.18

MSI
RS480M2-IL
ATI RS480
939

28.04

400/4GB

ATX

Y/x16/PCIE

3

6

1

4

10/100

0,1,0+1

4

✔

NA

24

3

3.5

4

3

3.5

2.5

2.5

✔

✔

✔

✖

22.08

62.7

45.8

165.6

102.4

5048

4409

3714

1166

4036

3918

2785

2786

10951

3770

22730

24501

48

57

40

40

30

7

24.4

140

7.04

5395

57.17

Gigabyte
GA-K8VM800M
VIA K8M800
754

24.54

400/2GB

Micro ATX

Y/8x/AGP

3

6

0

4

10/100

0,1

2

✔

NA

20

2

4

3

5

3.5

3

2.5

✔

✔

✔

USB LED Light

19.09

42.5

29.7

63.1

42.1

2223

3693

3383

558

4762

2948

2839

2840

9132

3139

18949

20388

51

57

41

57

46

7

24.2

165

9.74

3900

53.37

ASUS
K8SMX UAYZ
SiS 760GX
754

22.30

400/2GB

MicroATx

Y/8x/AGP

2

6

0

4

10/100

0,1

2

✔

NA

20

3

3

2.5

5

3.5

2.5

0

✔

✔

✔

✖

18.87

26

22.6

69.6

61.6

1886

3715

3367

511

4657

2976

2774

2775

9170

4033

19060

20503

51

57

41

57

44

7

23.9

165

7.61

4992

48.78
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Winfast
IGPSK7MA
Nforce2
462

22.32

400/2GB

Micro ATX

Y/8x/AGP

3

6

0

4

10/100

0,1,0+1

2

✔

NA

20 pin

3.5

3

2.5

2

3.5

2.5

0

✔

✔

✔

✖

18.92

42.6

34.5

84.1

58.1

2780

3704

2518

673

4587

3211

2571

2370

9072

3446

20623

21919

51

57

41

57

46

7

23.2

177

11.71

3245

52.95

Tul
A480A7-VF
ATI RS480
754

26.18

400/2GB

ATX

Y/ x16/PCIE

3

8

1

4

Gigabit

0,1,0+1

4

✔

NA

24 pin

3.5

3.5

2

0

3.5

4.5

0

✔

✔

✔

✖

21.20

53

38.6

158.3

102.8

4611

3662

3336

1085

4674

3408

2800

2800

9192

3159

19081

20525

51

57

41

57

46

7

25.5

165

8.03

4730

55.41

ASRock
939A8X-M
ULi 1689
939

26.34

400/4GB

ATX

AGP 8x

3

8

0

4

10/100

0,1

2

0,1

NA

24

3.5

3.5

3.5

5

3.5

2.5

2.5

✔

✔

✔

✖

25.59

132.4

101.5

265.9

192.5

7610

4348

3223

1435

4628

3810

2209

2208

11037

3794

22912

24644

51

57

40

57

46

7

28.8

160

10.15

3745

62.08

Asus
K8N
Nforce 3
754

24.60

400/3GB

ATX

AGP 8x

5

8

0

4

10/100

0,1,0+1

2

✔

NA

20

3

1

1.5

2

3.5

2.5

2.5

✔

✔

✔

✖

21.50

44

36.5

120.7

99.5

4939

3777

3610

623

4724

3185

3096

3095

9202

3162

18976

20547

51

57

41

56

47

7

26.6

158.35

7.76

4900

53.86

Elitegroup
RS480 M
ATI RS480
939

23.90

400/2GB

ATX

PCIE

3

8

0

4

10/100

0,1

4

✔

NA

24

2.5

3.5

1.5

4

3.5

2.5

0

✖

✖

✖

✖

24.74

66.9

49.6

188.3

115.7

5849

4436

3744

1192

4069

3914

5618

5570

11024

3782

22885

24620

47

57

41

30

30

7

28.3

132

7.60

5000

56.24

Gigabyte
GA-K8NE
Nforce4
754

27.14

400/3GB

ATX

PCIE 16x

3

8

0

4

Gigabit

0,1,0+1

4

✔

NA

24

3

3

3.5

5

3.5

2.5

0

✔

✔

✔

✖

27.17

157.4

138.8

335.2

209.4

9125

3713

3597

1655

4721

3627

3083

3047

9114

3127

18883

20316

51

57

40

57

46

7

25.6

145.16

7.76

4900

62.06

Winfast
NF4K8AB
Nforce4
754

25.62

400/3GB

ATX

PCIE 16x

4

8

0

4

Gigabit

0,1,0+1

4

✔

NA

24

3.5

3

2.5

0

3.5

2.5

0

✔

✔

✔

✖

27.47

170.2

135.2

375.6

235.5

9146

3744

3596

1661

4807

3588

3085

3087

9199

3157

19066

20541

51

57

41

57

46

7

26.3

159

9.28

4095

62.37

Winfast
NF4K8MC
Nforce4
939

25.62

400/3GB

ATX

PCIE 16x

4

8

0

4

Gigabit

0,1,0+1

4

✔

NA

24

3.5

3

2.5

0

3.5

2.5

0

✔

✔

✔

✖

32.36

185.6

145.2

400.4

296.6

9350

4497

5574

2567

4738

4292

6009

6024

10948

3761

22695

24408

51

57

41

57

46

7

30.3

130.66

8.74

4350

66.72

Tul
A480M7-V
ATI Radeon xpress 200
754

24.08

400/2GB

Micro ATX

Y/ x16/PCIE

1

8

0

4

Gigabit

0,1

4

✔

NA

24

2.5

3.5

3

0

3.5

4.5

2.5

✔

✔

✔

✖

19.08

45.3

30.8

60.9

45.2

2105

3595

3206

630

4675

2995

2829

2829

9092

3130

18845

20254

51

57

41

57

46

7

24.5

160

8.31

4575

51.47
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The winner in this round was
once again the MSI RS480M2-IL,
which stamped its authority over
all the other boards with a
thumping 3918 overall score.

The second-fastest board,
again, the TUL A480M7-VF, could
manage 3408, significantly less
than the MSI board.

The MSI board’s score here

was the second-best of all the
AMD boards and was beaten
only by the WinFast NF4K8MC,
which had the advantage of a 
3D card.

The rear was again brought
up by the MSI RS 480-M which
managed a mere 2125, almost
half of what the winner in this
test scored!

Other Synthetic 
Benchmarks
We then benchmarked all these
boards on our trusted SiSoft
Sandra 2005 Professional and
measured various sub-system
performances. This test gives an
individual breakup of perform-
ance of the various aspects of 
the system.

AGP: Short for Accelerated Graphics Port,
this is a port made exclusively for graphics
cards and is significantly faster than PCI.
There are different AGP standards based on
speed, such as 1.0 (1x/2x), 2.0 (2x/8x) and
3.0 (4x/8x). The AGP 1x interface operates
at a clock speed of 66 MHz, AGP 2x
operates at 133 MHz and so on—the
multiple of the AGP device can be used to
calculate the clock speed of its interface.
BIOS: The Basic Input Output System is a
program located on the CMOS chip located
on the motherboard. The BIOS controls
the primary functions of the hardware and
facilitates low-level communication
between the OS and the hardware.
The BIOS can be upgraded to provide
additional functionality.
SDRAM: Short for Synchronous Dynamic
RAM, this is a type of memory that is
synchronised with the FSB of the
processor. It is available in various speeds
such as 66 MHz, 100 MHz and 133 MHz.
DDR RAM: Double Data Rate RAM is a
type of memory that handles data at twice
the speed of the older SDRAM. DDR RAM
typically operates at 266 MHz, 333 MHz
and 400 MHz effective speeds, while
the actual speeds are 133, 166 and
200 MHz respectively.
DDR2 RAM: Double Data Rate 2 RAM is a
memory type based on chips designed to
run at speeds higher than that of DDR
RAM, such as 533 MHz and 667 MHz. Very
few motherboards right now support
DDR2 RAM. In our tests this month, only
the Mercury PI915GVM supported it.
Dual Channel: When two RAM modules
are plugged into two slots marked for two
different memory channels, then,
theoretically, the data flows at twice
the normal rate through the RAM.
This is known as a dual-channel
memory configuration.
FSB: The Front Side Bus speed is the clock
speed at which different components in a
computer speak to the CPU. The CPU’s FSB
is very important, and changing it can
dramatically affect the overall performance
of the computer. Increasing it can improve
system performance but will also void your
CPU's warranty, and may sometimes cause
damage to the CPU due to excessive heat
generated at higher clock speeds.
Decreasing the FSB reduces performance,

but may be necessary when the highest
FSB supported by the motherboard is lower
than the default FSB of the CPU.
IDE: IDE stands for Integrated Drive
Electronics, and is a standard interface for
hard drives, optical drives and other
physical storage devices. It is also known
as ATA, which stands for Advanced
Technology Attachment. ATA33, ATA66,
ATA100 and ATA133 are its various types
based on the transfer speed. For example,
ATA100 means that the theoretical data
transfer rate of the interface is 100 MB/s.
It uses a 40 pin connector cable that may
consist of 40 or 80 conductors.
Multiplier: This is the ratio between the
CPU speed and the FSB speed. As an
example, a CPU with an FSB of 200 MHz
and a multiplier of 18 will work at 200 x
18 = 3,200 MHz.
Northbridge: This is a chip on the
motherboard that controls the FSB and
memory. This is the largest chip on the
motherboard and is normally covered by a
heat sink, and sometimes actively cooled
by a fan.
PCI: Peripheral Component Interconnect
is a standard that defines the connection
between the motherboard and expansion
cards. The data transfer rate of PCI bus
can be up to 133 MB/s.
PCI-Express: Peripheral Component
Interconnect Express is a new PCI
standard that transfers data at speeds
equivalent to AGP 16x, which is roughly
4.3 GB/s.
RAID: Abbreviation for Redundant Array
of Independent Disks, RAID is a software
or hardware configuration that employs
two or more drives in combination for
fault tolerance and performance.

Fault tolerance is a method used to
safeguard data by writing the same data
to two different partitions or different
hard drives so that a redundant copy is
available in case the first gets corrupted
or destroyed. This involves two write
operations at a time, so naturally, system
performance suffers. RAID 0, 1 and 0+1
are the commonly used types of RAID. 
RAID 0: This involves striping only, and
there is no data redundancy. It has the
best performance but no fault tolerance.
Striping is a technique in which the drives'
storage space is partitioned into units

ranging from 512 bytes to several
megabytes. These stripes are interleaved
and addressed in order.
RAID 1: This type of RAID implementation
is also known as disk mirroring, which
involves at least two drives to duplicate
data. Striping is not involved here. This
offers the best ratio of performance to
fault tolerance.
RAID 0+1: This combines the best
features of RAID 0 and 1. In this type of
RAID, two pairs of striped drives are
mirrored together to provide fault
tolerance. Thus, it requires four hard
drives to implement.
Matrix RAID: This is a technology
developed by Intel, which achieves what
RAID 0+1 achieves using only two hard
drives. It does so by creating two separate
volumes in an array of two hard disks. It
enables you to separate the two-disk
Array into two volumes, as if there were
two separate sets of hard disks.
SATA: Also abbreviated as S-ATA, SATA is
short for Serial ATA, which is an interface
for physical storage devices such as hard
drives. SATA uses a serial technology in
which data is moved in a single stream,
which is done much faster than a parallel
interface because unlike the parallel
interface, a serial interface is not tied to a
particular clock speed. The transfer rates
for SATA begin at 150 MBps, and for SATA
II it is 300 MBps.
Southbridge: This is the chip on the
motherboard that controls all the onboard
devices including the IDE bus and PCI bus.
This is the second-largest chip on the
motherboard and is sometimes covered by
a heat sink.
CNR slot: CNR is an abbreviation for
Communications/Network Riser, and the
CNR Slot was developed by Intel. It is a
slot on the motherboard that allows audio
and modem devices created for this
standard to be plugged into it.
OpenGL: Short for Open Graphics
Language. It is a vendor-neutral, multi-
platform programming language used
mainly to create 3D applications and
games. It was developed by SGI.
Underclocking: Reducing the clock speed
of the CPU. It is achieved by either
reducing the FSB speed or the multiplier
of the CPU.

Jargon Buster
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Again, for the ALU/RAM, the
939 socket processors got a bit
of an advantage and therefore
clocked higher scores. However,
this time, the Gigabyte
GAK8VM800 board stole MSI
RS480M2-IL’s shine and beat it
quite comfortably, scoring 2839,
where the MSI board could
manage just 2785, which was
the fourth-fastest, and which
was superseded by both the
TUL motherboards.

The FPU/RAM scores were
identical (as they should be) to
the ALU/RAM scores, and hence
the standings were the same.

Again, in the CPU subsystem
benchmarks, those with a 939
processor benefited and clocked
fairly higher than their socket
754 counterparts.

The ASRock 939A8x-M and
the Elite Group RS480M mother-
boards, out of the blue, totalled
the competition by scoring a
massive 11037 and 11024 to
comprehensively beat the
WinFast NF4K8MC, the third-
placed board. The MSI RS470M2-
IL did not feature even in the top
six, and did rather badly in the
CPU subsystem tests.

The ASRock completely
dominated these tests and
scored the highest in all the tests
except CPU Whetstone where it
came second with a score of
3794—second only to the Asus
K8SMX, which did marginally
better and scored 4033.

The WinFast NF4K8MC scored
3761 and did not even feature in
the top three here.

The file system benchmark
gives us the data transfer speed
from the system to the hard drive
and back. The scores were more or
less the same throughout this test,
except for the MSI RS480M, which
scored just 38 on the drive index
figure, and the MSIRS480M2-IL,
which scored 48. All the others
got 51.

The Krypton M7VIG scored
rather poorly here with 25, but

that’s because it
had an IDE drive
and did not support
SATA. The WinFast
NF4K8MC scored
the maximum in
this test and really
started to shine
from here on.

B u s i n e s s
Winstone is almost
an industry stan-
dard while trying

to measure the performance of a
system in everyday office use.
Since this is an entry-level moth-
erboard, it won’t really be used
in gaming, and hence this test is
extremely important as it
directly targets the segment
that these boards
will cater to.

The winner here
was the WinFast
NF4K8MC, which
scored an amazing
30.3, a score you
would be hard
pressed to get out of
even higher-end
boards. In fact, the
top three scores here
were quite high, with
the ASRock coming in
second with 28.8 and
the Elite Group
RS480M coming in
third, scoring 28.3.
The MSI RS480M2-IL lost out in a
big way, scoring a minuscule 24.4!

To get a taste of their real
performance, we decided to do a
final test and manually clocked
the time it took the boards to
encode a video file. Encoding a
video file is again processor-
dependant, and hence the 939-pin

boards benefited.
The winner, again,

was the WinFast
NF4K8MC, which
converted the file in just
130 seconds, compared
to 132 seconds taken by
the Elite Group RS480M.
Surprisingly, the MSI
RS480M, despite being a
754 processor, clocked
135 seconds. The MSI
RS480M2-Il clocked 140,
which is poor. 

The reason we are
emphasising the 10-
second difference is
because the video file

used was a relatively small 100
MB. If ever you try encoding a
larger file— say a movie or a home
video—it would take significantly
longer on the RS480M2-IL than it
would on the NF4K8MC.

Needless to say, if you’re into
any sort of image editing or
manipulation, you’re better off
with the NF4K8MC.

Conclusion
Clearly, the winner here is debat-
able. Debatable or different,
depending on the kind of usage
you would put your computer
through, and your requirements.

If you would just like to have
an entry-level motherboard that
gives you everything onboard and
don’t want to do too many fancy
things, the best solution for you
would be the MSI RS480M2-IL. 

This is a nicely balanced
board with all the required
features but not necessarily the
most advanced features (for
example, it has six-channel
audio, which is just fine, instead
of eight). Hence the MSI-
RS480M2-IL gets the Digit ‘Best

3D Mark 2001 SE

ASUS K8S-MX-UAYZHigher is better

Higher is better

Ziff Davis Business Winstone 2004

Video Encoding

Time taken in seconds, lower is better.
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Buy Gold’ in the AMD onboard
graphics category.

A special mention here must
be made of the TUL mother-
board. This board may
not be an outright
shiner, but if you don’t
want to spend more than
Rs 4 to 4.5k, then this is the
perfect choice for you.

If you have a budget
constraint but don’t mind spend-
ing a little extra on a graphics
card (roughly Rs 4,000 for an
nVidia 6200 or the ATi-based
X300), then the best solution for
you would be the WinFast
NF4K8MC. This board has the
most surprising performance
that we have seen in a while from
a board in this category. It gives

you excellent
features (almost
everything you would find
anywhere else, except SLI!),
performance and above all, an
unbeatable price. So, if you don’t
mind spending that little bit
extra, look no further!

The price, performance and
features contribute towards
making the WinFast NF4K8MC
the Digit ‘Best Buy Gold’ in
the ‘AMD Without Onboard
Graphics’ category.

We would like to make a
mention here and say that if you
need to choose between two
boards, go for one with a 939
socket. Even if the board costs
marginally more now, it will
more than make up for it later
when you want to upgrade to a
faster processor.

THE INTEL 
MOTHERBOARDS
Let us now have a look at what the
Intel platform had to offer. Intel
motherboards traditionally used
to be driven by chipsets manufac-
tured by Intel itself, and occa-
sionally by Via. But today, even
entry-level motherboards are
based on chipsets manufactured
by Intel, Via, SiS and ATi. Like
AMD, each chipset manufacturer
has tried to cram every possible
feature that it could.

Just as we saw in the AMD
boards, despite these boards
having been labelled as ‘entry-
level’, many of the features that
had previously been available
only in high-end boards have

become standard in these
boards. The features we are

talking about are SATA, RAID,
FireWire, Gigabit LAN, etc. Many
of the boards also featured PCIe.

Features
Let’s take a look at the features
offered by these boards. 

A majority of the boards
supported the LGA 775 socket
interface which, apart from being
the latest from Intel, is also a lot
safer, as the pins which tradi-
tionally used to be on the CPU
are now on the socket. The lock-
ing mechanism is also sturdy,
and the heat-sink fan assembly is
very easy to lock onto the moth-

Foxconn is a new entrant to the motherboard
market in India, and they sent us three

boards to test. The 915PL7AE board is based
on the Intel 915PL chipset and was taken out
of the contest because it was the only board
for the Intel platform that did not feature
onboard video.

This motherboard has an LGA 775 socket
CPU interface. It supports up to 2 GB of
DDR 400 MHz memory in dual-
channel configuration.
There are four SATA
connectors and they
are configurable as
RAID 0, 1, 0+1 as well as
Matrix RAID. Onboard Gigabit
LAN is also provided. But there is only
one IDE connector.

There are four USB2.0 ports. The onboard
audio solution is an 8-channel based on the
Realtek chip. There are three PCI slots and a
PCIe x1 slot provided for expansion. The layout
of this deep-blue coloured board is also
quite spacious.

As mentioned before, there is no
onboard video. But then there is a PCIe x16
slot. In addition to this, there is a F.G.E.
(Fox Graphics Extension) slot that is AGP
8x compliant.

This board is a very good option,
especially if you are planning to buy a
motherboard as an upgrade to your machine.
If you have an AGP card, you can keep using
it—there will be no need to invest in a PCIe
card. You also have an upgrade option for the
future, and if and when you wish to buy a

PCIe card, you can just plug it in
and get going.

On the
performance front,

this motherboard leads
the pack. In Serious Sam

SE, it logged a score of 133.1,
while in Quake 3 Arena, it was

282.1 at 800 x 600 at 32-bit colour. In
3DMark 2001 SE, the score was 9101.
This excellent performance must be

attributed in part to the nVidia 6200 256 MB
PCIe card used in the test. However, you can't
discount the fact that the motherboard plays
an important role in these scores.

In SiSoft Sandra, too, this motherboard
was better than the others. Its PCMark score
was 4,945. In the ZDBench Business Winstone,
it scored a decent 26.1. You can conclude that
the board is very good for office work and
gaming alike. At Rs 4,290, this board is a
real steal!

Foxconn 915PL7AE-8S

Gigabyte
GA-8I915ME
Intel 915
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erboard and it
locks firmly too,
ensuring that the heat-sink and
the CPU remain in full contact.
In the Socket 478 interface, the
heat-sink and fan assembly
mounting is a comparatively
cumbersome thing to do.

Of the chipsets available for
this platform, no points for guess-
ing this one—Intel dominated
across the range of the mother-
boards. The Intel chipsets ranged
from the ageing Intel 845 to the
newer Intel 915GV. We had to
underclock the CPU so we could
test the Intel 845 motherboards,
since they did not support the 400
MHz FSB that our test CPU
Pentium 4 3.2 MHz sported.

That should give you an idea
of how dated the 478 socket is.
Intel has already stopped making
processors for socket 478, and any
stock you can find is leftover stuff.

On the memory support front,
we found that the Asus P5P800-
MX, the AOpen i915Gm-I, the
Gigabyte GA-8I915GV and the GA-
8IG1000, as well as the boards
that featured the ATi RS350 
and RS400 chipset, supported a
maximum of 4 GB of DDR 400
MHz RAM.

The Mercury PI915GVM based
on the Intel 915GV chipset was the
only one to offer two DDR2
memory slots, supporting a maxi-
mum of up to 2 GB of 533 MHz
RAM, in addition to two DDR slots.

The Intel 845-based boards
were FSB limited to 266 MHz, and
hence supported up to 2 GB of 266
MHz DDR memory.

Most of the boards supported
the dual-channel memory config-
uration. This makes a difference
in memory-intensive applications
such as photo-editing applica-
tions, and dramatically reduces
loading times due to the high
available bandwidth.

A majority of the boards had
AGP 8x slots, and quite a few of
them also had PCIe x16 slots. The

thing to note is that while
AGP 8x slots

provide an
option to
u p g ra d e

the graph-
ics card and

hence, is always
preferable over

onboard graphics, a PCIe
x16 graphics slot is prefer-

able since AGP is slowly but
surely making way for PCI-Express
and, as you may be aware, PCI-
Express graphics cards are already
available in the market and will
offer a better
performance than
their AGP counter-
parts once games
utilising their
complete band-
width and capabil-
ities are launched.

Some mother-
boards such as the
Gigabyte GA-
8I915GV had only
onboard graphics.
It had neither an
AGP slot nor a PCIe
slot and provided
no graphics
upgrade facility. This is not a good
thing, and such motherboards
should be avoided unless you are
very sure you will not want to go in
for better graphics later. 

In contrast, motherboards
such as the Foxconn 915PL7AE-8S
boasted of a PCIe x16 slot in addi-
tion to a F.G.E. 8x (Foxconn
Graphics Extension) slot, which
is compatible with the AGP 4x/8x
specifications and lets you plug
in a standard AGP card. Thus you
are free to choose
between an AGP or
PCIe graphics card
as it suits you. Or, if
you are upgrading to
this board, you can plug in
your old AGP card, and you
won’t have to invest in a new
card. However, this board did not
come with onboard graphics.

One motherboard, the ASRock
775Dual-915GL, provided an A.G.I.
8x interface that is compatible
with the AGP 8x interface in addi-
tion to the A.G.I. Express interface,
which is compatible with PCIe x4.
A DirectX 9.0c-compatible onboard
Intel Extreme Graphics 2 is also
present, which is quite decent in
terms of performance compared to
the older Intel Extreme Graphics.

The speciality of this board is
that it lets you plug in both an

AGP as well as a PCIe card at the
same time, thus facilitating a
multi-monitor working environ-
ment. This is just an additional
feature which might not be of
much value today, since multi-
monitor display cards can do the
same job at the cost of a single
display card.

Of the onboard display cards,
the ones from ATi, especially the
RS400 from HIS, really shone
bright because they provided not
only commendable performance
for onboard graphics, their image
quality was also quite good.

On the audio front, none
of the motherboards came
with minimum of six-chan-
nel audio. 

The ASRock 775Dual-
915GL, Foxconn 915PL7AE-8S,
Gigabyte GA-8IG1000 and GA-
8I915GV came with as many
as 7.1 channels. What this
means is that these sound
systems are enough to satisfy
your most demanding needs,
be it in gaming or watching
DVDs. With such an onboard
system available, one would
not find it necessary to invest
in a separate sound card.

SATA, which has so far been
considered high-end, has finally
made its entry into the budget
segment. All the boards sported
SATA ports, with half the lot
having four and the remaining
having two ports.

The Gigabyte 8TRS 350MT
even supported RAID. Two moth-

erboards, the HIS M48-

F3 based on Intel 845 and
the HIS FA61 based on Via

P4M800 did not have SATA ports.
From a future upgrade perspec-
tive, having a SATA port is neces-
sary, since the slower and smaller
IDE drives will soon become a
thing of the past.

Only the MSI RS350M-ILSR
had a FireWire port. A FireWire
port is a good thing to have espe-
cially if you are into video
capturing, because many video

AOPEN i915Gm-I 

ASRock 775 
Dual-815GL-M-ASR
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Scoreboard                             Intel Motherboards  
BRAND 
Model

Chipset

Interface type

Features

Memory Speed Supported/Max memory

Form Factor

Onboard/Graphics Port/Type

PCI Slots

Onboard Sound (Channels)

Onboard FireWire/Firewire b

USB

USB 1.1 (Nos)/USB 2.0 (Nos)

Ethernet/Gigabit Ethernet

RAID 0, 1, 0+1

SATA 

SATA RAID

HyperThreading Support 

Power Supply Type (Pins)

Component layout (SO5)

Capacitors near the CPU socket

Placement of IDE and SATA connectors 

Memory Slots and the lock on the AGP slot

AGP slot with locks

Locking mechanism of the processor

Interference of AGP card with PCI card

Colour coding of Memory slots and front USB

Package contents 

Manual

CD's 

Necessary cables

Other Miscellaneuos Features

Performance

Serious Sam Second Encounter

Normal (640x480x32) 

High (800x600x32)

Quake3 Arena

Normal (640x480x32)

High (800x600x32)

3D Mark 2001 SE 

PC Mark 2004

CPU Index

Memory Index

Graphics

Disk Index

Total Score

Sisoft Sandra 2005 Professional

Memory sub-system

ALU/RAM

FPU/RAM

CPU sub-system

CPU Dryhstone

CPU Whetstone

Multimedia - CPU  Integer

Multimedia - FPU SSE

Disk drive 

Drive Index MB/sec

Sequential Read MB/sec

Random Read MB/sec

Sequential Write MB/sec

Random Write MB/sec

Average access time

Zdbench Business Winstone 2004

Video Encoding (Time in secs)

Price Index

Price (Rs)

ASUS
P5P800-MX
Intel 865GV
LGA 775

20.42

400/4GB

Micro ATX

Y/8x/AGP

3

6

0

4

10/100

✖

4

✖

✔

24

3.5

3

3

0

4

3

2.5

✖

✔

✖

24.73

54.3

47.4

151.4

125.1

5762

4815

5176

1054

4793

4508

4564

4550

10417

4309

24255

28676

47

57

30

56

47

15

25

152

8.41

4520

53.55

Foxconn
865M01-G-6LS
Intel 865G
Socket 478

22.94

400/2GB

Micro ATX

Y/8x/AGP

3

6

0

4

10/100

✖

2

✖

✔

20

3.5

3.5

3

5

3.5

3

0

✔

✔

✔

22.14

50.9

37.8

84.1

57.4

2812

4839

4369

581

4909

3820

4303

4315

9850

4014

24584

35115

47

57

30

57

46

19

22.6

142

10.20

3725

55.28

Foxconn
915PL7AE-8S
Intel 915PL
LGA 775

25.86

400/2GB

Micro ATX

PCI-E x16/AGP 8x

3

8

0

4

Gigabit

0,1,0+1

4

✔

✔

24

4

2.5

3

5

4

4

0

✔

✔

✔

31.05

152.4

133.1

370.7

282.1

9101

5481

5154

1669

4866

4945

4524

4537

10454

4297

25476

33835

47

57

27

56

46

20

26.1

120

8.86

4290

65.77

Gigabyte
GA-8IG1000-G
Intel 865G
Socket 478

27.72

400/4GB

Micro ATX

Y/8x/AGP

5

8

0

2

Gigabit

✖

2

✖

✔

20

3

3

3.5

5

3.5

3

2.5

✔

✔

✔

22.29

42.1

34.9

99

78.4

3096

4763

4384

657

4195

4043

4213

4212

9811

4018

24733

34645

51

57

41

57

45

7

21.9

138

9.05

4200

59.05

Gigabyte
GA-8I915ME
Intel 915
LGA 775

19.46

DDR400/2GB

Micro ATX

Y/x16/PCIE

2

6

0

4

10/100

✖

2

✖

✔

24

4

3

2.5

5

4

3

0

✖

✔

✖

23.71

45.9

41.8

148.2

142.6

5516

4644

4807

1043

4222

3907

4541

4543

8715

3591

21166

27971

51

57

41

57

46

7

21.1

142

9.74

3900

52.91

Gigabyte
GA-8I915GV-MF
Intel 915GV
LGA 775

22.76

400/4GB

Micro ATX

Y/x16/PCIE

2

8

0

4

Gigabit

✖

4

✖

✔

24

4

4

3

0

4

0

2.5

✔

✔

✔

23.52

45.7

41.4

140.2

135.8

5301

4589

4756

1039

4919

3928

4641

4638

8718

3571

21183

28198

46

57

27

56

47

20

21.6

145

7.60

5000

53.88

Gigabyte
GA-8TRS 350MT
ATI RS350
Socket 478

25.82

400/4GB

Micro ATX

Y/8x /AGP

3

6

0

4

10/100

0,1

2

✔

✔

20

3.5

3.5

3

5

3.5

3

2.5

✔

✔

✔

23.79

54.6

47.5

178.5

131.7

5414

4429

4080

1520

4835

4344

4008

4002

9779

4023

24753

34370

46

56

27

56

47

18

22.6

142

9.50

4000

59.11

AOpen
i915Gm-I
Intel 915G
LGA 775

27.1

400/4GB

Micro ATX

Y/x16/PCIE

2

7

0

4

10/100

✖

4

✖

✔

24

4

4

4

5

4

4

2.5

✔

✔

✔

22.77

43.5

39.6

133.5

130.7

5106

4284

4658

1026

4876

3660

4670

4659

8139

3342

19750

26125

46

57

26

56

43

20

21.1

150

8.00

4750

57.87

ASRock
775Dual-915GL
Intel 915G
LGA 775

22.1

400/2GB

Micro ATX

Y/8x/AGP

2

8

0

4

10/100

✖

4

✖

✔

20

4

4

2.5

0

4

3

0

✔

✔

✔

22.61

44.2

40.1

135.5

132.4

5115

4311

4316

1028

4877

3452

4050

4055

10412

3361

19910

26321

46

57

26

56

45

20

21.8

146

9.25

4110

53.95

JULY 2005
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HIS
FA61
VIA P4M800
LGA 775

21.58

400/2GB

Micro ATX

Y/8x/AGP

2

6

0

2

10/100

✖

✖

✖

✔

20

3.5

3.5

2.5

5

4

4

0

✔

✔

✔

20.13

31.2

21.5

49.8

31.8

1480

5388

3573

557

4899

3855

2571

2570

10458

4300

25410

33850

44

57

21

55

45

30

24.4

132

8.64

4400

50.35

HIS
RS400
ATI RS400
LGA 775

26.74

400/4GB

Micro ATX

Y/x16/PCIE

2

6

0

4

10/100

✖

4

✖

✔

24

4

4

4

5

4

4

2.5

✔

✔

✔

24.27

57.8

40.5

176.9

112.9

5931

5415

4343

1654

4401

4865

3968

3974

10470

4303

25437

33880

41

56

24

32

32

23

24.6

126

7.04

5400

58.05

HIS
M48-F3
Intel 845GL
Socket 478

20.7

266/2GB

Micro ATX

Y/8x/AGP

2

6

0

2

10/100

✖

✖

✖

✔

20

3

3.5

2.5

5

3.5

4

0

✔

✔

✔

13.49

26.5

21.1

64.9

51.7

1771

2642

2184

522

3198

2219

1689

1693

5309

1458

12385

15522

37

41

31

40

30

8

16

201

16.52

2300

50.72

Mercury
PI865GVM-AGP
Intel 865GV
Socket 478

23.1

400/3GB

Micro ATX

Y/8x/AGP

3

6

0

4

10/100

✖

2

✖

✔

20

3.5

3.5

3

5

3.5

3

0

✔

✔

✔

20.99

48.9

38.4

94.5

74.9

2940

4247

4278

617

4716

3524

4126

4143

8506

2338

19872

24910

45

57

23

56

46

26

23.1

149

11.88

3200

55.96

Mercury
PI915GVM
Intel 915GV
LGA 775

26.62

DDR I/II 400/533 2GB

Micro ATX

Y/x16/PCIE

2

6

0

4

10/100

✖

4

✖

✔

24

3.5

3

3

5

4

4

2.5

✔

✔

✔

25.62

50.5

46

157.4

142.5

5549

5477

5088

1055

5005

4574

4413

4415

10464

4282

25416

33840

47

57

28

56

46

19

24.5

121

7.60

5000

59.84

MSI
RS350M-ILSR
ATI RS350
Socket 428

21.38

400/4GB

Micro ATX

Y/8x/AGP

3

6

1

4

10/100

✖

2

✖

✔

20

3

3

3.5

5

3.5

3

2.5

✖

✖

✖

21.73

25

21.9

85.2

72

4469

4826

3903

1103

4128

4051

3622

3617

9856

4026

24758

34651

51

57

41

57

47

7

21

145

9.74

3900

52.85

MSI
915GVM-V
Intel 915GV
LGA 775

21.9

400/2GB

Micro ATX

Y/8x/AGP

2

6

0

4

10/100

✖

4

✖

✔

24

4

4

2.5

0

4

3

2.5

✔

✔

✔

25.87

53.4

49.1

157.1

145.2

5571

5492

5108

1070

5008

4584

4552

4551

10491

4301

25488

33861

47

57

26

57

47

18

24.8

120

8.44

4500

56.21

MSI
PM8M2-V
VIA P4M800
LGA 775

20.7

400/2GB

Micro ATX

Y/8x/AGP

2

6

0

4

10/100

✖

2

✖

✔

20

4

4

2.5

0

4

3

2.5

✔

✔

✔

20.46

33.1

22

52.3

31.5

1501

5403

3588

559

4910

3872

2610

2612

10466

4318

25423

33867

45

57

32

56

46

25

24.7

130

10.56

3600

51.72

Mercury
PVCLE266M-L
VIA CLE266
NA

15.06

266/2GB

Micro ATX

Onboard S3

2

6

0

4

10/100

✖

✖

✖

✖

20

NA

2.5

NA

NA

NA

NA

0

✔

✔

✔

5.42

6

5.6

25.2

17.9

361

467

309

173

3141

451

228

226

988

231

2119

2538

37

41

31

39

29

8

5.5

Failed

11.88

3200

31.03

HIS
FA60
Intel 915G
LGA 775

24.5

400/2GB

Micro ATX

Y/x16/PCIE

2

6

0

4

10/100

✖

2

✖

✔

24

3.5

3

3

5

4

4

2.5

✔

✔

✔

22.81

43.2

37.1

135.2

134.5

5004

4302

4685

1034

4801

3735

4516

4510

8150

3340

19797

26210

47

57

29

56

46

16

21.6

150

9.05

4200

56.35
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capture devices make use of this
interface to transfer video to the
hard drive.

Only Gigabyte’s GA-8I915GV
and GA-8I1000G came equipped
with Gigabit LAN.

USB ports were also standard
accessories on all the mother-
boards. The Gigabyte GA-8IG1000,
HIS FA61 and HIS M48-F3 had
only two USB ports, whereas the
others had four.

Most boards came with two or
three PCI slots. Since video,
sound and LAN come onboard,
the necessity to add PCI cards for
these functions has been elimi-
nated. Hence, a lower number of
PCI card slots will not be much of
an issue, as there are only a few
types of add-on cards that you
might want—such as TV
tuner cards.

Almost half
the boards had a
24-pin power
connector. The
others had the stan-
dard 20 pin connector. As
we’ve mentioned earlier, while
buying a power supply, you need
to be careful about the pin count.

How They Fared
As with AMD, we began our
benchmarking by seeing how the
boards would fare on the graph-
ics and gaming front. Even
though this might not be what
the targeted user might use the
boards for, it is still a good
way to test the speed and
system performance.

The motherboard that scored

the highest in our Serious Sam
test was the Foxconn 915PLAE-8S.
This board scored a mammoth
152 and 133.1 fps in the 640 x 480
and 800 x 600 resolutions.
However, it must be pointed out
that this board lacked an
onboard graphics solution, so
we’d used an nVidia GeForce
FX6200 PCIE card, which led to a
substantial increase in scores.

The HIS RS400 came in
second with 57.8 and 40.5, and
was followed by the Gigabyte
8TRS 350MT, which logged a
commendable 54.6 and beat the
HIS RS400 in the 800 x 600 scores
by logging 47.5.

The worst performer here was
the MSI RS 350M-ILSR. This ATi
RS350-based socket 478 mother-
board logged a measly 25 and
21.9 fps, and you should steer
clear of it if you have even the
remotest chance of running an
application that is even slightly

graphics-intensive.
We then put the

boards through a few
demos of Quake 3 Arena,
and the picture changed
slightly—but not at the
top. That was ruled
completely by the
Foxconn 915PL7AE-8S,
which logged a humon-
gous 370.7 and 282.1,
but of course, as we’ve

mentioned before, it had a
graphics card to help it with the
games! The second-placed board
here was the Gigabyte 8TRS
350MT, which logged 178.5 and
131.7 for the above-mentioned
resolutions, and barely edged
out the newer LAG775 socket 
HIS RS400 which clocked 176.9
and 112.9 fps.

The board that did miserably
here was the MSI PM8M2-V. This

Via-based board scored really
bad—52.3 and 31.5. Of course, 31.5
is very playable, but it is not
acceptable considering the kind
of scores the other boards
were logging.

Another board that
performed beautifully was the
Mercury PI915GVM. The board
logged a commendable 157.4 and
142.5 fps, and came in fourth.

The real graphics benchmark,
3DMark 2001 SE, gave us rather
surprising results.

The board that lost out
hugely here was the HIS FA61,
which logged a mere 1480—which
was quite surprising, as the board
was based on the new Via
P4M800 chipset and is an LGA
775 socket.

Its more powerful and newer
cousin, the HIS RS400, logged an
impressive 5951 3Dmarks, and
stood first by a fair margin over
the second-fastest board, the Asus
P5P800-MX, which clocked 5762.

The third-fastest was the MSI
915GVM. It scored 5571 3DMarks,
and just barely edged out the
Mercury PI915GVM, which came
in fourth with a score of 5549.

Serious Sam (800x600)

Quake III (800x600)

HIS RS400 

FPS score, higher is better

FPS score, higher is better
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included while evaluation as
775 is the de facto Intel socket,
and 478 has been phased out.

In the memory subsystem,
the AOpen emerged the winner,
scoring 4670 in the ALU/RAM 
and 4659 in FPU/RAM tests. This
was a slightly higher than 
the second-placed Gigabyte
GA8I915GV-MF, which scored
4641 and 4638. The Foxconn
board managed just 4524 and
4537, and thus lost out here. The
worst scores came from the HIS
FA-61, which could manage just
2571 and 2570 respectively.

The CPU sub-system scores
were quite varied and produced
various winners. The Dhrystone
test was won by the MSI PM8M2-
V, which scored 10466 and

marginally beat
the Mercury
PI915GVM, which
scored 10464. The
difference is mean-
ingless, really—
both boards get a
joint first here!

The Whetstone test was won
by the MSI PM8M2-V with a score
of 4318, which was just about
better than the 4309 scored by
the Asus P5P800-MX, which is an
865GV-based board and is not on

PCIe—hence the performance is
quite commendable.

The multimedia CPU test was
won by the HIS RS400 with a
score of 25437, and the FPU test
was won by the MSI RS350M-ILSR
with a score of 34651. 

In the disk index tests, only
three boards scored 51—these
were the MSI RS350M-ILSR, Giga-
byte GA-8IG1000 and GA-8I915GV.
All the other boards ranged from
37 (for the HIS M48-F3) to 47.
Hence the HIS M48-F3 is the last
placed board here.

In our Business Winstone
Benchmark, the clear winner
once again was the Foxconn
915P7AE-8S with a score of 26.1.
It quite comfortably beat the
second-placed Asus P5P800-MX,

which scored 25. With a low 16,
the loser here was the HIS M48-
F3. The board was severely
hampered by its older socket
and chipset.

The final real world test 
we undertook was the video
encoding file test. The test
ended in a tie between the
Foxconn 915 board and the MSI

915GVM-V, both taking
just 120 seconds to

encode our test file. If
you plan to indulge in

any amount of video
encoding, these are the

boards you definitely need to
look at!

The worst times here were
posted by the HIS M48-F3, which
took a mind-boggling 201
seconds to do the same job! The
board was, again, limited by its
chipset and the socket.

The 21-point difference is almost
negligible, and these boards
should be considered on par for
all practical purposes.

The Foxconn 915PL7AE-8S
scored a massive 9101 3DMarks,
but since it was tested with a
graphics card, it is completely
unfair to compare this board to
the boards tested with their
onboard video solutions.

In our overall system bench-
mark, PCMark 2004, everything
went topsy-turvy. The MSI
915GVM-V logged the highest
CPU index at 5492, edging out
the Foxconn 915, which came in
second at 5481. The third spot
was taken up by the Mercury
PI915GVM, which logged a close
5477—which was not all that
surprising, since all these
boards were LGA 775-based and
had the same CPU.

The overall scores of this
benchmark reflected the true
overall system performance and
here, the Foxconn 915PL7AE-8S
lead by a hairsbreadth over the

HIS RS400 which clocked 4865,
which is extremely good consid-
ering the fact that the scores of
the Foxconn were bumped
up by the external graphics
card.

In SiSoft Sandra, our
second synthetic benchmark
for system performance, the
LGA 775 socket processors had
an advantage over the older
socket 478 processors in the CPU
subsystem tests but as was the
case in AMD boards, this advan-
tage should be noted and

3D Mark 2001 SE

PC Mark 2004

Video Encoding

Ziff Davis Business Winstone 2004

Higher is better

Higher is better

Higher is better

Time taken in seconds, lower is better.

MSI PM8M2-V
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Conclusion
With the various flip-flops in the
scores, we had an interesting
time trying to come up with
a winner.

Since this is a budget cate-
gory and we are looking at
boards which should provide
all onboard solutions
including video, the
Digit Best Buy Gold
award goes to the
Mercury Pi915GVM-V.

This board is certainly not
the best-performing board, but
then we are not in the perform-
ance category—plus the board is
near the top if not at the top in
almost all our tests. It is a
balanced board with lots of

Telephone Web siteCompany E-mailBrand

Contact Sheet Motherboards

Aopen
ASRock
ASUS
Elitegroup
Foxconn
Gigabyte
HIS
Krypton
Mercury
MSI
TUL
Winfast

Xserve India (Pvt) Ltd.
Abacus Peripherals Pvt. Ltd
ASUSTeK Computer Inc.
Cyberstar
Mediatech India
Gigabyte Technology (India) Ltd.
Maxtone Electronics
Priya Ltd
Kobian ECS India Pvt ltd
Tirupati Enterprices
Mediatech India
Mediatech India

080-5113 1001
022-56923941/44/45
022-56490048
022-28386711/13
022-26361111
022-26526696
022-23016468
022 5663199/97
022-23020767 / 774
033-22251192
011-5151 1234
022-26361111

info@xserves.com
ajain@abacusperipherals.com
info_India@asus.com.tw
navin@cyberstarindia.com
digit@mediatechindia.com
sales@gigabyte.in
maxtone@vsnl.com
sejal.shah@priyagroup.com
mumbai@kobian.com
mail@tirupati.net
digit@mediatechindia.com
digit@mediatechindia.com

www.aopen.com
www.asrock.com
www.asus.com
www.ecsusa.com
www.foxconnchannel.com
www.giga-byte.com
www.maxtone.com
www.priyagroup.com
www.kobian.com
www.msi.com.iw
www.tul.com.tw
www.leadtek.com

features, and since it is
PCIe-based and also
supports LGA 775, you
will have plenty of
upgrade options.

We would like to
clarify that even
though in terms
of pure scores
logged, the
Foxconn should be
the ‘Gold Award
Winner’, the result is
clearly due to its graph-
ics performance scores,
which would be an
unfair comparison as
the Foxconn board had
a 6200 graphics card
on it. On all other
aspects, our winner is
neck and neck with
the Foxconn, so the
Mercury board was
declared the winner.

What you must
keep in mind is that the
Foxconn motherboard
does not have onboard
video, so if you don’t
mind spending a little
extra on the additional

graphics card, we would
absolutely recommend this
board, as in all other aspects, it
is on par with, if not better

JULY 2005

Mercury
PI915GVM
Intel 915GV

than, the Mercury
Pi915GVM-V.

The Digit ‘Best Buy Silver’
award goes to Gigabyte 8TRS-
350MT. This board is a consistent
performer, and at the moment is
a good buy. However, we would
also like to point out that it is
not entirely advisable to buy this
board as it is based on socket
478, and Intel has stopped manu-
facturing processors for that
socket. Also, this board is based
on an older chipset and would
not allow you to upgrade to 
a PCIe-based graphics card in 
the future.

If you want a commendable
performer with a decent price tag
and future upgradeability, you
should consider the HIS RS400.
This board is an LGA 775 board
and supports PCIe. 

It is amazing what the entry
level boards of today have as
standard features. If the trend
continues, in a year’s time we
might even see SLI and dual-core
support being offered for Rs
5,000 or less! With the advent of
Intel Extreme Graphics 2 and
ATi’s onboard graphics provi-
sions, you are no longer limited
to playing arcade games on
entry level PCs. 

You can now go and buy some
of the entry-level games (read
high-end games of yesterday,
such as Unreal Tournament
2003!) and enjoy them without
the need of an additional 3D
graphics card. 

The choices and options are
immense, and the prices are
extremely low. Now you need not
think ten times before going in
for an upgrade, as the features
and prices on these boards will
give you decent performance at
an extremely low cost.

May this trend continue! 
varun_dubey@thinkdigit.com

jayesh_limaye@thinkdigit.com

Gigabyte GA-8TRS
350MT

AMD

Intel

Indicative System Prices

Component
Processor
Motherboard
RAM
Hard Disk

Floppy Drive
DVD Combo Drive
Monitor (15/17 inch)
Keyboard
Mouse(Ball/Optical)
Cabinet
Total

Processor
Motherboard
RAM
Hard Disk

DVD Combo Drive
Monitor (15/17 inch)
Keyboard
Mouse(Ball/Optical)
Cabinet
Total

MMooddeell
Athlon 64 3200+(939)
MSI RS480M2-IL
Transcend 512MB DDR400
Seagate Barracuda 80GB 
(7200RPM)
Sony
Lite-On DVD Combo drive
LG
Logitech
Logitech 
Kobian

Intel P4 2.8 (LGA 775)
Mercury PI915GVM
Transcend 512MB DDR400
Seagate Barracuda 80GB
(7200RPM)
Lite-On DVD Combo drive
LG
Logitech
Logitech 
Kobian

Price (Rs)
9400
5395
2500
2700

300
2450
4650/5650
300
300/500
1200
28895

6750
5000
2500
2700

2450
4650/5700
300
300/500
1200
25550

If you choose a socket 754 board, such as the TUL A480A7-VF then you
can go for Athlon 64 2800+ (754) costing Rs 5200. Total System Cost:
Rs 24395. If you go for a board without on board graphics like the
Winfast NF4K8MC, then you will need to pay Rs 3500 for XFX Geforce
6200 256 MB (TC) PCIE graphics card. Total System Cost: Rs 32750

If you choose our silver winner Gigabyte GA-8IG1000-G (socket 478)
then you can go in for the P4 2.4 (478 socket) processor costing 
Rs 5650 and your total system cost would then be Rs 23650

JULY 2005



just anyone
can sit down
and learn
overnight. For
the SoHo
segment, or even
for a personal Web
site, hiring a few
site developers to build
your site is also not an
option. What next, then?

Nuke ’em
PHP, the open source alternative
to Microsoft’s ASP, is the obvious
choice to build a Web site. Why?
Because it is cross-platform—a PHP
site can be hosted on any Web
server, running any OS, unlike
ASP, which needs a Microsoft OS—
and because it’s open source.

The biggest advantage of open
source software is the thousands
of developers who dedicate time to
improve or simplify such software.

PHP-Nuke is a project by dedi-
cated developers who decided that
people shouldn’t need to know
how to code in order to develop
their own PHP-based Web sites.

There are
many offshoots

of PHP-Nuke, which is
the beauty of open source,

and these are listed in the box
“Options”. The installation and
control panel of each do not logi-
cally differ much from PHP-Nuke,
so you can feel free to experiment
with some of them as well.

Here, however, we will stick to
PHP-Nuke, and learn how to
install, configure, and finally,
tweak it to give you a Web site
that’s unique and looks exactly
what you want it to look like.

Prerequisites 
There are some things you will
need to have in place before you
can begin setting up your site,
such as a domain name and
hosting space on a Web server
that supports PHP and MySQL
databases. Both are relatively
easy to find.

Robert Sovereign-Smith

ost SoHo businesses today
need to have a Web pres-
ence, especially given the

increasing number of searches for
products and solutions being
conducted online. The days of
consulting the Yellow Pages are
almost gone, at least in every city
or town that’s been Net-enabled
for the past two years.

Previously, in this space, we’ve
shown you how you can set up a
very basic HTML-based Web site—
at almost no cost. Now, for you to
take your Web site to the next
level, and start creating a true
online presence, you need to get
into the world of scripted Web
pages, and things such as server-
side scripting to create dynamic
Web pages that will give your site
the professional look it needs. 

This is where coding languages
such as Microsoft’s ASP (Active
Server Pages) and PHP (PHP: Hyper-
text Preprocessor) come in.
However, it’s not something that

M

When it
comes to
Web sites,
HTML can
be limiting.
Learn how
PHP can
expand the
possibilities
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When you sign up for Web
hosting, you will be told how to
control your databases. Most
hosting companies offer a
simple phpMyAdmin or
mysqladmin front-end for
managing your databases. In our
example, using GoDaddy.com’s
hosting package, we got an allo-
cation of one database, which
we created from our account at
GoDaddy.com itself.

You will have to create a data-
base here and call it anything you
want. Now you will have to use the
phpMyAdmin or mysqladmin
front-end to create the hundreds of
tables and thousands of fields in
MySQL that PHP-Nuke needs. 

Fortunately, all you need to do
is find a link called SQL, as shown
in the accompanying screenshots.

Adding PHP-Nuke
Tables To The Database
Once you click on the SQL

link, you will see something simi-

On GoDaddy.com, for exam-
ple, a .COM domain will cost
about $9 (Rs 390) yearly and basic
hosting with 25 GB data transfer
and 500 MB Web space will cost
about $4 (Rs 175) a month. This
brings your total yearly expendi-
ture to about $57 (Rs 2,500).
Thankfully, this is all you will
have to pay. Using this article, you
will be able to set up a personal or
company Web site for exactly that
price and not a paisa more.

Getting PHP-Nuke
Once you’ve bought your domain
name and Web hosting, the next
step is to download the PHP-Nuke
installer from www.phpnuke.org.
The latest version will cost 
you $10 (Rs 435) to download, 
but they offer the previous
version for free. So, as of the writ-
ing of this article, if the latest
version is 7.8, you can download
version 7.7 for free. The latest 
free version is available at
http://snipurl.com/digit_php.

Installing PHP-Nuke
Once you have downloaded the
file, unzip it to your hard drive.
You will see three folders—‘html’,
‘sql’ and ‘upgrades’, along with
multiple text files.

Since you are freshly
installing PHP-Nuke, all that
concerns you is the ‘html’ and
‘sql’ folders. The ‘upgrades’ folder

is meant for those of you upgrad-
ing PHP-Nuke to the latest version.
The first thing you should do is
read the ‘Readme’ and the ‘Install’
text files, as you should do before
preparing to install any software. 

Now all you have to do is
follow the step-by-step instruc-
tions below to install PHP-Nuke.

Creating A New MySQL
Database
A MySQL database is what

a PHP Web site uses to store data.
It reads the MySQL database and
displays content, and the settings
that you select.

63JULY 2005 DIGIT

Digital Tools l Smart SoHo

Unzip the PHP-Nuke installer to your hard drive

You can create a new SQL database from
GoDaddy.com’s control panel

Whether your Web hosting provider
offers mysqladmin (top) or phpMyAd-
min (bottom) control panels, just look
for the “SQL” link to upload your
“nuke.sql” file and execute it

1 col AD



lar to what’s shown in the screen-
shots. There will be an option to
upload a file to the server and run
the SQL commands in it. Basically,
you need to upload the file called
‘nuke.sql’ which is in the ‘sql’
folder you came across after
unzipping the PHP-Nuke installer.

There will be a button titled
‘Choose’, which will ask you to
select a file from your hard disk.
Select the file ‘nuke.sql’ and click
‘Go’. This will execute all the
required SQL commands, and you
can now begin uploading your
Web content.

Editing The config.php
File Correctly
In the ‘html’ folder, you

will find a file called config.php.
Open this with a text editor such
as Notepad or Wordpad. You will
see the following lines:
$dbhost = “localhost”;
$dbuname = “root”;
$dbpass = “”;
$dbname = “nuke”;
$prefix = “nuke”;
$user_prefix = “nuke”;
$dbtype = “MySQL”;
$sitekey = “<something>”;
$gfx_chk = 0;

$subscription_url = “”;
$admin_file = “admin”;
$advanced_editor = 0;

These are the default settings,
and you will need to change
these. An explanation for each
field is given within the
config.php file itself. The impor-
tant ones you should take special
care when changing are:

à $dbhost = “localhost”;
Set this to wherever your

MySQL database is hosted. With
GoDaddy hosting, this is generally
something like “mysqladmin99.
secureserver.net”. If you are sure
that the database is hosted on the
same machine as the Web server,
then leaving this to “localhost”
should be fine.

à $dbusername = “<name>”;
Here, “<name>” is the user-

name you set with your hosting
provider for database management.

à $dbname = “<dbname>”;
Here you should enter the

database name you set in Step 1
for your database.

à $admin_file = “admin”;
If you want to change the name

of the admin.php file to something
else, say “da-big-boss.php”, for obvi-
ous security reasons, then you
should change this setting to
reflect that ($admin_file = “da-big-
boss”;). Make sure that this setting
and whatever you rename the
admin.php file to always match, or
you will end up with a non-
functional site.

Uploading The Site
Now you’re finally
through with all the

actual editing and changing. All
you have to do is upload all the
files, as they are, to your Web

server’s root directory. This will
take a while, and may fail
frequently on slower connections. 

It would be best to find an FTP
utility that supports resume and
allows you to upload folders and
keep folder structures. If you have
a decent connection, Internet
Explorer will also do just fine.

Once everything is uploaded,
just type in your domain in a
browser and you will see a message
on the main page that tells you to
create an admin account and set a
password. Once this is done, you
will be logged into the Adminis-
tration Control Panel (ACP). This is
where you will be able to tweak
your site and its content—all from
within your browser.

Understanding The
PHP-Nuke Layout
Once you’ve gotten all the

above steps right, you will have
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If you don't have a Web server, but would
still like to try your hand at designing a

Web site, you can always set up a local
server on your own computer. This is also
useful if you want to test a module before
installing it on your main site, or if you want
to try out a theme, or any such tweaks.
However, you need a Web server that
supports PHP, such as Apache, and a MySQL
database daemon running, and you're
probably using Windows. Complicated, huh?

Well, not really—thank God for Open
Source and Free software! There's a
software called EasyPHP, available at

http://snipurl.com/digit_easyphp. Don't be
put off by the French used everywhere—
when you finally install it, there's an
English option!

All you need to do is install EasyPHP,
and it creates a '/Program
Files/EasyPHP/www/' folder where you can
just paste your Web sites to see them work.
Now you need to start EasyPHP, and
navigate to 'http://localhost' to see your
Web site. It even has a phpMyAdmin,
accessible by right-clicking on the EasyPHP
logo in the taskbar when the software is
running. Truly easy PHP!

EasyPHP: The Easiest Way To Test Your PHP Site

Click on the
“Choose”
button and
then select
the
“nuke.sql”
file that you
unzipped

The first time you visit your site you will be prompted to
set an administrator password

Set up the administrator password for your Web site

Once you login as administrator, you will see the
Administrator Control Panel (ACP)
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reached the Administrative
Control Panel (ACP) for your PHP-
Nuke Web site. Now, before you can
start building your site, you need
to know what each little icon in
your ACP means, and how you can
leverage them within your site.

Since we cannot list all of them
in detail, we will only cover the
most important ones. You should
be able to decipher the rest easily
enough by clicking on them.

Preferences
This is where you set all the impor-
tant settings of your site, such as
the name of the site, the logo it
uses, the theme or colour of the
entire site, and all administrative
information and settings.

Make sure to set all the correct
information here first. You should
also check out the different theme
options that come bundled with
PHP-Nuke and decide on one that
suits your site best. You can always
tweak the design later, or even
download a PHP-Nuke theme from
the thousands available online.

Blocks
Blocks are just that—blocks! The
different boxes you see around the
default site that you already have

are its blocks. We have marked out
different blocks in boxes in the
accompanying screenshot to
better illustrate this. From the
ACP, you can control which blocks
are shown on your site, and more
importantly, where on the site
they appear.

You will see the following
details mentioned: Title, Position,
Weight, Type, Status, Visible To,
and Functions with Edit, Acti-
vate/Deactivate, Delete and Show
options. So, for example, let’s say
you want to move the Login block
to the left of the Web site and
disable the Languages block:

First, you click on the Edit icon
in line with ‘Languages’. In the
new page that loads, you will see
that you can change the option for
Activate to ‘No’. This will deacti-
vate the Languages module, and
you should also set the ‘Visible to
Subscribers’ option to ‘No’, to hide
the Languages block.

Now, just edit the Login
block the same way, and just set
the value of “Position” to “Left”.

Now you can go ahead and
play about with the blocks to see
what you want where and what
you want to remove. You can also
create new blocks, with links to
new pages that you construct.
It’s really very easy once you do
it yourself.

Modules
Modules are like functions of your
Web site, and can be controlled
easily using the ACP. Clicking on
the Modules link takes you to a
page with a long list of modules.
Here you have to choose what’s
important for your site to have
and what isn’t. Remember, there
has to be at least one module
linked to your home page.

By default, this is set to the
News module, as PHP-Nuke was
primarily built for community
boards. You can change this to
anything else, and you can also
download and install more
modules from the Net. 

By default, the following
modules are active after you
install PHP-Nuke:
AvantGo, Downloads, Feedback,
Journal, Private Messages, Recom-
mend Us, Search, Statistics,
Stories Archive, Submit News,
Surveys, Top 10, Topics, Web
Links, Your Account.

The easiest way to learn what
each one is, is to click on the
link and see where you go. It’s
all pretty straightforward.

Messages
The default message you see in
your home page is listed here.
Messages are sort of like posts
that get priority over everything
else in the home page. They can
be set to be permanent, such as
an introduction to your site, or
temporary, such as informing
site visitors that the downloads
section will be down for a week.
You can also have messages only
for registered users, or other
administrators—basically differ-
ent usergroups.

Investing The Time
Though this will only get
you started with your

Web site, PHP-Nuke is built to be
easy to understand. Even if you do
come across problems, or cannot
understand something, there are
hundreds of forums that discuss
and solve any questions or prob-
lems that people face.

In the end, how well-designed
and snazzy your site looks
depends solely on the amount of
time you can dedicate to it. You
can also add a shopping cart and
a payment gateway, and sell your
goods online. The options are
unlimited, especially with PHP-
Nuke modules, which seem to be
made for each and every function
you could ever imagine.

Building your dream site is a
lot easier now—all it takes is some
time, the right keywords in Google,
and a little bit of bandwidth!

robert_smith@thinkdigit.com

Each red box in this screenshot depicts one block

Manage your block placement from the ACP

PHP-Nuke has many offshoots;
as developers took up the

challenge and started developing
their own versions of easy-to-
configure PHP-based sites. Here
are a few examples, in case you'd
rather try them out instead:
PostNuke: Based on PHP-Nuke
5.0; www.postnuke.com
myPHPNuke: Based on PHP-Nuke
4.4; www.myphpnuke.com
Xaraya: Based on PostNuke;
www.xaraya.com
NPDS: Based on PHP-Nuke 4.3;
http://www.npds.org/us
XOOPS: Based on myPHP-Nuke;
www.xoops.org
PHP-Nuke Platinum: PHP-Nuke,
but with a lot more modules
thrown in to help skip searching
for them online;
http://snipurl.com/nuke_plat

Options
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Use The Publisher
98/2000 Design Gallery

The Publisher 98/2000
Design Gallery contains

hundreds of professionally-
designed objects that you can
add to your publication,
including pull quotes, logos,
coupons, borders, mastheads,
calendars, and more. To open
the Design Gallery, click
‘Design Gallery Object’ on the
‘Objects’ toolbar.

You can also use the
Design Gallery to store
objects that you create or
import. Once the items are
added to the Design Gallery,
you can reuse them in other
publications. This is a great
place to store your favourite
pictures, your logo, or even
an entire page.

To add an object to the
Design Gallery, click the
object. On the ‘Insert’ menu,
click ‘Add Selection to Design
Gallery’. Type a name and a
category in the spaces
provided, and click OK.

Add Terms To The Spelling
Checker Dictionary

You can add special
terms to the spelling

checker dictionary in
Publisher, such as proper
nouns, industry-specific
words, and abbreviations?
Once you add a term,
Publisher won’t flag it as
incorrectly spelled when it
appears later in the
publication or in another
publication. To add special
terms to the spelling checker
dictionary, on the Tools
menu, click ‘Spelling’, then
click ‘Check Spelling’. Click
‘Add’ for each word or
abbreviation you want to add
to the dictionary.

Using The Design Checker
To Check For Missing Text

Missing text often
occurs when you resize

a text frame after inserting
text, or when you add a
graphic that pushes text into
an adjacent text frame.
Adding a continued notice to
a text frame can also cause
missing text. Publisher
indicates that text is missing
by showing the ‘Text in

Overflow’ symbol at the
bottom of a text frame when
the frame is selected.

Use the Design Checker to
check your publication for
missing text. It analyses your
publication and stops at every
text frame that contains text
in the overflow area, and
suggests possible solutions.

To run the Design
Checker, on the Tools menu,
click Design Checker. To
check your entire
publication, click ‘All’, or, to
check specific pages, click
‘Pages’, and then type the
page numbers in the ‘from’
and ‘to’ boxes.

Click OK. Publisher will
check the design, and will
display a dialog box if it finds
a problem. If you want to fix
the problem, go to the
publication and make your
changes; you don’t have to
close the Design Checker
dialog box. When you’ve
finished, click ‘Continue’ to
have Publisher continue
checking your publication. Of
course, if you don’t want to
fix the problem, click ‘Ignore’
or ‘Ignore All’, then click
‘Continue’. Click ‘OK’.

Measuring An Object
Click the object you
want to measure, and

then look in the status line at
the bottom of the screen. The

numbers in the lower-right
corner indicate the size of the
selected object.

Switch Between
Single-Page And
Facing-Page Views

Did you know that you
can switch between

single-page and facing-page
views in Publisher? This tool
helps you work more
efficiently and create better-
looking multiple-page
publications, such as
newsletters, brochures, and
catalogues. Use single-page
view when you want to work
at a higher magnification
and concentrate on one page
at a time. Switch to facing
pages (or two-page) view
when you want to see the
pages as your reader will see
them. By switching back and
forth, you can balance the
content and design of the
left- and right-hand pages
so that they compliment
rather than compete with
each other.

To switch between single-
page and facing-page views
of your publication, select
an inside page of your
publication. On the ‘View’
menu, click ‘Two-Page
Spread’. To return to the
previous view, click ‘Two-
Page Spread’ on the
‘View’ menu.

Add Continued Notices To
Publisher 2000
Publications

Continued notices help
guide readers through a

story that continues on
another page in a
publication. Continued
notices are useful for long
articles or publications, such
as newsletters or catalogues.
Before adding a continued
notice, be sure to connect the
text frames that contain the
story. Continued notices only
appear after text has been
placed and flows from page
to page.

To add a continued notice
in a text frame, right-click a
connected text frame, point
to ‘Change Frame’, then click
‘Text Frame Properties’.
Under ‘Options’, select one or
both ‘Continued’ checkboxes.
Click OK. Repeat the steps 
for each connected frame in
the chain.

Change The Dates In Your
Publisher Calendar

The only way to change
dates in a Publisher

calendar is to do it manually.
Create a calendar, then go to
the first cell where you want
to enter or change a date, and
type a number. Press [Tab] to
move to the next cell, then
type the next number.
Continue pressing the [Tab]
key to move from cell to cell
in the calendar.

Change The Number Of
Hyphens Added To Text

You can change the
number of hyphens that

are automatically added to
your text to achieve a more
even right edge, or to reduce
white gaps in the text, the
number of hyphens, or the
number of short syllables
before or after a hyphen. To
achieve any of these effects,
change the number in the
hyphenation zone in the
following way:

For a more even right edge,
reduce the number.

For fewer white gaps in the
text, reduce the number.

For fewer hyphens,
increase the number.

For fewer short syllables
before or after hyphens,
increase the number.

Publisher
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To change the number in the
hyphenation zone, click a text
frame that contains text. On
the Tools menu, point to
‘Language’, then click
‘Hyphenation’. In the
‘Hyphenation Zone’ box, type
the measurement you want.
If you do not want any
hyphens in your publication,
click a text frame, and clear
the ‘Automatically hyphenate
this story’ checkbox.

A Cutting And Pasting
Alternative

Are you tired of cutting
and pasting objects?

Instead of pressing [Ctrl] + [C]
and [Ctrl] + [V], try this: select
an item, hold down the [Ctrl]
key, and drag it to where
you’d like. Instead of moving
the original, you’ll drag a
copy instead.

Font Formatting
Highlight some text
where you want to

change the font. Press [Ctrl] +
[Shift] + [F]. Press the down or
up arrow keys to find the
desired font, then press
[Enter] to select the
highlighted font.

Import Styles
If you want your
Publisher documents to

match the styles you’ve
previously used in your word
processing documents, you
can speed up formatting by
importing styles: open the
Publisher publication that
needs the styles you plan to
import. Choose Format > Text
Style from the menu. Choose
‘Import new styles’. Select
your word processor from the
list of supported word
processor formats in the ‘Files
of Type’ drop-down box. Go to
the folder where your word

processing documents are
located, and select the file
that contains the styles you
want to import. From the list
of styles in that document,
delete any you don’t need or
make changes to any of them,
if necessary. Click ‘Close’. The
dialog box closes and styles
are imported to your
Publisher publication.

Create Two Background
Pages In Publisher 98

What many programs
call Master Pages,

Microsoft Publisher 98 calls
‘Background Pages’. For two-
sided printing or two-page
spreads it is often helpful to
have separate background
pages for left and right pages. 

Here’s how: Choose
Arrange > Layout Guides.
Check the box for ‘Create Two
Backgrounds with Mirrored
Guides’. You can apply
separate or mirrored items,
such as page numbers to each
background page
independently.

When using two
background pages, if you
want page numbers on all
pages, you must insert page
number markers on both
background pages. And when
placing page numbers on two-
page spreads, it is usually best
to not place the page
numbers on the inside edges.

Turn Off Catalog Display
When Publisher Starts

Microsoft Publisher
normally opens with the

Catalog display that allows
you to choose a Wizard.
Expert users may prefer to
turn off this feature and
bring up the Catalog Display
only as needed: choose Tools
> Options from the menu bar.
Uncheck the box on the
‘General’ tab for ‘Use Catalog
at startup’.

You can get back the
Catalog and the Wizards by
going to File > New.

Creating A Banner In
Publisher

If the Catalog isn’t
already open, choose

File > New in Microsoft
Publisher 98. From the
‘Publications by Wizard’ tab,
choose ‘Banner’. From the list
of banner styles, choose a

banner type. When you select
a banner type, the matching
sample is selected in the right
pane of the catalogue. There
may be multiple choices, so
select the sample that best
matches your needs.

Click the ‘Start Wizard’
button. Click ‘Next’ in the
Wizard introduction pane,
then specify a length for your
banner. If you want a length
not listed, choose ‘Custom’ to
specify another length. Click
‘Next’ again, then specify a
height for your banner. Again
click ‘Next’, then specify
where you want graphics to
appear on your banner—to
the left, the right, both sides,
or no graphic at all. Click
‘Next’ for the last time and
specify whether or not you
want a border on your
banner. Click ‘Finish’ to close
the Banner Wizard.

You could stop now, or
continue to customise your
banner. You can change the
graphics, text, or border by
selecting those portions of
your banner and the
appropriate menu options.

To print, click File > Print
from the menu bar. Click the
‘Tile Printing Options’ button.
In the ‘Options’ window,
specify how much you want
the pages to overlap (for
assembling the pages into
your finished banner). 

The sample box shows
how many pieces of paper are
required to print your banner.
You can adjust the overlap to
prevent wasting too much
paper or go back and change
the height and width. When
satisfied, click ‘OK’ to close
the options dialog, then print
your banner.

Append A Signature
Automatically

To set up a default
signature in Outlook

Express, go to Tools >
Options. Go to the
‘Signatures’ tab. Make sure
‘Add signatures to all
outgoing messages’ is
selected. You might want to
deselect ‘Don’t add signatures
to Replies and Forwards’. Now
select the signature you want
to become the one

automatically inserted, and
click ‘Set as Default’.
Click ‘OK’.

Access Blocked
Attachments

In an attempt to
increase security and

prevent virus and worm
infections, Outlook Express
prevents you from opening or
saving attachments that it
thinks may contain harmful
code. Often, this level of
security is a bit too much of a
good thing. Fortunately, you
can regain access to all
attachments in Outlook
Express. To prevent Outlook
Express from controlling your
access to email attachments,
go to Tools > Options. Go to
the ‘Security’ tab. Make sure
‘Do not allow attachments to
be saved or opened that could
potentially be a virus’ is not
checked, and click ‘OK’. 

Add A Background Image
There’s a lot of
sophisticated stationery

for Outlook Express that
makes use of sounds, scripts
and spectacular effects. But
some of the most impressive
stationery is just a good
background image. To add a
background image to an
email with OE, start with a
new message in HTML format.
Select Format > Background
> Picture. Use the ‘Browse’
button to select the desired
image file. Click ‘OK’. 

If you don’t like how
Outlook Express automatically
repeats the image to the right
and downwards, you can
prevent this by editing the
source of your message (Select
View > ‘Source Edit’ from the
message’s menu. Click on the
‘Source’ tab at the bottom of
the window. Now, edit the
HTML source as much as
you like.)

Outlook Express (OE)

Quickly Copy Formatting
Within A Page
With the right mouse button
held down, drag the object or
text that has the formatting
you want to copy onto the
object or text you want to
change. Release the right
mouse button, and then click
‘Apply Formatting Here’.

Bet You Didn’t Know

The Signatures tab in OE’s options
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Varun Dubey

Have you ever wondered if there
was some way you could record

memorable video chats you’ve had
with your friends or family? What
about important video conferences
with clients? We have just the
software for you!

What You Need
To be able to record your video
conferences—irrespective of the chat
client you are using—you need to
download a free utility called
‘Bulent’s Screen Recorder’. Download
‘1.5b’, the freeware version from
http://snipurl.com
/evp8.

At www.
silver.net, you can
find the latest,
paid version of
the software.

Startup
Starting the
software

after installation
will get you to the
default window, and
the default settings
are more or less
sufficient for
most recordings.

Configuration
The software offers a pretty
comprehensive list of tweaks

for your recordings.
Click on the configuration button,

and you will be presented with a
rather haphazard configuration
window where you can manage the
various settings for your recordings.

The default capture quality is set
at 10 frames per second (fps), which
you should change to the value you
would like—most movies are
encoded at 30 fps.

Apart from the capture rate, it
also lets you select the compression
you want to use, as well as set the
compression rate using a simple
slider. You can also set hotkeys to 
take screenshots, and set a file size
limit for recording—wherein the
recording will stop as and when the
file size is reached.

Recording
First of all, you need to choose
the source from which you

will record. Click the ‘Select Source’
button on top, and then select from
amongst the options of ‘Entire
desktop’, ‘A full window’—which can
be any open window on your desktop,
‘A specific region’ which can be set by
you, or your handycam.

The last mode, ‘Watch it’, puts the
software into a monitoring mode and
will start recording when a change

occurs in the source. It will otherwise
pause and wait for any change in the
scene. This is great for security
related capturing—as soon as
someone enters an otherwise empty
room, the software detects the scene
change and starts recording. 

To record video chats, select the
source as ‘A full window’, set window
as MSN or Yahoo! video chat window.

Continuous Recording
Once the source has been
selected, you can start

recording by clicking on the
handycam button. This is the manual
record and you need to keep the
button pressed (by holding down the
mouse button) to keep recording. The
moment you release the button, it will
stop recording. To keep recording
continuously, you should first click

the handycam button, and then click
the arrow on the top left. This will
make your recording continuous until
you press the ‘Stop’ button.

Playback
On pressing the ‘Stop’ button,
you will be provided with

various options of ‘Save’, ‘Play’,
‘Photo’, or ‘Studio’, the last of which
lets you edit your AVI file. Clicking
‘Play’ will open your default AVI
player and play the file.

Image Capturing
The button next to the
handycam button that looks

like a still camera is just that! Once
you stop your recording, you can view
these snapshots by clicking on the
green button labeled ‘photo’.

That’s all there is to it. You can
now have video chat logs and say
goodbye to boring old text—provided
you have broadband, of course!

varun_dubey@thinkdigit.com  

Record Your IM Video Chat
Learn to record the video chats you’ve had over instant messengers

Change the settings in Configuration Panel 

Choose the
recording source
from the options
available in the 
‘Select Source’
Menu

Choose
the
appropriate
video
encoder

Default screen of
Bulent’s Screen
Recorder
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Now, locate the “<BODY>”
tag. Insert
‘style=”background-repeat:no-
repeat;”’ (not including the
outer quotation marks) after
“<BODY ” to prevent the
image from repeating.

To make the image repeat
downwards, insert
‘style=“background-
repeat:repeat-y”’.

For the background image
to repeat to the right, insert
‘style=“background-
repeat:repeat-x”’. 

Go back to the ‘Edit’ tab. 
To make this a little

clearer, if the <body> tag is
‘<BODY bgColor=#ffffff
background=“C:\Program
Files\Shared Files\Microsoft

Shared\Stationery\backgroun
d.jpg”>’, for example, it
should be something like
‘<BODY style=“background-
repeat:no-repeat”
bgColor=#ffffff
background=“C:\Program
Files\Shared Files\Microsoft
Shared\Stationery\backgroun
d.jpg”>’ after the editing.

Add A Sender To The OE
Address Book Quickly

To add the sender of a
message to your OE

address book, just highlight
the message in the message
list, and select Tools > Add

Sender to Address Book. This
inserts the sender with the
name and email address that
appeared in the ‘From:’
header of the message to your
OE address book.

With this method,
Outlook Express will not ask
any questions. If you want to
edit the entry, you have to do
it in the address book.

Add Address Book Entries
To An OE Mailing List

First, to create a mailing
list in Outlook Express,

select Tools > Address Book.
Select File > New Group...
from the address book’s
menu. Type the name of your
mailing list in the ‘Group

Name:’ field. This name
can be anything you
like. Click ‘OK’. That’s it!

Now, to continue
adding address book
entries to the mailing
list: if you have a well-
stuffed Outlook Express
address book, and the
new members of your
list can be found there,
adding them to the list
is particularly easy. 

To add address book
contacts to a mailing
list in Outlook Express,
select Tools > Address
Book. Highlight the
mailing list you want to
add members to either
in the list of to the left,
or in the main list of
address book entries. 

Click ‘Properties’,
then on ‘Select
Members’. Highlight the
address book entries you
want to add to the
group in the list on the

left. Add selected entries
using the ‘Select —>’ button.
Click ‘OK’ when done, and
click ‘OK’ again.

Add a Member to a
Mailing List

It’s easy to add address
book members to a

mailing list in Outlook
Express, but adding
recipients to a mailing list
without having them appear
in the address book, too, is a
simple thing to do, too. 

To add a member to a
mailing list in Outlook
Express, go to Tools >
Address Book. Highlight the

mailing list you want to add
subscribers to in the list of
address book entries. Click
‘Properties’. Type in the e-
mail address of the new
recipient in the ‘E-mail:’
entry field at the bottom of
the dialog. Optionally, add a
name to the subscribed e-mail
address. Click ‘Add’. Finally,
click OK and close the
address book.

Add All Recipients Of
An E-mail To Your OE
Address Book

If an e-mail you received
has additional

recipients, adding them to
your OE address book is a
snap. Just right-click on the
recipient, select ‘Add to
Address Book’ and confirm
the details. But what about
adding a dozen new contacts
and confirming a dozen
details?

Fortunately, Outlook
Express can make adding all
recipients in the ‘To:’ line to
your address book a bit easier.

To add all recipients of an
e-mail to your Outlook Express
Address Book, open the e-mail
in its own window by double-
clicking it. Select Tools > Add
to Address Book > Everyone on
To List. Click ‘OK’ for each new
contact to confirm. (You can
go through the new contacts
faster by hitting [Enter]
repeatedly; and if an address
is already in your address
book, OE will display an
informative dialog. Hit [Enter].

Unfortunately, this only
works with addresses in the
‘To:’ field of messages you
have received. The more likely
and sensible case of additional
new contacts in the ‘Cc:’ field
is not covered. You can move
the ‘Cc:’ addressees to the ‘To:’
field with some manual
editing, though, and add
them to your address book
more comfortably with the 
above method:

Drag and drop the
message from its OE mailbox
to your Desktop. Open
Notepad. Drag and drop the
newly created .eml file (its
name should be the same as
the e-mail’s subject) from the
Desktop onto Notepad. Edit
the message such that all
recipients are in the ‘To:’ line.
(Make sure you separate the

existing contacts in the ‘To:’
field from those copied from
the ‘Cc:’ field with a
semicolon.) Now close
Notepad, saving the file. Drag
and drop the .eml file from
the Desktop into your OE
Inbox. Add the contacts to
your address book. Delete the
message and the .eml file on
your Desktop. 

Use Rich HTML
Formatting In Your
OE Signature

If you send your emails
using rich HTML

formatting in Outlook
Express, the signature does
not have to pale in plain
letters beside the rest of your
message. Using HTML in your
signature is not as
straightforward as setting up
a plaintext signature,
however. It is not even as easy
as using HTML formatting in
the rest of your message.

This is because HTML
signatures in Outlook Express
are off-shored to external
files. But here’s how to
do it. All you need is some
basic HTML knowledge,
though you’ll do fine even
without that.

To use rich HTML
formatting in your Outlook
Express signature, create the
signature’s HTML code in
your text editor. Make sure
you use only the code you
would also use inside the
<body> of an HTML
document. Save it to a .html
file in your My Documents
folder, for example. Select
Tools > Options and go to the
‘Signatures’ tab. Highlight
the desired signature. Make
sure ‘File’ is selected under
‘Edit Signature’. Use the
‘Browse...’ button to select the
signature HTML file you just
created. Click OK, and test
your new signature. 

If you don’t want to type
the HTML by hand (or use an
HTML editor), you can do it in
OE: create a new message in
Outlook Express. Type and
design your signature using
the formatting tools. Go to
the ‘Source’ tab. Select the
content between <body> and
</body>. Press [Ctrl] + [C].
Create a new file in your text
editor, press [Ctrl] + [V], and
continue as above.

The background can either be tiled...

Or you can make it appear only once
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Add An Animation To 
Your Signature

Once you’ve mastered
HTML formatting in

your signature in Outlook
Express, adding an
animation to it is the icing
on the cake. All you really
need is a nice animated GIF
to include in your signature.
To add an animation to your
signature in Outlook
Express, create a signature
using HTML formatting in
Outlook Express. Edit the
signature’s .html file to
include ‘<img src=“path to
your animated GIF” />’
(without the outer, but
including the inner set of
quotation marks) where you
want to place the animation.

Add Background Sound
To E-mails

In Outlook Express, it’s
easy to add background

music that will
automatically play when the
recipient opens the message.
To add background sound to
an e-mail message in
Outlook Express, start with a
new message in HTML
format. Select Format >
Background > Sound from
the menu. 

Use the ‘Browse...’ button
to select the sound file you
want to play in the
background. (Make sure the
file is of a supported sound
format.) Specify whether you
want the sound file to be
played continuously or a
certain number of times.
Click ‘OK’. 

To change the sound later,
select Format > Background
> Sound again from the OE
menu. Remember that the
music will only play if the
recipient uses an e-mail client
that understands HTML.

Attach Files Via
Drag-And-Drop

In Outlook Express, you
can add attachments

easily via the toolbar or the
menu. But there is an even
more intuitive and
sometimes faster method to
create attachments in
Outlook Express: drag-and-
drop. Open the folder
containing the file you want
to send in Windows
Explorer. Now click on the

file with the left mouse
button. Keeping the mouse
button pressed, drag it over
to the OE message window.
Drop the file anywhere over
the message creation
window by releasing the
mouse button. OE will
automatically add it as 
an attachment.

You can also use this
method to attach more than
one file at a time. Simply
mark the files you want to
add and drag them over to
the Outlook Express message
to drop them there.

Add A New Identity In
Outlook Express

If you want to allow
others to use your

computer and your OE
without having to set up
multiple users in Windows,
you can create an identity 
for each user in Outlook
Express itself.

Outlook Express identities
are shielded from each other,
and each has its own
accounts, signatures, settings
and its own address book. You
can even protect an identity
with a password. 

To add a new identity to
Outlook Express, you need to
select File > Identities > Add
New Identity. Enter the name
(or, if you have multiple
identities for the same name,
a user name) of the new user
under ‘Type your name:’.
Click ‘OK’. Click ‘No’ to allow
the additional user to set up
their ‘copy’ of Outlook

Express themselves.
Of course, if the

additional identity is for
yourself, you can also answer
‘Yes’ and switch to it
immediately to set it up.

Launcher Shortcuts
All the Launcher
features are available as

items under the Window
menu. In addition, the
following function-key
shortcuts are available to
access these features. If you
memorise the function-key
shortcuts for the Launcher
items, you’ll probably never
need the larger Launcher
Palette again.

[F5] Site
[F6] Library
[F7] Styles
[F8] Behaviors
[F9] Timelines
[F10] HTML

Controlling The Size Of A
New Window

A new browser window
is usually the same size

as the original browser
window containing your site.
This can be confusing for
some novice Web users. 

To make navigation as
simple and straightforward as
possible, you may want to set
the new browser window to a
smaller size. You can do so
using the ‘Open Browser
Window behavior’.

To use the behaviour,
choose Window > Behaviors
to display the Behaviors
palette. Then, select the link
in your HTML document.
Next, select Open Browser
Window from the Behavior
menu. In the resulting dialog
box, enter the URL of the link
and set the desired width and
height of the new window.
Then, click ‘OK’. At this point,
when the user clicks the link,
a small window opens with
the linked page. 

A Dreary Dreamweaver
Display?

As you may have
noticed, when your

computer’s system resources
run low, Dreamweaver’s
display is the first to go. Some
users also experience
disappearing objects, objects
smearing across the screen as
they’re dragged, and palettes
and windows only partially
redrawing.

When you experience
these types of difficulties,

first close as many running
applications as you can. If the
problems continue, try
setting your video driver to a
less demanding resolution.
640 x 480, set to hundreds of
colours, is a good resolution
to begin testing with.

Linking To Named
Anchors

Linking to a named
anchor lets you move to

a specific spot on a specific
web page. We’ll now discuss
how to link to named anchors
on the same page, on other
pages in your site, and on
pages external to your site.

First, to create a link to a
named anchor on the same
Web page, select some text or
click a graphic. Then, choose
Windows > Properties to
display the Properties palette.
In the Link text field of the
‘Properties’ palette, enter “#”
and the name of the anchor
you want to navigate to. For
example, if the name of the
anchor is heading1, you’d
enter “#heading1” in the Link
text field.

To create a link to a
named anchor on another
Web page, enter the name of
the page and append “#” and
the name of the anchor, as in
“report.htm#heading1”.

To create a link to an
anchor on a Web page
external to your site, enter
the full Web address of the
page and append “#” and the
anchor name, as in

“http://www.thinkdigit.co
m/report.htm#heading1”.

Naming Objects
Dreamweaver layouts
can quickly become so

complex that it’s difficult to
know what to select and
whether it’s selected. 

To help alleviate this
confusion, develop a habit of
naming every object you
place in a Dreamweaver
document according to its
function. For example, after
you create a table in your
document to hold the main
site navigation links, choose
Windows > Properties to
open the Properties palette. 

Now, enter
‘Site_Navigation’ in the Table
Name text field. The next
time you select the table,

Dreamweaver

Creating a new identity in OE
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Varun Dubey

Have you ever had your cell
phone stolen? Or lost? If you
have a PDA phone, then the

loss of a cell phone doesn’t just imply
loss of mere contact numbers but also
the incalculable loss of important
office files and business e-mails. 

Let’s think of a less heart-
wrenching but equally exasperating
scenario. Consider that you would
like to perform a seamless transfer of
files between your PC and your PDA
or you would like to take a backup.
Here’s a step-by-step process through
which you will be able to link your
PDA to your laptop or computer using
a Wi-Fi connection.

Startup 
Start your handheld PC, and
go to Start > Connections >

Settings > Network Cards.

Check Connection
Capabilities
Here, you will see all the

connection capabilities of your device.
It will list your
Wi-Fi cards,
Bluetooth adapter
and other
connectivity
devices. Click the
drop-down menu
and select ‘Work’.
Select your
Wireless Ethernet
card from the list 
of the various 
cards given.

Network Settings For 
The Phone    
Next, the settings page for the

card appears. Here, click ‘Use Specific
IP address’.
Remember, the
IP address
should be of the
same series as
that on your PC
or laptop.
Essentially, this
means if your
laptop has the 
IP address
128.128.130.140,

your PDA or Pocket PC must have an
IP address beginning with
128.128.130. You can choose any three
digits between 0 and 255 as the last
three digits for the IP address.

Click ‘OK’, and you will get a
message that these settings will be
effective when the card is used the
next time. Click ‘OK’ now, and you will
return to the ‘Network Cards’ menu.

Access PC Wi-Fi Connections
Now, on your PC or laptop,
click the ‘Wireless

Connections’ icon in the system tray.
Alternatively, you can access it from
Start > My Network Places > View
Network Connections.

Edit Network Properties
Right-click your wireless
network connection icon, and

click ‘Properties’. In the list of
protocols installed, scroll down and
select ‘Internet Protocol (TCP/IP)’, and
click ‘Properties’.

Enter The IP Address 
Once you reach the Properties
dialog box, select ‘Use the

following IP address’ to specify an IP
address. You need to be careful and
provide an IP address of the same
series as that on your PDA.
Continuing with our example, let’s
provide the following:

IP Address: 128.128.255.142
Subnet Mask: 255.255.0.0
Default Gateway: 128.128.130.99
DNS Server: 128.128.130.99

Configure Wireless Network
On the top of the window,
click the ‘Wireless Networks’

tab. Make sure the tab, ‘Use Windows
to configure my wireless network
settings’ is checked. 

Click the ‘Add’ button, and
provide an SSID (Secure Set
Identification) for the PC or the
laptop as the
case maybe.
Uncheck
‘Data
encryption
(WEP
enabled)’,
and then
click ‘OK’.

When
you come to
the wireless
connections
window,
you will see
the SSID
with an
icon with a red cross on it. 

There’s no cause for concern as
this simply implies that the wireless
connection or the PDA is not in
range yet. This is because the Wi-Fi
access on the PDA hasn’t been
activated so far.

Connecting To Your PC 
Start your Wi-Fi connection,
and you will find your PDA

scanning for a network.
Click Tools

> Network
Cards to view
the available
networks.
Select ‘laptop’
or whatever
SSID you gave
the PC or
laptop, and
select ‘OK’.
You’ll now see
that the PDA
has connected
to the PC  
or laptop. 

At this point, you will be able to
browse shared folders on your
desktop PC or laptop.

varun_dubey@thinkdigit.com 

Wi-Fi Connect Your PDA And PC
Wouldn’t you like to transfer data from your pocket PC to your laptop or
desktop PC? Read on to learn how to do just that using Wi-Fi… 

Enter the IP address

Selecting the  
Network adapter

The TCP/IP properties

Search And Connect 
Your Network

Uncheck the ‘Data Protection
(WEP enabled)’ option
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you’ll immediately know the
table’s purpose by glancing at
its name in the Properties
Inspector or in the HTML
Code window.

Naming every object as
you place it in a
Dreamweaver document may
seem tedious, but it will save
you hours of frustration and
confusion later.

Using Anchors In
Dreamweaver

Named anchors are
objects you can set links

to within an HTML page.
When you click on a link
connected to an anchor, the
browser scrolls the Web page
to the anchor.
When you create and place an
anchor, common sense would
dictate that you place the
anchor directly beside the
target. However, this causes
the browser to scroll the page
edge so close to the target
that the target is obscured
from view. 

Therefore, when you place
an anchor in Dreamweaver,
place the anchor one line
above the text or image. This
creates enough space for your
Web visitor to easily see the
anchor target.

Another considerate
function you can add to your
page is to place a link to the
top of the page next to each
named anchor.

To create such a link,
place your cursor at the top
of your page and choose
Insert, Named Anchor. Enter
Top in the resulting dialog
box and click ‘OK’. 

Then, place text or a
graphic next to each named
anchor on your page linking
to the Top named anchor.
Now your visitor has a
convenient way to navigate
around your Web page. 

Viewing The Head Section
As you may know,
Dreamweaver places a

Title and a Metatag element
in the Head section of an
HTML document. These
elements are normally
invisible while you view the
page in Dreamweaver
WYSIWYG (What You See Is
What You Get) mode.
However, you can set
Dreamweaver to display

elements in the Head section
of your HTML document.

To do so, choose View >
Head Content. Dreamweaver
creates a frame in the page
window and displays the
items in the Head section.
You can add, modify, or
delete these items. To modify
an item, first choose Window
> Properties to display the
Properties palette. Then,
select the Head object and
modify the values displayed
in the Properties palette.

Exact Spacing
Exact spacing in HTML
is a difficult task. To

create precise layout, leading,
and spacing, use a 1 x 1 pixel,
transparent GIF as a spacer.
Because you’re using a
transparent GIF, you can
shape and mould the GIF to
any dimension you require to
position text, images, form
objects, and tables. To do so,
insert the transparent GIF
into your Dreamweaver
document. Then, set the
width and height through
the Properties palette until
you achieve the desired
amount of white space. 

Paragraph Versus Line
Breaks

You may have noticed
that each time you press

the [Enter] key, Dreamweaver
skipped down the page two
lines. Pressing [Enter] inserts
a single paragraph break. The
HTML tag for a paragraph
break is <P>. This is useful
when you are looking at
increase the space between
different paragraphs. 

However, there will be
times when you just want to
go to one line directly below
the one you are working on
without introducing extra
space. Pressing [Shift] +
[Enter] inserts a line break
instead. The HTML tag for a
line break is <BR>. Knowing
the difference between a <P>
and a <BR> will allow you to
control the spacing between
lines of text.

Setting Two Words
Not To Break

Usually you want to
leave the text-wrapping

decisions up to the browser.
In most cases, any specific

formatting you assign to text
will appear differently on
another computer. 

However, there are
instances where it is
beneficial to locally format
text. For example, the table
column header “Part #” will
look sloppy if a foreign
browser displays it like:
Part
#

To prevent odd breaks like
this, replace the space
between the words with a
non-breaking space. To create
a non-breaking space in
Dreamweaver, place the
cursor in the text and press
[Ctrl] + [Spacebar]. The HTML
for a non-breaking space
is &NBSP: 

Tabbing in Dreamweaver
As you may know, there
are no tabs in HTML.

However, if you want to
indent an entire paragraph of
text, you can use the
Blockquote HTML tag. 

To indent a paragraph of
text in Dreamweaver, select
the text and choose Text >
Indent. To out-dent a
paragraph of text (or remove
a BlockQuote), choose Text >
Outdent. Alternatively, you
can press [Ctrl] + [>] to indent
or [Ctrl] + [<] to out-dent.

When you choose Text >
Indent, Dreamweaver
generates HTML similar to

<blockquote>
<p>This is a paragraph of

text</p>
</blockquote> 

Turning Off The Border
Around A Linked Image

Everyone likes to use
images for links instead

of stale, boring text. However,
when you apply a link to a
graphic, browsers always
display a one-point blue
border around the graphic. If
that border isn’t to your
liking, you can easily modify
or delete it in Dreamweaver.

To do so, first click the
image to select it. Next,
choose Windows > Properties
to display the Properties
palette. To increase the
thickness of the border, enter
a number in the Border text
box. Press [Enter] or click
Apply. To get rid of the border

around your linked image,
enter “0” in the ‘Border text’
box. The border will
disappear but the link will
still be live.

Arranging Palettes
Dreamweaver palettes
are a wonderful feature

of the software, however they
can become a hindrance
when they obscure portions
of a Web page. One quick way
of moving all the active
palettes out of the way is to
choose Window > Arrange
Palettes. This automatically
pushes every active palette to
the side of the screen. 

Combining Palettes
Part of Dreamweaver’s
ease of use comes from

the multiple palettes you can
use to assign or modify HTML
attributes. Because the palettes
take up valuable screen real
estate and obscure your Web
page, they can quickly become
a hindrance. Fortunately, you
can consolidate most palettes
into one tabbed palette.

To do so, open a few
Dreamweaver palettes, click
one palette’s title bar, and
drag that palette onto
another. Dreamweaver will
combine the palettes into one
palette and create a tab for
each merged palette. Note
that the Properties, Launcher,
and Site palette cannot be
combined with other palettes.

Types Of Links
There are three types of
links: Link, Alink (Active
Link), and Vlink (Visited
Link). You can set specific
colours for each type of link.

The Link colour is what
users see when they haven’t
visited the target of the link.

The Alink colour is what
the users see while they
click the link.

The Vlink colour is the
colour the link appears in
after a user has visited the
target of the link.

To set colours for links in
your document, choose
Modify > Page Properties.
Next, choose a colour in the
Link, Active Link, and Visited
Link colour lists. Click ‘OK’.

Bet You Didn’t Know
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Fitting Into A New Size
There are many
situations where you’ll

need to get an image to fit
into a specifically sized
space. If you’ve been trying
to resize graphics and
they’ve ended up squished
horizontally or vertically,
this tip should help you out
and keep your images from
being digitally abused.

The size of our example
image is 584 pixels high by
400 pixels wide. We need to
resize the image so that the
final size is 200 pixels high
by 300 pixels wide.

To find the size of your
image, select Image > Image
Size from the Photoshop
menu bar. This dialog box
gives you the width, height
and resolution of your image.
You’ll see a checkbox next to
the word ‘Proportions’. (Note:
in Photoshop 4 and 5, this
checkbox is labelled
Constrain Proportions.) Don’t
uncheck that checkbox. Your
image will be squished if
you do.

Let’s uncheck that
‘Proportions’ checkbox, and
change the width to 300 and
the height to 200 pixels, and
take a look at the result.

Use [Ctrl] + [Z] to undo
the damage, and select

Image > Image Size again.
Leave the ‘Proportions’
checkbox checked. You want
to change only one
dimension. Photoshop will
then do the math for you and
figure out how big the other
dimension needs to be in
order to retain the correct
proportions for your image. 

Which dimension do you
change? Select the dimension
that will need to change the
most. In this example, we’re
changing an image that is
400w x 584h to 300w x 200h.
The height dimension in this
example needs to change the
most, so we’ll change the
height from 584 to 200.

Photoshop scales the
width size proportionately,
making the image 137 
pixels wide. 

Now you’ll need to
change the width of the
image. You don’t want to use
Image > Image Size for this.
Instead, we’ll use the Image >
Canvas Size function. 

What the Canvas Size
does is add pixels to your
image, and it fills them with
whatever background colour
you selected. 

Canvas Size changes the
size of your image by adding
to it, leaving the original
image unchanged. The Image
Size command changes the
size of your image by anti-
aliasing it.

Change the width
number from 137 pixels to
200 pixels.

The Placement graphic
gives you a choice of where
the extra pixels will go: to
the left, to the right of your
image, or on either side of
your image. We’ve left the
original image centred,
which is the default.

In our final image, we
selected white as the
background colour, so that is
what the extra space, added

on either side of the image
by the Canvas command, was
filled with.

Making Icons With
Bevelled Edges

Start out with your file
the size you want your

finished icon to be—we’ve
used 40 x 40 pixels. Windows
standard icons are generally
32 x 32.

The first method of
making an icon is the
standard toolbar-icon look
that many software programs
have, and can actually be
done in Windows Paintbrush,
PaintShop Pro, or any simple
basic paint program. 

Bucket fill the image
with your background colour,
which is usually light grey.
Draw a one-pixel black border
all the way around the icon.
(Use the pencil tool with the
smallest brush setting. Hold
down [Shift] as you draw your
line to constrain the pencil to
a straight line).

Then, on the bottom and
right sides of your icon,
inside the black border, draw
a darker grey line two pixels
wide. On the left and top of
the icon, draw a two-pixel
white line. At the corners
where the grey and white
lines meet, stair-step the
pixels so they form a 45-
degree angle.

The second method can
be used to create a bevelled
edge not just for icons, but
you can also use this to
create bevelled edges for
photos or scans as well. 

First paste in your photo
or texture whatever you’ll
be using as a background
in a file the same size as your
finished icon. Open your
layers palette and
add a layer. 

On the second layer, draw
a two or three pixel border in
dark grey on the bottom and
left sides of your file. On the
top and right sides, draw a two
or three pixel white border.
Make sure that your corners
where the grey and white
meet are 45-degree angles.
Now, drag the transparency
slider at the top of the layers
palette until it looks right. You
can save this layered file as a
.psd file to use later as a
template for future icons.

Create Custom Brushes 
In Photoshop

You can create custom
brushes in Photoshop.

Open a new file, and make
sure the ‘Brush Palette’ is
open on screen.

You can create a brush
up to 999 by 999 by pixels,
which would be the digital
equivalent of painting with
a mop. 

You’ll want to keep your
brushes on the smaller side,
especially if you will be using
them to create Web graphics.

For this example, we
opened a small file, 100
pixels by 100 pixels, and
selected Filter > Add Noise,
using the Monochrome
setting. We repeated the
Noise filter ([Ctrl] +[F]) 
several times.

You’ll find that brushes
with soft edges are much
more useful than brushes
with hard edges. 

To soften the edges of
the brush, select an area of
the image (about a quarter
of the way in from all of the
edges), then go to Select >
Feather, then Select >
Inverse. Fill the selected
area with white. 

Select the area of the
image that you want to use
as a brush. Next, from the
flyout menu from the Brush
Palette, select ‘Define Brush’. 

A new icon will appear on
the brush palette for your
new brush. You can save your
new set of brushes by
selecting ‘Save Brushes’ from
the palette.

It helps to add to the
default brush palette, rather
than create an entirely new
one. Also, it helps to test out
the brush before you save it. 

You can always delete a
brush from the palette by
selecting the icon for the
brush, then selecting ‘Delete
Brush’ from the flyout menu
on the Brush Palette.

You can use the Brush
Options on that same flyout
menu to set the way the
brush tracks. 

Moreover, the default
setting is 25—that is a
percentage of the size of the
brush, so the brush shape
will repeat that often
(depending on your settings
in the Options palette).

Photoshop

The correct way to resize an image: using the ‘Canvas Size’ option

A Photoshop experiment: resize
the image above without keeping
the ‘Proportions’ checkbox checked
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AMD Motherboards 
WinFast NF4K8MC

PCIE-based, 8 channel audio,
Gigabit LAN, socket 939

No on-board graphics

Contact Mediatech India
Phone 022-26361111
E-mail digit@mediatechindia.com
Price Rs 4350

MSI RS480M2-IL
+ PCIE based, 6 channel
audio, supports 4 GB RAM,
socket 939, Firewire port
No Gigabit

Contact Tirupati Enterprices
Phone 033-22251192
E-mail mail@tirupati.net

Price Rs 5395

Internal TV Tuner Cards
Compro VideoMate PVR/FM

Exceptionally clear TV recep-
tion quality, low price, FM
radio, good PVR software

Contact Mediatech India
Phone 022-26361111
E-mail
sales@mediatechindia.com
Price Rs 1,995

Mercury TV Tuner Card
Good TV reception quality,
FM radio, low price
PVR software is basic

Contact Kobian India Ltd
Phone 022-23020767 / 0774
E-mail mumbai@kobian.com
Price Rs 1,850

Projectors
Acer PD11

High 1600-lumen brightness
support 
Large 330-inch diagonal
image size capability
Picture-in-Picture mode

Contact Acer India Pvt Ltd 
Phone 080-25219520
E-mail rajesh_aiyar@acer.co.in
Price Rs 62,999

Cell Phones 
Sony-Ericsson K700i 

Extensive feature set;
includes camera, MP3, FM
radio, etc.
Fast processor

Contact Sony Ericsson
Phone 0124-2560808 
E-mail dhiraj.soni@
sonyericsson.com
Price Rs 11,200

CRT Monitors (19-inch)
Samsung SyncMaster 997DF

Good colour reproduction
Compact

Contact Samsung Electronics India
Phone 011-51511234 
E-mail marketing@

samsungindia.com
Price Rs 13,999

Samsung SyncMaster 957MB
Brightness modes for different
viewing environments
Good colour reproduction

Contact Samsung Electronics India
Phone 011-51511234 
E-mail marketing@

samsungindia.com  
Price Rs 15,999

PDA Phones
Nokia 9500 Communicator 

Full QWERTY keyboard
Slightly bulky

Contact Company: Nokia India Ltd
Phone 011-22677900
E-mail jay.bakshi@nokia.com
Price 35,000 

O2 XDA II Mini 
Small, thin and pocketable
One-handed operation not 
possible  

Contact Creative e-biz
Phone 022-23828100
E-mail creative@goldkist.net 
Price Rs 32,000

Portable Hard Drives
WD-Media Centre 250GB

Very low cost per MB 
Memory card reader slots

Contact Western Digital 
Phone 022-25851085 
E-mail ajay.kapure@wdc.com
Price Rs 14,999

Freecom FHD-2 Pro 80 GB 
Extremely compact; bundled
carry case
Contact J S Equipments
Phone 022-23810713
E-mail jse@vsnl.com
Price Rs 15,400

CRT Monitors (17-inch)
Acer AC715

High resolution of 1600 x
1200 @ 75 Hz 
Good reproduction of finer
details

Contact Acer India Pvt.Ltd.
Phone 080-5219520
E-mail rajesh_aiyar@acer.co.in
Price Rs 6,995

Viewsonic E71f
Aesthetically appealing  
Good geometry reproduction

Contact Roop Technology Pvt Ltd
Phone 022-26680022
E-mail roop@vsnl.com
Price Rs 7,200

Intel Motherboards
Mercury PI915GVM

Supports PCIE, DDR/DDR II
RAM, 6-channel audio

Only 2 PCI slots. No SATA.

Contact Kobian ECS India Pvt ltd
Phone 022-23020767 / 774
E-mail mumbai@kobian.com
Price Rs 5,000

Gigabyte 8TRS 350MT
Supports 4GB DDR 400 RAM,

SATA, 6-channel audio
Socket 478, AGP

Contact Gigabyte Technology 
(India) Ltd
Phone 022-26526696
E-mail sales@digigiga.co.in
Price Rs 4344

The best products tested so far in different 
hardware and software categoriesThe A-List

July 2005
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LCD Monitors (17-inch)
Acer AL714sm

Light
Good greyscale 
reproduction

Contact Acer India Pvt Ltd
Phone : 080-5219520 / 23
E-mail rajesh_aiyar@acer.co.in
Price Rs 14,999

CMV CT-712A
High luminance
Good coloured text 
reproduction

Contact Cee Vision 
Technologies Pvt.Ltd
Phone : 022-26733353
E-mail chemoplastmumbai@ 
vsnl.net
Price Rs 17,000

Laptops 
ACI Emerald C2

Inbuilt Web camera
Affordable

Contact Allied Computer 
International
Phone 022-56943260  
E-mail hirji@aci-asia.com   
Price Rs 42,999
Website www.aci-asia.com

MSI MegaBook M510C
Terrific performance, typical
feature set
High screen resolution
Average wireless LAN 
performance 

Contact Maxtone Electronics
Phone 022-23011434
E-mail maxtone@vsnl.com
Price Rs 68,000

LCD Monitors (15-inch)
Acer AL1512

Very competitively priced
Good contrast ratio
No vertical swivel

Contact Acer India Pvt. Ltd
Phone 080- 5219520-23
E-mail Rajesh_Aiyar@acer.co.in
Price Rs Rs 9,999

CMV CT-529A
Good colour reproduction
High contrast ratio

Contact Cee Vision 
Technologies Pvt Ltd
Phone 022-26733353 
E-mail chemoplastmumbai@ 
vsnl.net
Price Rs 12,000

Home Inkjet Printers
Pixma iP1000

Economical; decent photo
printing. 
No output tray; no PictBridge  

Contact Canon India Ltd
Phone 0124-5160000
E-mail www.canon.co.in
Price Rs 3,195

HP Deskjet 3745
Fast printouts, 
excellent price
Below-par photo printing

Contact Hewlett Packard 
India Ltd. 
Phone 0124-2566111
E-mail www.hp.com 
Price Rs 2,999

Photo Inkjet MFDs
HP PSC 2608

Inexpensive, excellent and fast
text and photo printing

Contact Hewlett Packard India Ltd
Phone 0124-2566111 
Website www.hp.com
Price Rs 14,999

Office Inkjet MFDs
Lexmark X7170

Full featured MFD, fast 
printing and copying speeds.
Decent quality photo prints
No memory card reader; B&W
LCD screen 

Contact Lexmark India Ltd
Phone 022-26057755
Website www.lexmark.com
Price Rs 14,999

Fujitsu S2020 
Hot-swappable combo drive
Good graphics performance  
Average screen readability in
sunlight

Contact Fujisan Technologies Pvt Ltd
Phone 022-56368718
E-mail gathani.paresh@

fujisan.co.in
Price Rs 78,000

Zenith Presidio Vu
Good battery life
Inbuilt Web cam and SD/MMC
card reader support
No recovery CD provided

Contact Zenith Computers Ltd 
Phone 022-28377300
E-mail kalpak_bhatt@

zenith-india.com 
Price Rs 60,000
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Office/ Photo Inkjet
Printers
Canon Pixma iP 3000

Fast, excellent photo and 
text printing
No LCD 

Contact Canon India Ltd. 
Phone 0124-5160000
Web site www.canon.co.in  
Price Rs 8,495

Canon Pixma iP 4000
Fast, excellent photo and 
text printing
No LCD

Contact Canon India Ltd. 
Phone 0124-5160000 
Web site www.canon.co.in  
Price Rs 10,995

5.1 Speakers
Artis X10 Mini

Compact, sturdy, clear 
sound
Slightly weak bass 

Contact Kunhar 
Peripherals Pvt Ltd
Phone 022-56345758
E-mail salesbom@kunhar.com  
Price Rs 16,500

Creative Megaworks 
5.1 550 THX

Excellent bass, easy setup
Satellite speakers 
marginally low on clarity

Contact Creative Technology 
Phone (0)98203 57718 
E-mail india_getcreative@ 
ctl.creative.com  
Price : Rs 20,490



Too Little For Too Much

The SAFA SR-M850F comes at a time when digital
portable music players are freely available and an

MP3 player is no longer a novelty unless it screams
‘iPod’. Enter the SAFA SR-M850F with nothing less than
512MB of solid state memory and a 65K colour screen! 

This is a decent MP3 player and supports all major
audio formats such as MP3, OGG, and WMA (sorry, no
AAC). It also looks glossy and has two tiny 10 mW
stereo speakers on either side. The player is packed
with features that put other players to shame. Voice
recording, reading text files, viewing JPEG files etc.

Feature-wise, this is a solid product, powered
by an internal rechargeable battery that lasted 18
hours of continuous MP3 playback using the
bundled earphones.

Priced at a whopping Rs 12,100, though, it is too
expensive compared to a 4GB iPod Mini that costs just Rs 500 less! 

Company Arihant Informatique Pvt Ltd.

Price Rs 12,100

Phone 022-25789494

E-mail arihant9@hotmail.com

Web site www.safa.co.kr

Rating
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Motorola V3 Razr

Trendsetting designs have been the hallmark
of many Motorola cellphones but somehow

they always fell short of critical acclaim. With
the V3 Razr, Motorola changes all that.

Motorola resorted to space
grade alloys for the body
panels making the V3 light
and strong. At 3.8 x 2.0 x 0.5

inches, the V3 is pocketable.
Feature-wise, you get

Quad-band support, Bluetooth,
VGA digital camera with 4x

zoom, GPRS, PIM functionality,
MPEG 4 video playback and Java

support. The V3 has 5MB internal
memory but no option for

upgrading. Targeted at the fashion-
conscious, the V3 should make a

strong statement.

Company Motorola India Pvt Ltd

Price Rs 20,095

Phone 0124-2303212 

E-mail s.sravani@motorola.com

Rating
1 2 3 4 5

Samsung Miniket VP-M110S

1 2 3 4 5

SAFA SR-M850F MP3 player

Great Flaunt Value

Adigital video camcorder, digital camera, MP3 player,
webcam, voice-recorder and a mass storage device—all

rolled into one compact device measuring 70 x 30 x 42 mm
and weighing just 80 grams! We are talking about the new
Miniket VP-M110S from Samsung. 

With internal storage of 1 GB and 10X
optical and 100X digital zoom, the Miniket
also supports additional memory in the form
of MemoryStick Pro. The two-inch foldable
LCD supports up to 210K colours, and also
acts as viewfinder for the video and image
capture, apart from displaying the Menu.

The Miniket connects to a PC using the
bundled cradle and a USB cable. Windows
XP recognises it as a removable storage
device and you can transfer music and
other data easily to and from your PC.

The Miniket captures videos at 720 x
576 or 352 x 288. There are three quality
options—Superfine, Fine and Normal. In
the Superfine mode and at 720 x 576 size,
the internal memory can accommodate approximately 22
minutes of footage, provided no other files are stored. Videos
use a proprietary MPEG 4 standard licensed from DivX Inc. 

For stills, you can choose between 800 x 600 and 640 x
480. An 1280 x 960 extrapolated option is also available, and
images are captured as JPEG. The flash works only in the
Photo mode, and can be set to Auto, ON/OFF.

Customisable options for video and still image capture
include Auto/Manual focus, four White Balance modes (Auto,

Hold, Outdoor and Indoor), and five programmed auto
exposure modes—’Auto’, ‘Sports’, ‘Spotlight’, ‘Sand/Snow’,
and ‘High Speed Shutter’. You can choose from seven effects,
including Sepia or Negative. ‘Electronic Image Stabiliser’ and
‘Backlight Compensation’ are also included.

In terms of performance, image quality was not up
to the mark, for either video or photos and there was

evident Noise. As far as the MP3 player is concerned,
it is primitive at best. All you can do is

play and listen to music. You can also
record voice files in the WAV format in
8 KHz, 128 Kbps stereo mode. It’s good

only for voice and all other noises are
lost in the background.

The device heats up a bit even when
used for a short period. Also, battery life

is affected by zooming. In our battery tests
(which involved playing assorted MP3’s

over and over), the Miniket could manage
about three hours and 15 minutes on the regular 3.8V 900

mAh battery. However, an 1800 mAh extended battery pack
is also included in the package. 

The Samsung Miniket is a lifestyle product, and not
meant for users who want a dedicated digital handycam or
an MP3 player. Still, it’s great for those who have the cash to
spare and want a product with flaunt value.
Company Samsung India Electronics Limited

Price Rs 39,990

Phone 011-51511234

E-mail a.manchanda@samsung.com

Rating
1 2 3 4 5



Waiting To Explode

Recently, ATi launched the Radeon X800 XL graphic card
comprising a mammoth, 512 MB of memory. The card is

based on the X800 XL (R430) chip which is manufactured
using 0.11 micron technology unlike the 0.13 micron
being used to produce the X800 XT and the X850 XT
from ATi.

This PCI-Express card features dual
DVI ports as well as VIVO via a
composite port. It features the ATi
Rage Theatre chip doing all the work. 

The fan speed is
controlled by the
drivers and even at
maximum load, it was
silentl. It is a DirectX
9.0b card and has 16
pipelines. The chip is
clocked at 400 MHz
whereas the memory is
clocked at 1 GHz. 

The card was tested
on a setup using a 3.6
MHz Pentium IV

Prescott processor on an original Intel 925XCV motherboard
equipped with Micron 1 GB 533MHz DDR2 RAM running

Windows XP SP1. The drivers were
Catalyst 5.5. We wanted to see if the

512 MB framebuffer benefited 
any games. Not much at 

lower resolutions. 
Coming to 3DMark05—

often used as an
yardstick in graphic
performance—the

X800 XL scored 5028 on
default settings and an

impressive 3994 on 1024 x 768
with all the effects cranked up. 

The extra memory does not offer a
performance benefit to justify premium
pricing. You are better off holding on to
your present cards!

Company ATi Technologies

Price NA

Web site www.ati.com                

Rating
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ATi Radeon X800 XL

Liven Up Your Mornings

The Bose Wave Music
System is a

surprisingly
compact device that
functions as an
Audio CD/MP3 CD
player, FM/AM radio
and an Alarm that wakes you each morning to the station or
track of your choice, and speakers that’ll give any high-end 2.1 system a
run for its woofers. 

These features are in a sleek black trapezoidal case—also available in
platinum white. The centre of the front panel has a bright green display
that tells the time, and other information like the ID3 tags in an MP3 CD.
The overall look is retro, kind of like the radio alarms you’ll see in
Hollywood movies from the ’80s, yet, has a sleekness about it that gives
you an idea of the power beneath. The lack of buttons—all functions are
only through its remote—and the slot-based CD underline the design.

The Wave is packed with some nifty features—automatic night-time
dimming of its display, a gentle ramping of the volume to its final set
position when you turn on the device so you’re spared the rudeness of
sudden loudness; a power cord that also doubles as an antenna. Thanks
to its form factor, setting it up couldn’t have been easier.

The sound is crystal clear and rich. Even at full volume, you’ll be
hard-pressed to find any distortion. Before you run to get this, though,
take a look at the price—at Rs 30,000, it can only be called staggering! 

Company Bose Corporation India Pvt Ltd

Price Rs 29,990 + taxes

Phone 011 - 2307 3825

E-mail nandita_sood@boseindia.com

Web site www.boseindia.com

Rating
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Mitashi DivX-999 DVD Player

Sometime earlier, we had reviewed the
Mitashi DivX-555 player. Now, Mitashi has

launched a sibling, the DivX-999. It is similar to
the earlier launch but looks much sleeker and
has a tray-less slot design. Yes, instead of a tray
coming out of the player, you will have to insert
the disc into the player.

It plays DVDs, Audio CDs, Video-CDs, MP3
and WMA CDs and DivX and XviD movies and
more. Regrettably, though, not WMV files. 

Build quality is good, although the remote
looks tacky and the laminated keypad plastic
soon starts coming off. The remote provides all
functions to control the player. Playback quality
is good and setup and menu is intuitive. 

DivX and XviD playback is good, but if the
movie confronts higher bit-rates for a MPEG 4
movie, it starts framing. DVD and Audio CD
playback, though, is impeccable
and yes, it does play
HD-CD’s. 

The player
offers 5.1-channel audio

using analogue as well as digital connec-
tivity options. 

Overall, this is a good all-round player and
the player is region-free, which will let you play
DVD’s from anywhere without a hitch.
Company Mitashi Edutainment Pvt. Ltd.

Price Rs 4,990

Phone 022 25006661

E-mail rakesh@mitashi.com

Web site www.mitashi.com

Rating
1 2 3 4 5

1 2 3 4 5

1 Poor: Has serious drawbacks and needs improvement before it can be used for its target application. 2 Mediocre: Does not live up to expectations, needs improvment 
in many areas. 3 Average: Reasonably competent but nothing spectacular about the product. 4 Good: A good buy, better than most products in its category. 
5 Excellent: A brilliant combination of price, performance and features - far beyond expectations.

Please write to products@thinkdigit.com. The Digit Test Centre will be delighted to
respond to your queries.

Looking for more information on any of the products featured here?
1 2 3 4 5

Bose Wave Music System



How GPS Works: From The
GPS Constellation To
Differential GPS
Twenty-seven satellites orbiting the
earth are responsible for the location-
tracking information any GPS
receiver—be it in a car or a ship—
receives. Of these, at least 24 are
operational at any time, and the
remaining ones are used as backups. 

These satellites continuously send
out strings of bits that synchronise
with every active GPS receiver. They
also send out information about
where they are. 

Thus, a GPS receiver always has
information about the location of
satellites within its range.

I. With Only One Satellite
When your GPS receiver gets a signal from one satellite, it knows where
the satellite is, and can estimate the distance between itself and the
satellite. The receiver thus knows it is located somewhere in the yellow
circle (as shown in the picture above).

II. When Two Satellites Come In
If the receiver can get information from two satellites, it can further
refine its location: it now knows that it is located somewhere within the
red area—the intersection of the two yellow areas (as shown in
illustration above).
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How GPS Works

III. The Three-Satellite Scenario
Now, when a third satellite is involved, the receiver knows it is within
the green area (as in illustration above)—the intersection of three
circles. Ideally, this green area should be a single point, but in the real
world, it is not. A fourth satellite is therefore required to pinpoint the
location of the receiver.

IV. The Fourth Satellite To The Rescue
When there is information from a fourth satellite, the receiver knows
exactly where it is in three dimensions. The latitude and longitude as
well as the altitude are then known. The fourth satellite’s information
does two things; refine what the receiver already knows, and
pinpoint altitude adding to the accuracy.

Estimating Distance
One question has remained unanswered thus far: how does the GPS receiver know the distance between itself and a satellite? How can it
estimate this?

The answer is that each GPS satellite is constantly sending out a unique stream of 0s and 1s, which identify the satellite. Each GPS
receiver is synchronised with all the satellites, as mentioned earlier, and it has the same stream of 0s and 1s generated within it, in
synchrony. When a receiver gets a certain signal from a satellite, it guages the time shift between the internal sequence and that of the
satellite. Thus, figuring out how long it has taken the signal to reach it is possible. With this time gap known, the distance can be figured,
since radio waves travel at the speed of light.

Differential GPS
So far, that is, with four satellites in the picture, the precision of pointing out a location is between 10 and 30 metres. To refine this further
and improve accuracy to within a couple of metres, differential GPS (DGPS) is used.

A GPS receiver, known as the base station, constructed at a place where the latitude, longitude and altitude are precisely known, through
geographical surveys, is used to send out DGPS signals. The receiver determines its position according to the information received from
three satellites. This recorded position is bound to be a little different from the known position, and it is this difference that the unit
broadcasts, via its antenna. Using the difference in signal in addition to the information the receiver already has from the satellites, other
GPS receivers can refine their position.

Digital Tools l Visual Explanation
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Intranet And FTP
I am an employee in BSNL. We work on our
intranet with dial-up. We got a new HCL

Busybee PC with Windows XP Pro version.
The problem is that I am not able to run the
FTP command at the DOS prompt mode. 
The message I keep getting is “FTP is not
recognised as an internal or external
command, operable program or batch file.”
How do I get the command ftp to run at DOS
prompt, so that I can send or receive file
from our intranet FTP.

Kiran

The FTP command requires that
either the file FTP.EXE be present in

the folder from where the command is
run or that the path to that file is present
in the PATH environment variable.
FTP.EXE is installed by default with every
Windows XP installation to the System32 folder
in the Windows directory. The reason for the FTP
command not working on your computer could
be due to this file being corrupt or the file may
have been deleted. You can copy this file from
any Windows XP PC from the location
mentioned earlier to the Syetem32 directory of
your machine, and the FTP command will start
working again.

What Is My Server Type?
I have a problem with Outlook Express. When I
create an account, it asks for the type of

server. I don’t know what type my server is. What
should I enter?

Bapi Roy
The incoming and
outgoing mail

server to be specified in
Outlook Express
depends on the mail
provider and your
Internet Service
Provider (ISP). While
the incoming mail
server depends on the
mail service provider
that has provided your
e-mail ID, the outgoing
mail server depends on
your ISP. Since you
have not provided your
e-mail ID, we advise

you to contact your ISP for your outgoing server,
which is also known as POP (Post Office
Protocol) server and if your e-mail provider is
different from your ISP, you will have to contact
that provider for the incoming server which is
also known as the SMTP (Simple Mail Transfer
Protocol) server.

Live Update Led To Deletion 
I own a Compaq Presario M2000 Series laptop.
I have been using Windows XP Home Edition

Version 2002 Service Pack 2. I am using the CMD
Command Prompt (DOS-based). Till recently, all my
DOS applications were working fine. However, after
a Live Update operation, a file named AUTOEXEC.NT
in C:\Windows\System32 folder, was deleted auto-
matically. Now, I had to copy this file from

C:\Windows\System32\Dllcache. 
However, whenever I restarted the

laptop, it always deleted the  AUTOEXEC.NT. I
have also tried the ‘System Restore’ option
from HP but to no avail.

Dipak Sheth 

You do not need to set the environ-
ment variables in Autoexec.NT and

Config.NT. There is an easier way to set
the environment variables in Windows
XP/2000/2003. Open the ‘Control Panel’
and open the ‘System Properties’.
Alternatively, you can bring up the
‘System Properties’ by pressing the
‘Pause’/ ‘Break’ key while keeping the
Windows key pressed. Now, navigate to

the ‘Advanced’ tab and click the
‘Environment Variables’ button near the
bottom of the window. 

Here, at the top, you can set user variables
for the current user only by clicking on ‘New’,
entering the variable name and value and
clicking ‘OK’. To modify a variable, click on the
variable and click ‘Edit’ and modify the
name(s) or value(s). To delete a variable, click
on the variable and then hit ‘Delete’. 

At the bottom, you can set global environ-
ment variables, which are applicable to any
user who logs into Windows. You must belong
to the Administrator group in order to be able
to set new variables or modify any variable. As
always, you need to restart Windows for the
changes to take effect.

The Space Saga
I have a Celeron 1.7, Windows 2003 Server with
Exchange Server 2003 installed. Problem is,

when my PC restarts, its root partition C: has
around 400 MB free space. But, as I run any appli-
cations, the space gets filled and after some time, it
is “0 Bytes”. I also checked for any Log or .tmp files,
viruses, but everything seems OK. What could be
the cause and what is the solution?

Prasad Thombre 

Windows 2003 Server requires a page file,
which is nothing but a swap file located in

the root partition—usually the C: drive, in order
to function smoothly. The page file is utilised as

Your Questions, Our Answers

Setting up the incoming and outgoing mail
servers in Outlook Express
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virtual memory, an extension to the amount of
physical RAM available in the system, when the
amount of physical RAM is insufficient for
certain applications. The size of the page file
depends on the amount of RAM and generally
ranges from 1 to 1.5 times that amount. 

You have mentioned at the start of Windows,
the C: drive has around 400 MB free space. For
Window 2003 Server, this amount of space is too
low and hence the page file expands and
occupies all the available space after
some time and you are left with almost
no space on your C drive. 

The solution is to move some of your
data and applications to another drive
to free up as much space as possible on
your C: drive. Once you do this, you will
find Windows 2003 Server perform
much better.

A Strange Scratching Sound
Recently, I got the DVD version of
American Army Special Forces

(Firefight) 2.3.0 from a friend, but unfortu-
nately, it is 766 MB in size and exceeds the
size of a CD-R which is 700 MB. 

I want to know how to write the installer pack-
age in two different CDs so that when I install it on
my computer, the PC detects that the installation is
not complete and there is more on a second CD. 

Secondly, for the last few days, whenever I start
my machine, it emits a whirring sound as if some-
thing is getting scratched. I think the sound is from
the fan of the SMPS, but I am not sure. After running
for sometime, it either stops or reduces to a mini-
mum. What is happening?

Udayan Misra 

Writing a 766 MB file to a CD is not a
problem these days, as 800 MB CD-R

media are available.
All you need to do is
start Nero, click on
File > Preferences,
click the ‘Expert
Features’ tab and
check the ‘Enable
Disc-at-once CD over-
burning’ as well as
‘Enable generation of
short lead-out’ and
click ‘OK’. 

Insert the media
and start burning the
file to it. When
prompted, choose to
overburn and the CD
will be created.
Remember, some older
CD writers might not
support overburning
and hence, you won’t
be able to create a CD
using those CD writers. 

If that’s the case,
then you may use a
compression utility
such as WinRAR to

create an archive that can be split into
volumes of 700 MB. You can later burn these
archive files to CDs.

Your second problem strongly points to
one of the fans in your computer being
obstructed. Open the cabinet and see if the
CPU fan, graphics card fan or any other fan is
obstructed by cables or wires. 

If so, relocate the wires to a location away
from the fan blades. If the SMPS fan seems
to be making the noise, then you are
advised not to open the SMPS yourselves as
there is risk of an electrical shock. Call a
hardware engineer to solve the problem.

I Want To Play DAT File, Now!
I have SuSE Linux 9.1, Mandrake 10, ELX
4.0 and Knoppix 3.3. I want to write a

VCD with Linux. I tried doing this with the K3B
software by Linux, but it asks for package
VCDIMAGER from vcdimager.org. I down-
loaded it from the Internet. It contains some
‘C’ files and others but no .rpm files. I tried
those, but in vain. How can I install this pack-
age? The Linux versions I have can’t play the

.DAT files except ELX; the rest play only .MPEG files.
Is there any package that plays these files?

Amit Pawar 

The files that you downloaded from vcdim-
ager.org are tar.gz files which you must

extract using a file extraction utility such as
GZIP from www.gzip.com. Since these are
source files, you will have to compile them and
then install the package. 

Alternatively, you can install NeroLINUX
which is nothing but Nero Burning ROM for
Linux. Download it from http://snipurl.com/flb5.
You can use this to create VCDs just like you use
Nero for Windows. You can download and install
MPlayer from www.mplayerhq.hu. It will let you
play a host of file formats including .DAT files.

Avid For Viewing 
I have Windows XP SP2 installed on my
computer. I had installed AutoPatcher from the

Digit DVD and disabled previewing of .AVI files.
Please tell me how I can enable this again. When I
turn on my PC, a warning in displayed that reads:
“Your Firewall is turned OFF”. When I try to turn it
‘ON’, an error message is displayed, “Cannot Turn
ON Firewall”.

Param Partap 

In order to enable the preview of AVI files in
Windows Explorer, open the registry editor.

Navigate to the following branch,
HKEY_CLASSES_ROOT\.avi\ShellEx. Right-click
in the right pane and select New > Key. Name
this key as {BB2E617C-0920-11d1-9A0B-
00C04FC2D6C1}. Include the brackets too. 

Next, double-click in the default string
inside this key and set its value to {c5a40261-
cd64-4ccf-84cb-c394da41d590}. Again, you
must include the brackets. After you log off
and log on again, the AVI preview in Windows
Explorer will be enabled. Enable overburning in Nero
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Collect News Via FeedDemon

U
sually, to collect news snippets from
the Internet, you have to visit your
favourite Web sites over and over

again. Not anymore. With an RSS reader,
these news snippets can be delivered
directly to your desktop, just like you get
mails in Outlook. FeedDemon is one of the
better solutions available for news
aggregation on the Windows platform.

Installing The Software
FeedDemon is an application you
need to install. The interface is

similar to that of Microsoft Outlook 2003. A
trial version of the software can be
downloaded from www.bradsoft.com.
Installation is a straightforward process, and
is similar to other Windows applications.
Just double-click the installation file and
follow the instructions.

The FeedDemon
User Interface
Once installed, a wizard walks you

through the configuring process, and also
introduces you to various aspects of
the application.

There are three panes. The first, on the
extreme left, is the ‘Channel’ bar; the middle
one shows news items, and the right-most
pane is a browser that allows you to read news
from the selected Web site.

Default Channel Groups  
The wizard has some pre-
configured channel groups so you

can start using the application straight out
of the box. A channel group is a collection
of similar news channels, for instance, in
the technology channel group, you can add
news channels from Anandtech, Toms-
hardware, CNET, and other Web sites—just
check the channel groups you would like to
subscribe to.

You can also go one step forward and
select specific channels in the channel

group. To do so, click on the ‘+’ sign and
expand the list, and then select channels
that suit your taste.

Subscribing To A
New Channel
At times, you might feel like

subscribing to a particular blog or a
specific Web site that offers RSS feeds but
is not included in the default channel list.
You will need to manually add it to the
channel bar. 

For adding a new channel, go to File >
New > New Channel. The New Channel
dialog box will open, if you have the URL of
the blog or the Web site (often offered by
Web sites and blogs) select the first option
and click ‘Next’. 

Paste the URL in the box and select the
checkbox that says ‘Auto-discover and verify
feeds’, then click ‘Next’. After entering the
URL, select a name for the channel, and
select the channel group for the same, so
that your feeds are properly organised.

Reading A News Item
The news item pane will list recent
news snippets from a particular

channel with a short lead. Just double-click
the snippet in the news items pane, and the
adjacent browser will take you directly to
that particular Web page. 

To read the next snippet, simply repeat
the process. The browser supports tabbed
browsing, so you can open multiple windows
if you like. 

Customising The
Look And Feel
You can customise the look and

feel of the interface from the ‘Options’

page. Go to ‘Tools’ and select ‘Options’ to
open the configuration page, or hit [F8] to
do the same. From this page, you can
change the look and feel of the interface,
as well as settings related to your
connection and also to other features.

Advanced Features 
FeedDemon also includes a
filtering system that allows

filtering of inbound news based on
keywords. These news snippets are
delivered to the ‘Watches’ pane.

To add keywords, go to File > New, and
select ‘New Watch’. A new watch dialog box
will open. Add a tile to the watch, then key
in the keywords and click ‘Finish’. Once
done, it will segregate news items with the
keywords separately in the watches pane.

With an RSS reader, you won’t have to visit your favourite news sites over and over

The FeedDemon User Interface

The default channel groups

Subscribing to a new channel

The second step in the process

Customising FeedDemon
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To enable firewall in Windows XP SP2,
follow these steps: Right-click on the
‘Internet Connection’ icon in the
‘Network Connection’, which is in the
‘Control Panel’ and click  ‘Properties’. 

Next, click the ‘Windows Firewall’ tab
and select the ‘ON (recommended)’ radio-
button. Click ‘OK’. Your firewall should
now be enabled. If this doesn’t work, your
Service Pack 2 installation is probably
corrupt, and you will have to re-install
Service Pack 2. 

A better option would be to install a
third-party firewall such as Sygate Personal
Firewall, which is free and can be down-
loaded from http://snipurl.com/24pi. It’s
much better than the firewall that comes
free with Windows XP SP2.

Who Does This Computer 
Belong To?

I have two Operating Systems—Windows 98 SE
on C: and Windows XP on D: drives. Whenever I

format C:, or re-install Windows 98 SE, I lose the
ability to boot into Windows XP, as its boot.ini file
resides on C:, which gets deleted during reinstalla-
tion of Windows 98 SE. So, along with Windows 98, I
also have to re-install Windows XP. Is there any
other way to install Windows 98 without having to
install Windows XP or to retain the boot.ini file? 

I have also tried copying the boot.ini file
but that does not seem to work. I have a few
music files with the extension .ram down-
loaded from Internet. 

While trying to find a player for it on
the Web, it refers to the ‘Real Audio Media
Player’, which I later installed from the
Digit DVD, but it could not play the above
file. In its supported file list, .rm is pres-
ent. I have many Hindi movie DVDs.
Please suggest software to cut songs from
the VOB files.

Soumyadeep Mitra 

As for your first question regarding
multiple operating systems, refer to

the answer provided in the Q&A section
of the June 2005 issue of Digit. 

The files with extension .RM and .RAM are
Real Media files and can be played using
RealPlayer basic version, which can be down-
loaded from www.real.com or using Real
Alternative, which was carried in the June 2005
DVD of Digit. If you are still not able to play the
file, chances are the file you have is corrupt. 

There is a lot of software available to cut
VOB files and save as AVI. Dr. DivX is one such
software and can be downloaded from
www.divx.com, and it’s shareware. Another
software, a freeware known as Vidomi can be
downloaded from www.vidomi.com. 

E-mail us your computing
problems along with your
contact details to
ssooss@@jjaassuubbhhaaii..ccoomm, 
and we may answer them
here! Since we get more
mails per day than we
can handle, it may take
some time for your 
query to be answered.
Rest assured, we are
listening!

Get Help Now!

PC Appears Critical 

My PC configuration is as follows: an Intel Pentium IV 2.4
GHZ, 256 MB DDR RAM, a Seagate Barracuda 80GB hard

disk, and Intel 845GEVB2 motherboard. Recently, while down-
loading software from the net, my PC hung and after 15 or
20 seconds, my screen went completely black and
displayed a message in blue with an error code “STOP:
C000021a (fatal system error)”. After this message, I shut
down my PC and restarted it . Still, I keep getting this
message: “Your computer has recovered from a critical
error”. I scanned my PC, but it didn’t show any reason for

the error messages. Is there a major problem? 
Appu Sarkar 

‘STOP: C000021A’ is an error that often occurs due to
pending file-rename operations scheduled in the

Windows XP registry that for some reason can’t be
completed. The software you were downloading is possi-
bly an online installation program that scheduled a file
to be renamed on the next restart of Windows. This is
due to the file being in use and hence, cannot be deleted
during the current session of Windows. 

During the boot process, Windows registry checks for
the file rename operation scheduled to be completed,
and if it finds that the file or folder does not exist, then
the above error is generated.

This error can be corrected using the registry editor.
However, be warned that fiddling with the registry can
be dangerous if not done with care. Use the registry
editor at your own risk. Moreover, you will need to
perform a parallel installation of Windows XP. A parallel
installation of the operating system is an installation to
the same drive and volume as an existing installation 
of Windows XP. 

From the parallel installation of Windows XP, start the
registry editor by going to Start > Run and entering regedit
and clicking ‘OK’. In the ‘File’ menu, click ‘Load Hive’ and
type the path to the System hive of the original installation
of Windows XP. This is typically: 

C:\Windows\Syetem32\config\system 
Click ‘Open’. When prompted for the name of the key,

type ‘TEST’, and view the following registry entry:
HKEY_LOCAL_MACHINE\TEST. Note the setting for the
Current DWord value in the preceding registry key. This is
represented as CURRENT:Reg_DWord:0x1. This indicates
that the “CurrentControlSet” for your Windows XP installa-
tion corresponds to ControlSet001. A value of ‘2’ indicates
that ControlSet002 will correspond to the
“CurrentControlSet” of your original Windows XP installa-
tion. Locate the following registry key:

HKEY_LOCAL_MACHINE\TEST\ControlSetXXX\Control
\Session Manager where XXX is the CurrentControlSet
identified in the previous step. Under the ‘Session
Manager’ key look for ‘PendingFileRenameOperations’
entries and delete them. Click ‘TEST’ hive, next, click the
‘File’ menu and click ‘Unload Hive’. Again, click the ‘File’
menu and click ‘Load Hive’. Locate and load the software
hive of the original Windows XP, which are typically
located at C:\Windows\System32\config\Software. When
prompted for the key, enter TEST2. Here, look for and
delete any PendingFileRenameOperations entries in the
following registrykeys: 

HKEY_LOCAL_MACHINE\TEST2\Microsoft\Windows\
CurrentVersion\RunOnce, and 

HKEY_LOCAL_MACHINE\TEST2\Microsoft\Windows\
CurrentVersion\RunOnceEx. Click on the TEST2 hive and
then click the ‘File’ menu and click ‘Unload Hive’. Quit
the registry editor and boot into the original installation
of Windows XP.

Question 

of the

Month
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It’s been almost two years since I assembled
my AMD machine with an Athlon XP 2400+
on an MSI K7N2G motherboard. All these

days, I have been avoiding playing games—a
complete waste of time once you get hooked, if
you ask me. But, despite my best efforts, I could-
n’t resist the temptation—and joined our Skoar!
team members for some ‘fragging’ sessions. 

From then on, a daily adrenalin rush was a
must to facilitate sound sleep! Back home, the
onboard nVidia2 Graphic chip could hardly
deliver when it came to Doom 3 or Far Cry. This
was reason enough for me to upgrade and shift
to the next level of performance. 

The problem, though, was that upgrading
just the graphics card was not enough. Also, I
would end up with an AGP card, a breed with
one foot in the grave. So, a complete platform
overhaul was called for. 

Join me on the journey, which saw me
upgrading my PC to something that will last
long—very long—and will allow me to play most
of the games out there. Before asking “AMD or
Intel,” ask which platform offers upgrading
headroom. To cut a long story short, ask “PCI-
Express or AGP?” 

When you’re talking about a gaming
machine, a lot will depend on which of these
standards your motherboard supports. PCI-
Express is the technology of tomorrow, and is
the way to go. 

Choosing between Intel and AMD is
something better left for you to decide
(read Digit’s Processor Performance Test in
the January 2005 issue for more).

I have always been an AMD fan, so it
was decided that an AMD platform
based on PCI-Express would be it.

My first stop at Lamington
Road was a small shop. For
some reason, the salesman
was insistent on selling
me a Sempron processor
on an Asus board. “No
thank you,” I told him as
I moved on.

The salesman in the
next shop was better at
tech, and offered me some
insights. According to him,
you can have a 754-pin or a
939-pin AMD Athlon 64 proces-
sor, the latter offering dual-chan-
nel memory support and hence, bet-
ter performance at the same clock speed. 

Hmm… what about clock speeds, I
asked? “It starts from as low as 2800+ and
goes up to 3800+, but we generally stock

processors up to 3200+, because there is hardly
any demand for other clock speeds,” he replied. 

Next, what about PCI-Express? Can I use it
with a 915 chipset? I could see the salesman was
about to break into a bout of hysterical laughter,
but he controlled himself admirably and
explained that although the 915 chipset sup-
ports PCI-Express, it is for Intel processors and
not AMD. I was impressed, and decided to lend
him my ears a little longer.

On an AMD platform, nVidia and ATi have
some good motherboards that support PCI-
Express, I was told. Motherboards based on ATi’s
RS480 chipset and nVidia’s nForce4 are selling
like hotcakes, especially boards based on the for-
mer chipset. These boards retail for around Rs 6K.

What if I wanted to put together two graph-
ics cards for the ultimate gaming experience?
Motherboards based on nVidia’s nForce4 chipset
offer this functionality, and this is called SLI
(Scalable Link Interface), but these mother-
boards are really expensive, I was informed. How
much? More than Rs 15K, and they require a pair
of special graphics cards. A pair of 6800 GTs
should set you back by Rs 60K! Well, that’s a lot
of money, and I skipped the idea. I had no plans
of settling for the ATi chipset, so I opted for a
Gigabyte board based on the nForce4 chipset for
around Rs 5.5K. 

The salesman was a little upset when I asked
him about Intel solutions, but he replied that
915 chipset boards are the best bet for PCI-
Express platforms from Intel. He also cautioned
me that a new replacement chipset for the 915 is
due in a month, and that it boasts of support for
dual- core Intel processors. Dual-core! What
about AMD dual-core processors? They are to be
launched somewhere in late October or
November, and will be compatible with existing
motherboards. 

Nevertheless, I had to settle for a graphics
card, and, in my opinion, nothing offers bet-
ter value for money than cards based on
nVidia’s 6600 GT. The shop had a Leadtek
6600GT for Rs 12.5K, and I was only happy to

buy one!
So, finally, my gaming rig looks like

this: an AMD Athlon
64 3200+ 939-pin, a

Gigabyte nForce4 moth-
erboard and a Leadtek

6600GT graphics card. A
steal of a deal for Rs 25K. Not bad, eh? 

Agent 001

PCI-Express is
the technology
of tomorrow,
and is the way
to go

Gamer’s Delight
Agent 001 decides he wants a future-proof gaming beast

Want more of Agent 001? Turn over to read his
answers to your buying questions

Illustration Shyam Shriram
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A Basic Digicam
I plan to buy a digital camera in the range of
Rs 6K to 8K. I am a casual shutterbug—all I

am looking at is a decent point-and-shoot camera.
Good picture clarity, reasonable amount of stor-
age memory and compact size are the more
important considerations. Also, I’d like to go for a
known brand. 

Kiran 

There are many good digicams in the
price range you’re looking at. Depending

on the features, the price will vary between Rs
8.5K and 10K. Canon’s PowerShot A310 and A400
are retail at around Rs 9K, while Nikon Coolpix
3100 and Kodak EasyShare CX7220 are available
at around Rs 8.5K. On the features front, Canon’s
A400 leads the pack with a 3.2 megapixel (MP)
sensor, while the rest have a 2 MP sensor.
However, when making a buying decision, you
should also take into account after-sales service,
as these digital cameras tend to turn into  photo-
genic paperweights if they develop problems.
Find out which of the above-mentioned compa-
nies have a good network in your city.

An AMD Gaming Rig
I want to build an AMD-based gaming rig.
Initially, I thought of getting an AMD Athlon FX

53, but I could not find a retailer selling it, nor was
I able to get hold of the FX 51. Also, on the Athlon
64 side, only the 3500+ is available at the top end.
Which is the right one for me? Since you always
advise good power supplies, I want to install a
400W Antec or VIP. Is that a fair choice? Also, is
the iBall cabinet with its own SMPS good, or should
I go for one of the above? Which memory should I
opt for? Hynix, Kingston…?

Mohith

Top-end AMD processors are hard to
find in the retail market. If you want to

buy any of them, you will need to contact
AMD’s main distributor in India, Tech Pacific,
on 022-55960101. You can also write to
pratik.chube@techpacindia.com for more
information on AMD processors. 
As for the SMPS, although the iBall cabinets
offer a power supply like all other case manu-
facturers do, they hardly match up to the per-
formance and reliability offered by Antec or
VIP. If I had to buy one, I would bet my money
on Antec.

Buy memory modules from any vendor—
just make sure they are genuine and compati-
ble with your motherboard.

Gimme The Graphics—Price No Bar
I want to buy a graphics card. I have a Pentium
4 processor plugged onto a 915-chipset mother-

board. Which graphics card can play all the games
(well, almost all) available in the market, and also
forthcoming titles such as Quake 4 and  the like?
Money is not an issue.

Vedamurthy Rajarajan 

Cards based on nVidia’s 6800 Ultra
chipset offer the best performance,

albeit at a significant price. So, if you want
the best of the best graphics cards, go for a
card based on the 6800 Ultra chipset from
vendors such as Gainward, MSI or Asus, and
expect to pay around Rs 40K. With this card in
your system, you can play any game with all
the eye candy on, and, at resolutions as high
as 1600 x 1200.

Hot In Hyderabad
I have a computer with a 2.8 GHz HT-enabled
Pentium 4 processor. After a few months of

use, I’ve noticed that the system gets hotter as I
play games or run it for few hours. Once the system
gets hot, the fans whirl faster, emitting a loud noise.

After some research on the Internet, I found
that using a good thermal compound helps a lot.
Arctic Silver seems to be the best thermal com-
pound, but I am unable to locate it in Hyderabad.
Can you help in locating a dealer?

Naveen

The new Pentium processors based on
the Prescott core generally tend to run

hotter, and hence, if you have one, your system
will run hot. The heating is nothing to worry
about; however, the resulting noise from the
fans can be irritating. Good thermal compounds
do reduce temperatures, but don’t expect mira-
cles. Your computer’s temperature will go down
by about 4 to 5 degrees at best. Still, if you want
to give it a try, you can call G Bhatia from Prime
ABGB Pvt Ltd on 022-23896600.

Of RAM Latencies
I have an AMD Athlon XP 2400+ CPU on an Asus
A7N8X-Deluxe board. I want to buy 512 MB of

DDR 400 MHz TwinX memory modules from Corsair.
Four types of TwinX are available, out of which the XL
and XLPT have the lowest latency, LL is of low laten-
cy and the regualar TwinX is of normal latency.

What is latency? Should I buy RAM of higher or
lower latency? What RAM module should I buy to get
the maximum performance from my system?

Shujat Ali

All computer components have some
amount of latency, i.e., the time required to
react after it receives a signal to send or receive
data. When the CPU requires some data stored
in RAM, it takes some time for the data to reach
the processor due to the latency of the memory
module. Hence, if your memory modules have
low latency, they will transmit data faster,
which translates into better performance. The
TwinX XL, XLPT and LL all have extremely low
latencies compared to regular memory mod-
ules, so they deliver better performance. A set
of 256 MB TwinX LL modules will set you back
by Rs 9.8K, and the price tag increases as the
latencies drop. I would suggest you go for the
regular TwinX memory module as they are
more than enough for your requirements. 

If you want the
best of the best
graphics cards,
go for a card
based on the
6800 Ultra
chipset from
vendors such 
as Gainward, 
MSI or Asus

Want a tech product, but
don’t know how to go
about buying it? Send an
e-mail to
agent001@thinkdigit.com
to get your queries
answered

Ask Away

Ask Agent 001
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Aditya Kuber

Geeks are always on the look-
out for a deal, and, spend a lot
of time and effort looking for

one. Sad thing is, they don’t often
get one. Techdepot.com is an
answer to their prayers. 

However, before you head
straight for the Internet, let me tell
you - this site is currently deliver-
ing only in the United States. So, it’s
time to beg those uncles and aunts
who are on their way from the US,
and plead them to get you your
dream gadget(s). But if you don’t
have a friend/relative abroad, still
this is a site you must simply visit
to keep track of all the great deals
and offers. 

Build Your PC
It’s simple. You have a budget and
you have a requirement. Putting the
two together is as good as having a
sunrise at midnight. Techdepot.com
does just that for you. First of all,
decide whether you want the PC for
home or office use, and select if you
want a desktop or a notebook. Now
you’re one a roll! 

Select components that fit your
price range and needs, a code is
generated for your order. The logic
behind this selection is that you can
come back at a later date and re-
order the exact same configuration.

Here’s a sampler of what’s
possible: Choose your hard drive,
your motherboard, even your cabi-
net and fan make! Then get to the

memory and choose how much RAM
you want, the hard drive capacity
and finally, the ports and all. Then
for the accessories, choose the
keyboard, mouse and your monitor.
And if you happen to be buying at
the time of a special promotion, you
could customise the colours of your
computer as well. Now, how about
that dazzling red… ?

More Than Just
Computers
Did you thing that computers were
all that was being retailed on 
Techdepot.com? You’re in for a
surpirse here! They’ve got digital
cameras, cell phones, scanners, LCD
monitors, accessories... the works.
What’s even better is that there’s a
deal on everything they sell!  

If you are on a really tight budget
then ‘Clearance Counter’ is the page
to bookmark. From time to time,
products that are either limited in
supply or ‘open-box specials’, are
listed here. Be sure to visit regularly
as these are fast moving items. 

Some deals are as good as
$1,599 (Rs 70,000 approx) for a
Toshiba Portege Tablet PC. And no,
this is not the one with just the bare
minimum, it has all the frills that will
catch the fancy of all geeks.

Techdepot.com

There are also other refurbished
products available and again, at a
bargain. While the range might not be
as varied as with the new products,
budget shoppers should find this
option handy. But you will need to
really look hard for a deal. I found one!

The site also offers tech support
and all vendors offer their products
with warranty, with all the bells and
whistles you would otherwise
expect to have.

Look Around
The site, although nicely laid out, is a
bit cluttered. Initially, it takes  some
time getting used to the layout, which
sometimes can be frustrating. This is
one of those sites where you would
like to get going from the word go,
but cannot, since it appears cluttered
and little confusing at the outset. But
with time, and a bit of pursuance,
you’ll get used to it. Don’t worry, its
worth the effort! 

There are almost 20 links on just
the top navigation bar and simply
going through all the 20 links to get
to know the site can take a while. If,
however, you are clear about what
you are looking for, chances are you
will find it with just one click.

The colours on the site are
rather muted and this gives it a
sombre appearance. Nevertheless,
it also has a soothing effect. You are
shopping, remember?

For Budding Geeks
Wait! There’s more. If you are a
student (or work for the government
in the US for that matter), there is a
different microsite for you that has
special student discounts, free pre-
sales tech support, and, even flexi-
ble payment options. Love it?

Yes, there are some more sites
that offer similar functions but what
we really liked about this site was
that it lets you construct your own
PC, buy refurbished PCs & prodcuts,
and they also have a clearance sale.
All this, in addition to the shiny new
stuff they have in plenty!

The only real negative with this
site, as mentioned, is the fact that
you cannot order anything sitting
here in India. But hey, a little
daydreaming and browsing never
hurt anyone, right? Surf away! 

aditya_kuber@ thinkdigit.com

Heaven is relative, but if you are a geek, chances are, this is what it would be like for you…

Can you ask for more? Techdepot.com’s homepage

‘Build Your PC’ at Techdepot.com
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It is a paradox of our times that, on the
World Wide Web, we can find long-lost
school friends whom you haven’t met in

15 years, but cannot find the telephone
number of the local 24-hour pharmacy. More
often than not, we find an obscure spy
document of World War II, but try finding
details on your local municipal
representative, and you will appreciate the
trouble with information on the Internet.
Quite unlike the 24-hour local telephone
information services that are pretty prompt
with information.

Google and Yahoo! launched local search
sites some time back; MSN launched its
local search engine in June. Good going.
The bad news, not surprisingly, is that most
of the local engines are America-centric.
Yet, it is a precursor to the future—the tool
that everybody wants; and everybody has
been waiting for.

We simply have to have a local equivalent
of Google on the Web. For India, for our city,
for our suburb, for our neighbourhood. 

It is, therefore, another startling
paradox that, in the age of information
overload, we find local information is at a
premium in our country. One of the easiest
ways to access local information today is
the local self-government body—the
municipal corporations and its local offices.
However, give or take a few, most municipal
corporations and their officers are
technophobes. You cannot expect them to
create online databases that you and I can
access when they are scared of the PC. Or so
is the excuse that is meted out.

My theory is this: government officials
are not scared of technology; they are scared
of giving out information. Information is
power; their only constituency, so to speak.
This power gives rise to corruption. Hence,
there is no logical (even if immoral) reason
why they should give out information that
can, theoretically, be “sold”.

One of the most interesting (and
information-laden) aspects of local search is
maps. Almost every US and European city is
digitally mapped, and with aerial imagery
now available on the Web (think

keyhole.com or TerraServer), it is almost
tragic that India’s satellite imaging prowess
is not put to good use for that precious
human connect with technology. 

Truth be told, none of the three—MSN,
Yahoo!, or Google—can add any value to our
local knowledge if the information itself is
not there in the first place. Ask the
municipal corporation of Mumbai, the city
where I live, about maps of Mumbai, and you
will come up with a blank. Yet, the guys at
Eicher Good Earth, a private firm, have
published an entire book of Mumbai’s maps,
including valuable information on local
shopping complexes, ATMs, apartments,
hospitals, 24-hour pharmacies, and you
understand why digitising a city’s
information requires intent and will, more
than money. So, if Eicher can, why can’t the
municipality, especially since it is a
treasurehouse of information?

All the three search giants throw up
results indexed from local businesses and
services. Nowhere have they invested their
own resources to create information. The
only money that has gone into these search
services is for developing the programs that
power them, and investing in the people
who are doing it. It is a simple model. Try
searching “Pizza Hut” in “Evanston”
(Illinois, USA) on any of the three services,
and you will not only get detailed addresses
along with phone numbers, you also get
maps, aerial imagery, and other options you
could try out just in case. MSN’s beta
version of the local search also throws up
Web results for good measure.

Not that maps and aerial imagery are
anything new (MapQuest provided PDF
versions of aerial imagery more than two
years ago), but it was only in the last six
months, post Google’s acquisition of
Keyhole.com, and the subsequent use of its
aerial images by CNN, that the service came
into prominence. Google, it would seem, did
the right thing at the right time. So did MSN.
So did Yahoo!.

Their success with local search is
evidence enough that people care more
about their neighbourhood than what
it is happening in Poland or Sierra Leone.
Or for that matter, whether US army
personnel are hurling abuses at the inmates
in Guantanamo Bay. If I want to know
which restaurants in my suburb are open at
three in the morning, someone better give
me that information.

The call, therefore, goes around the Web:
Wake up! The future is local. 

Sachin Kalbag

Sachin Kalbag, former
Executive Editor of Digit, is now
a Deputy Editor at Daily News
and Analysis (DNA), Mumbai

Wake Up! 
The Future Is Local

Google and Yahoo! launched local search sites
some time back; MSN launched its local search
engine in June. Good going. The bad news, not
surprisingly, is that most of the local engines
are America-centric”
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Not really Elvis,
but someone in
Elvis’ land,
anyway! I do have
a few relatives
and friends living
abroad and last
month, a couple
of them
celebrated their
birthday last
month. Over the
years, I have been
wishing them over
e-mail, but this
year, I thought
why not call them
using VoIP? The
dilemma? Is VoIP
better than the
good old phone? 

At home, I use my CDMA cell phone to connect to
the Internet. The connection for using VoIP needs
to be stable, but this will have to do for now.
First, install a P2P software like Skype that helps
you connect to another computer to talk. You will
find it on the Digit DVD; installation takes
around 15 minutes.

Time taken 15 min

Once installed, I need to configure it and ensure that
the person I wish to call has the same software (it’s a
P2P, remember?). Thankfully, my cousin has it and I
make the connection.

Time taken 10 minutes

My cousin has been expecting my ‘call’ and is on
standby when I connect. We can talk for as long as
we want and the connection is not too bad either.
There is a slight lag though... and I would have done
better with one of the new PC phone devices. We
have a good 15 minute conversation.

Time taken 15 minutes

I had to go to the corner store and buy a calling
card and eventually, it lasted me only eight
minutes. Voice quality and lag were also a let down.
Not too impressed, but this was simpler.

Good old telephone... ...And this is what the computer has done to it

1

2

3

4 It was a good thing that I had forewarned my
cousin of my call. With cost not being an issue, we
could talk for as long as we wished. Voice quality
was only marginally better, though.

Moneywise, the tech way is better. However, in
terms of speed, the old way is better. But the tech

way wins only because of the sheer convenience it
offers. With this form of communication constantly

improving, I guess I would stick to this. I’m paying for
the Internet connection anyway… why pay again for
making calls if I can combine the two?

OLD
WAY

TECH
WAY

Total Time Taken: 35 minutes
Total Cost: Rs 100 

Total Time Taken: 40 minutes 
Total Cost: Rs 0 

And 
The

Winner
Is...

Aditya Kuber (aditya_kuber@thinkdigit.com)

The voice quality is all right, but the time lag is
irritating. No choice, though... the calling card
lasts me for about 8 minutes; just about enough to
have a decent conversation.

Time taken 10 minutes

Calling Elvis!

Once I have purchased the calling card, all I need
to do is punch in the code behind the card and
dial the destination number. Easy as pie.

Time taken 10 minutes

Options galore! Should I use the landline or my cell
phone? I have a post-paid cell phone and need to
subscribe to international calling. Since my land-
line doesn’t have ISD (International Subscriber
Dialling), I will have to either buy a calling card or
go to the corner shop to make the call. I choose the
calling card worth Rs 100; gives me more control!

Time taken 15 min
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nything to do with computers and infor-
mation technology and you’d have
multiple formats and their multiple

abbreviations. And don’t blame the press for
this state of affairs. It’s the geek ego at play. So
we have Really Simple Syndication and Rich 
Site Summary. We have RSS feeds and Atom
Feeds. We have feed burners and then we have
feed readers…

Now, if all this is end-user technology, why
must an average computer user struggle with
all this? What is a news aggregator? How does
it function better than just going to the site
directly and accessing all your information?
Well, as you would have guessed, the questions
are no-brainers, and as we proceed through the

A

article, you’ll see how much easier and how
much more convenient it is to have your own
feed reader. Moreover, throughout the article,
to maintain a level of uniformity and easy
recall, all formats of feeds—whether RSS or
Atom—would be referred to as RSS feeds or
simply, feeds. Nothing personal against the
Atom format, but RSS is a better-known
acronym to remember.

Looking Before Leaping
Before we get headlong into the coded world of
XML and RSS, we need to tackle a few points
that people regularly miss out on—areas such
as syndication, uses of a feed, and how setting
up a feed increases the number of hits to your
site. We have already discussed how to 
set up your own RSS feed (Tips & Tricks, Digit,
June 2005).

Illustration Binesh Sreedharan

News is 
the in
thing these 
days. It’s 
therefore 
natural 
that news 
aggregators 
are a talking 
point

News You Can Use
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The term that actually drives people up the wall, however, is
‘Syndication’. Web Syndication is often confused with copyright.
Though in some cases, syndication does involve procuring a
license from the originator of the story, in many cases these
days, syndication on the Web merely means making feeds avail-
able from a site so other people can display an updating list of
content from it. This originated with news and blog sites, but is
increasingly used to syndicate any information.

So how does this update happen? And how does it benefit the
end-user? For someone to subscribe to an RSS feed, a few condi-
tions are a must:

First and foremost, the publisher of the content must make
the content available in the RSS format. Secondly, the person
subscribing to a feed must have a feed reader or ‘News Aggrega-
tor’. This gets us to the whole point of this article. What in the
name of Brin and Page is a news aggregator?

The Boss
Simply put, a really smooth set of code that fits snugly into your
Internet browser or desktop is an aggregator. But what exactly
does this software do? 

In a nutshell, a News Aggregator periodically downloads 
the latest headlines from your chosen news sources and
displays them in one convenient place. It enables you to glance
at the latest headlines and gives you the ability to read the 
full story behind those headlines that interest you. You don’t
have to go scourging around the Internet nor does your 
bookmarks list have to flow into hundreds to get the news that
interests you! 

News feed readers come as individual software that can be
downloaded off the Internet. You also have RSS readers that can
be added as extensions to your browser (Only Firefox and Opera
as yet) or sites such as Bloglines (registration required) that let
you check all your feeds from any Web browser.

So no more unwanted tabs open on your Firefox or Opera, no
more waiting for the advertisements to load for just a quick
glance through the headlines. What aggregators (and RSS and
Atom as a whole) have done is given you the choice to read only
the news you want to read. You get to run a quick check on the
headlines and pick only the ones that really interest you. What
you can also do, is choose the sites or blogs you want to subscribe
to. This is truly having your cake and eating it too!

Best Practice Guidelines For AdSense

Syndicate the full text of your articles
The more content that is available in a site’s feed, the better the user
experience, and the more likely people are to subscribe your feed. If
you can’t put the full text of your articles in your feed, then in addition
to the headline of each article, include as informative a snippet as
possible of the article’s text.

Don’t include more than one ad unit per article
Feeds represent an uncluttered, highly targeted medium, and these
characteristics should be preserved to maintain and grow an audience.
The AdSense for feeds ad format has been designed to be very
streamlined to ensure that users are not overwhelmed with advertising.

Place the ad unit at the end of articles
The content of an article is what users are most interested in, and that
should be placed first. Then they can read the ad with more context.

Include terms and conditions on the use of your feeds
Just as you have rights associated with the original content you create on
your Web site, you also have rights associated with your feed content. If
you have concerns about those rights, specify the exact terms and
conditions for the use of your feeds somewhere on your site.

Source: http://snipurl.com/digitenhance
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In a way, feed readers are like conditional
access for the end user. For example, a
technophile (the propah word for a geek, if you
may) would find it really handy to subscribe to
a technology Web site like Wired.com and blogs
that feature articles on technology such as
Slashdot.org or Gizmodo.com. Avid market
trackers could surf through multiple feeds
coming from Wall Street Journal, Reuters Busi-
ness or other such business information
portals. But the real gainers from this technol-
ogy are journalists and market or industrial
research personnel. 

Who Benefits From This?
For a scribe, an aggregator is like his/her own
personal news ticker (the infoRSS extension
available for Firefox actually looks and works
like a television news ticker, as it scrolls across
your taskbar). This ticker saves the journalist a
lot of time and the trouble of visiting news sites
from across the globe. All that needs to be done
is subscribe and read off the feed reader.

With the number of blogs increasing at an
alarming rate, market research professionals are
turning to them for gathering relevant market-
ing data. The comments left behind on

commonly read blogs give a fair inkling to these
guys about public perception of a service or a
product. By subscribing to these blogs—most
blogs generate feeds as a default setting—and
sites, a market research cuts down on the time
spent combing for relevant data.

How do these tools help Web sites then?
Have you ever wondered how Web browsers
help Web sites? You see, news aggregators play
a very analogous role vis-à-vis Web browsers.
One lets you surf sites, the other surfs your
feeds for you. Both, develop, increase and accen-
tuate traffic towards the portal (could be a site,
could be a blog). 

But the aggregator ensures point delivery. If
I am a content provider on the net, I can take
this reasoning of accurate content delivery to an
advertiser and then proceed towards my bank…
laughing all the way, of course!

As a Web publisher whose content has been
subscribed to via the RSS format, I get a clear
picture of what sort of content would appeal to
people/readers/users. As a feed provider, you can
decide whether to put up all your content as the
feed or just a summary.

Also, the software ensures if a person finds
an interesting piece of news or post on a Web
site, he will be directed to the site on clicking
the summary. Google has decided to extend
their AdSense programme to RSS feeds as well.
Now available as a beta, the procedure is 
similar to setting up a normal AdSense account
(see box Best Practice Guidelines For AdSense on
previous page).

With the advent of new browsers and tech-
nology such as news aggregators, our methods
and habits of surfing the Internet will undergo
a drastic change. This conditional access will also
prompt Web site publishers to come up with
innovative approaches to laying out their
content. It would also help users decide very
quickly what news is the news they can use. 

mithun_kidambi@thinkdigit.com

Jargon In My Head

With tonnes of jargons and formats floating around, an
average PC is always at sea. So to bust a few technological

high bars, here’s a brief explanation of concepts and tech fundas.

What is RSS? 
It’s a dialect of XML. Still puzzled? Read on.
RSS is a format for syndicating news and the content of news-
like sites and blogs. The acronym stands for Really Simple
Syndication or Rich Site Summary. There is an ongoing dispute
between the two camps over the versions RSS 1.0 and RSS 2.0
but then let’s not get into that bit.

How do RSS and feed readers work?
RSS files are a type of metadata. Metadata in turn, are units of
information commonly used to provide descriptive information
about the content, context, and characteristics of data.

An RSS file commonly contains four main types of
elements: channel, image, items, and text input. These
elements are easy to identify and code. A typical RSS file would
read as follows

<item>
<title>I Am trying To Understand How A RSS Feed

Works</title>
<link>http://www.thinkdigt.com</link>

<description>An RSS-aware programme will track changes
and…</description>.

Now a reader is a simple program that tracks changes in
the feed and reacts appropriately. A news aggregator will
update the feed as per the changes. 

What is a news reader?
A news reader is simply a piece of software that you can use to
read your subscribed news feeds. 

What is a news feed?
A news feed (also known as an RSS feed) is a listing of a Web
site’s content. It is updated whenever new content is published
to the site. News readers “subscribe” to news feeds by
downloading lists of content, blogs, tips, stories etc, and present
them to you in your news reader. All news feeds will have a link
back to the Web site, so if you see a headline/excerpt/story you
like, you can click on the link for that piece of content and will be
taken to the Web site that generated the news feed to read it. 

What is syndication?
Syndication refers to the process that occurs when a publisher
provides content in a form that can be consumed by software
(like a news reader).

The Habari Xenu Firefox browser integrated news aggregator
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ilesh Nayar recently joined a leading
software company in Mumbai as an
associate consultant. Fresh out of an

engineering college with a degree in computer
engineering, Nilesh feels a degree in manage-
ment will help him scale the corporate 
ladder faster. So why didn’t he go in for a post-
graduate course in management right after 
his graduation?

His answer: “Getting a good job right after
college is getting pretty tough these days; also,
wouldn’t work experience help if you want to
pursue a management degree later?” 

This line of reasoning can be heard from an
increasing number of young professionals
across the country. India has always had stu-
dents enrol for management courses right after
graduation. This is quite contrary to the trend
observed in the West. With work experience
being a prime criterion for admission, the
average age for students in the first year
of management schools, including the
likes of Harvard Business School and
INSEAD, is around 27 years. We, 

however, learn to live life on the fast track right
from our kindergarten days. It is therefore nat-
ural that most freshers at B-schools around the
country are fresh graduates. 

But there is also a bunch of people who
would like to keep their jobs and get additional
qualifications, all in a bid to keep up in the cor-
porate rat-race. The part-time courses (after-
hours lessons) offered by almost all
management institutes across the country cater
to this demand.

Lectures and presentations after work hours
do get tiring, but then, there is the next big pro-
motion dangling in front of your eyes! These
courses have a few shortcomings, though. The
timings may not be suitable to all, and working
executives at times have to travel—in the process
missing a few lectures. These courses are also
restricted to working executives from a partic-
ular location. So what could be done to bring in

a larger pool of students and make the
courses available to many more stu-

dents, transcending geographical
boundaries? This is the 21st cen-

tury, and there is a very simple
credo here: when faced with a
problem, think Technology.

A management institute, a telecom major and a high-speed connection is enough to learn management—
no matter where you are in India

Broad-basing Management
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faculty. The curriculum provides enough flexi-
bility to the faculty to maintain equilibrium
between theoretical understanding and prac-
tical applications,” he adds.

With a batch of a maximum of 150 stu-
dents, the institute is making sure they do not
overpopulate a class. They, however, have plans
to increase the number of batches with every
academic year. The one-year course has 
240 hours of online classes and 60 hours 
of on-campus contact sessions at XIM’s
Bhubaneshwar campus.

At Rs 1,50,000 for individual students,
the course may be a little expensive, but then,
this is application of video conferencing
and broadband technology with all its bells
and whistles.

The Class Act
How does this course really function then? How
different is it from trooping into a classroom?
After the rigorous selection process, as is 
the norm for any management course, suc-
cessful candidates will opt for their choice of
Webworld centres. This, of course, is subject 
to the availability of a minimum number of
applications for that centre. In short, a quorum
is required! 

The classroom functions as a regular one;
however, instead of a lecture podium, the pro-
fessor peers down at you from a video camera.
The high speeds and plasma televisions would
mean that you will get impeccable picture and
audio, and that too, in real-time.

This will also enable a student to interact
with the lecturer or fellow students. The lec-
turer would get multiple images on his plasma
screen thanks to PiP (Picture-in-Picture) tech-
nology, which would make it easy for him to
address individual questions and also ask for
opinions from a particular student. 

Broadband internet access also means that
students would be able to look up or research a
topic in real-time when a lecture or Q&A ses-
sion is in progress. This will also enable pre-
sentations online.

Looking Forward
Commencing July this year, the one-year course
aims to redefine the way management educa-
tion for working professionals is conducted
across the country.

In addition to the PGCBM, XIM has a Post
Graduate Certificate Course in Rural
Management (PGCRM) in the pipeline. Along
with that, there are a large number of
Management Development Programmes
(MDP), which the institute plans to offer to var-
ious corporate, government and non-govern-
ment institutions.

If extended beyond postgraduate educa-
tion, affordable broadband technology 
might just prove to be the panacea for our
ailing rural education programmes and under-
takings. It could also reach out to all those chil-
dren who cannot take the time out to attend
day schools. Backward Integration just got a
new meaning. 

mithun_kidambi@thinkdigit.com

102 DIGIT JULY 2005

Digital Business l Case Study

The Genesis
Technology might not solve all your problems,
but it has a soft spot for education and post-
graduate students in particular! “Xavier Insti-
tute of Management, Bhubaneswar (XIMB) has
always looked forward to expanding the
domain of management education and
reaching out to the world in order to deliver
quality education to students without the lim-
itations of place or travel,” says Dr W S
William, Dean-Academics, XIMB. In keeping
with this line of thought, XIMB wanted to offer
a postgraduate programme using a virtual
classroom platform.

In their bid to leverage the potential of satel-
lite education and its utility as a virtual class-
room platform, XIMB ran into a few technical
roadblocks. What they needed was a technology
partner who could provide the necessary—and
really humungous—infrastructure. At around
the same time, Reliance Webworld was looking
to make more use of their existing Webworld
centres, all of which were equipped with a
videoconferencing facility and high-speed data
transfer capability. “We had an existing rela-
tionship of sorts with XIMB,” says Sarup
Chowdhary, CEO, Reliance Webworld. “When
they proposed this venture, we were only too
glad to be able to render our services.”  

All Cut And Laid Out
Born out of an alliance of opportunity
and necessity was the PGCBM, or Post Graduate
Certificate Programme in Business Manage-
ment, based on the virtual classroom format.

Aimed primarily at working executives, the
weekly classes would be held only after office
hours. Each of the Reliance Webstores has a
Video Conferencing (VC) room, which accom-
modates up to 12 students. Thus, the students
of the PGCBM programme would be seated in a
Reliance Webworld, interconnected seamlessly
with other centres through a VC bridge, which
is stationed at the DAKC (Dhirubhai Ambani
Knowledge City) in Mumbai.

With over 200 Webworlds spread around
the country, accessibility to the course would
definitely not be a problem. Also, the high data
transfer speeds—a dedicated 768 kbps line to
enable video communication in real-time—have
ensured that a virtual classroom would actually
feel like a classroom.

Technology has also made sure that absen-
teeism from class would not be punished! If a
student is unable to attend a lecture, the ses-
sion would be played back to the students at the
designated Webstores, which is possible
because lectures and the classroom proceedings
would be recorded. Now, if only my college had
thought of my well-being and recorded all those
‘fun-filled’ lectures I missed... 

So what are the dynamics of the course, you
ask? Use of technology is fine, but what is more
important is the credibility of the course, and
this would be best ascertained by taking a look
at the curriculum. Dr William says that the
course would be as robust as any management
course around. “The quality of the curriculum
is very high, specifically designed by our 

This programme
leverages the latest
technology, is
location neutral,
adds immense
value to the
working executives
and has a high
quality curriculum
design.”

Prof W S William
Dean (Academics), 
XIMB
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Guest
Column

For at least a decade, individuals around
the world have questioned  opportunities
offered by Internet to help foster

commercial development. Based on our
successful experience of millions, the answer
to these questions is a resounding “Yes.” ,
With over 150 million registered users from
more than  150 different countries (over a
million users in India), eBay has enabled
individuals and small businesses to offer their
wares to e-commerce shoppers everywhere. 

Online marketplaces allow craftspeople
in small villages in remote corners of India
to market their unique handcrafted goods
over the Internet to Europeans and
Americans seeking a taste of Indian culture.
City dwellers in Mumbai can purchase
jewellery, electronics, and even automobiles,
at prices lower than what they would pay in
other markets. 

Even so, many consider the world of
electronic commerce to still be in its infancy,
particularly when looking at the vast
potential for growth of Internet access and
its use around the world. In the same regard,
the recipe for success related to secure
electronic commerce in the ever-evolving
Internet is still a work in progress, as
businesses around the world explore new e-
commerce models on an almost daily basis
and fickle consumers vote on the success of
these websites with their pocketbooks.

Studies show that the primary security
related reasons for consumers not
participating in electronic commerce
include:

Not receiving items purchased or receiving 
items that are substantially different than 

described (and having no recourse)  
Having their personal information sold to 

third parties
Having their personal information stolen
E-mail scams known as “phishing” or

“spoofing” that result in messages being sent
from disreputable sources but disguised as
messages from trusted sources

To understand a bit about the success of
electronic commerce, it may be helpful to
ask: what is the key to success of eBay? 
How does eBay help people overcome the

perceived anonymity of the Internet to 
build enough confidence that buyers are
willing to send money to sellers they have
never met? From the perspective of an
insider, the answer can be summed up in
one word: Trust. 

The first ingredient in a trusted
marketplace is a community of users who act
with integrity. In this regard, we have
discovered and capitalised on something that
we all know intuitively but that rarely gets
reported in our morning newspapers or
evening news programs-people are basically
good! Just as 99.9 per cent of the people we
choose to interact with in our daily lives 
are conscientious and moral; the
overwhelming majority of users bring the
best intentions to their ecommerce
transactions on eBay.

Layering this trust with a world class
security team of close to 1,000 people, we use
statistical risk analytics to identify and remove
suspicious users and inappropriate items. As
credit card companies set a ceiling on
spending based on user characteristics and
flag suspicious transactions by location and
price, eBay’s security team can act behind the
scenes to keep an eye out for everyone.

Add a little flavour with a philosophy of
working closely with law enforcement. eBay
takes the view that law enforcement
agencies should be able to walk their beat
on eBay the same way they patrol an offline
shopping mall or a street corner. eBay has
more than a dozen former law enforcement
officials on staff and maintains strong
partnerships with law enforcement from
many countries to ensure that those
responsible for misconduct are prosecuted
to the fullest extent possible.

This is another example of converging
real world concepts successfully with the
virtual world. Doing this unobtrusively is just
as important to maintain the sanctity of the
online marketplace. 

Topping this off is a financial protection
program to reimburse users who do face a
true problem. For example, one can provide
free buyer protection for losses occured at
the buyer’s end.

With this recipe, online marketplaces in
the converged world can become a reflection
of the people who use its platform. The
success of eBay helps confirm our belief that
people are basically good and willing to trade
fairly and honestly with others. 

It has also gone a long way in reinforcing
the belief that converging the real and
virtual worlds is possible. 

Joseph Sullivan

The author, Joseph Sullivan, is
Senior Director of Trust and
Safety at eBay Inc. He recently
spent three weeks in India

Security In An
Online Marketplace

Are people actually willing to trust someone they
have never met, is located somewhere far away, per-
haps even on the other side of the globe? Could a
business based on trust between remote buyers and
sellers actually work? Evidently, yes!
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Credit Cards And Impulse Buyers
Credit cards are such a novel invention. When
used right, they can save you in times of cash
crunches—while on the other hand, can be the
cause for a cash crunch. As a business, credit
cards are always your friends. The great fear of
buying online with credit cards is reducing. More
and more people are spending money they don’t
have, to buy things they don’t really need—and
most of it is online. As a business, if your prod-
ucts offer any sort of flaunt value, or have caused
customers to impulse-buy, and you’re not online
yet, you’re missing out on a lot of business. 

Reputation And Appearance
It may sound shallow, but people are so used to
seeing sites with shopping carts, coming across
your site that does sell products, but not
online, might make your company seem small.
Whether this is true or not isn’t really impor-
tant; the fact is, you’re not IBM or Microsoft,
and you’re not selling steel or crude oil. You

Robert Sovereign-Smith

t’s true that not all products are suit-
able for sale online. Not many online
buyers would think, “Ahh, I’d like a ton

of steel to build my own boat, and a couple
of barrels of crude oil in case I run out of
charcoal for the barbecue.” However, if you are
a medium-sized company offering products,
and not services, you should already have
an online retail outlet. If Fabmall.com can
deliver groceries in Bangalore, there’s no
reason for any company to think twice about
selling online.

As usual, basic questions abound: “Do people
really buy online?”, “We can’t afford an online
merchant ID, can we?”, “Are my products too
expensive/cheap to be sold online?”, the list goes
on... So let’s take a look at why you should sell
online before we get into telling you how to set
up payment gateways.

DIGIT JULY 2005

Have you
ignored the
prospect of sales
on the Internet?
Boost company
profits—start
selling online

Imaging Binesh Sreedharan
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don’t have a million distributors either, so
where’s the online product catalogue and
shopping cart?

Product Pricing
Yes, it’s pointless to set up an online shop if your
products cost a lakh a piece. Considering that the
average credit card holder’s credit limit is between
Rs 30,000 and Rs 40,000, any products that cost in
excess of Rs 20,000 might not be so hot online. If
your products are FMCGs, and cost anywhere from
a few hundred rupees to a few thousand, you
should definitely consider an online shop.

Shipping
Don’t make the mistake of thinking that since
you only service a single city, an online shop
wouldn’t help. You will need to mention
clearly that delivery is only within your city,
and not let it deter you from setting up your e-
shop. You could always put up a “Dealers
Wanted” sign on your site and try and expand
into more cities eventually. 

The Checklist 
Before you go about getting a Payment Gateway,
you need to identify your needs. If you have a
variety of products, you will need to set up a
product catalogue and a shopping cart service. 

In this issue, we have shown you how to set up
a PHP Web site (page 62). If you are setting up a Web
site using that advice, you will find that adding a
shopping cart is quite simple—all you need to do
is find a shopping cart module for PHP-Nuke that
fits your needs, and add it to your Web site.

Digital Business l Smart Business

The Payment Gateway
The payment gateway is sort of like a broker for
all deals between you and your customers. It will
authenticate your customer’s credit or debit card
and then bill it for the specified amount. This
money is then deposited into your account on a
weekly or monthly basis.

The important thing to keep in mind is that
you will need to bill your customers in the local
currency, as you don’t want customers not
buying your products just because the price is
mentioned in dollars. Though there are many
companies offering payment gateway services,
we will just take one example for the purpose of
this article.

The first thing you need to do is register at CCAvenue.com

Don’t make the
mistake of
thinking that
since you only
service a single
city, an online
shop wouldn’t
help
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CCAvenue.com
CC Avenue is a trusted Indian payment gateway,
and boasts of clients such as C-DAC, TATA, the
Ministry of Commerce and Industry, Mahindra
and Mahindra, LG Electronics India, Reliance’s
Paradox Studios, and yes, even Digit. The fact that
we use it should suffice as an explanation as to
why we recommend it. 

CCAvenue has two basic options for a
payment gateway solution:
The Premium Scheme: This involves a one-time
setup charge of Rs 25,000, and a software main-
tenance cost of Rs 2,400 per annum. They levy a
charge of five per cent per transaction under this
scheme, so for every Rs 1,000 that you sell online,
Rs 50 goes to CCAvenue. You will have to price
your products accordingly and cover this deficit
of five per cent.

The Economy Scheme: For smaller businesses
just starting up an online shop, this is perhaps
the wiser option. There is the Rs 7,500 one-time
setup fee, and a software maintenance charge of
Rs 1,200 per annum. In this scheme, the per
transaction charge is seven per cent.

You can always upgrade to the premium
scheme later, by paying the difference in the setup
fees. Also, you can do that only if you receive an
overwhelming response to your online shop and
end up paying a little too much to CCAvenue at
the extra two per cent per transaction!

Setting It Up
In order to set up your payment gateway, all you
need to do is log on to www.ccavenue.com and
click on the ‘Sign Up’ link. Fill in all the details
correctly, and you will be asked to pay for your
gateway plan. You can pay by credit card, Net
Banking, demand draft, or even by cheque.

Once you’ve paid, you will need to download a
copy of the CCAvenue Client Agreement, down-
loadable from http://snipurl.com/digit_cca1, or

viewable at http://snipurl.com/digit_cca2. You will
need to print this on a Rs 100 stamp paper, and
have it filled in, signed and stamped by an autho-
rised signatory for your company, and then snail-
mailed to CCAvenue.

Once you have been approved, your account
will go online and you will receive instructions
on how to go about integrating your site with
CCAvenue in order to offer your visitors the abil-
ity to purchase merchandise.

Using your Account
CCAvenue charges your clients for you, and
then puts each order into an accounting
module in your account with CCAvenue.
You have to log in frequently to your CCAvenue
account and update the status of each order
to ‘Shipped’ or ‘Executed’. Only then is the
payment delivered to your account. Failure
to update the status of a pending transaction
for 12 days results in the money being
credited back to the customer, and you lose a
perfectly good order. 

Apart from the little coding required to inte-
grate the module that CCAvenue provides you
with, everything else should be a breeze. Even the
module integration should be easy for any compe-
tent Webmaster or systems administrator. CCAv-
enue will provide you with modules based on ASP,
PHP, JAVA and .NET, so 99 per cent of Web sites
should have no problems with the integration.

The setup procedure is pretty much the same
for any payment gateway provider that you
choose, and the control panels will be similar.
Within a matter of three or four days after apply-
ing for a payment gateway, you should be able to
begin integrating your site with it. Do write in to
us and let us know if this article helped your
company’s business grow. 

robert_smith@thinkdigit.com

Choosing the right payment options can mean as much as 50 per cent more
online business for you. Using your payment gateway, you can also choose to

add Net Banking and debit cards as options for payment. You should also design
your shopping cart in such a way that the Cheque, Demand Drafts and Cash On
Delivery payment options are also included, which should then point to another
page within your Web site itself. Be sure to mention all important details, such as
the name the cheque should be made out to, in crisp bold lettering—one spelling
mistake could cause a lot of unnecessary headaches.

Also make sure you have trustworthy resources and manpower to execute the
Cash on Delivery payment option, else it would be wise to steer clear of offering it.

Choosing The Right Payment Options

The main CCAvenue control panel screen

View details of all transactions over the past months

From the CCAvenue control panel you can get quick
statistics for the past week, month, or year as well

You can always
upgrade to the
premium scheme
later, by paying
the difference in
the setup fees
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Trend

Blogvertising,

We have advertised on blogs to some
extent. For instance, advertising
campaigns for MSN and Reliance

Mutual Fund were extended to blogs. We don’t
contact the blog publishers directly, and most of
the ads are done through Google AdSense. 

Indian blogs are still at the evolutionary
stage. Abroad, blogs have almost 50 million hits
per month, whereas in India the figure is just
around 3,000 to 4,000 hits per month.

Although the current revenue from
advertising on blogs is negligible, this
segment can’t be ignored. The focus on blogs
is entirely content-oriented. Blogs are also a
good example of two-way communication. 

The viewer response to advertising on blogs
would be higher than the traditional medium.
In blogs, the ads will be looked at by serious
surfers. As bloggers are increasing in number,
India is slowly and surely catching up! In the
future, newspapers may source content from
blogs only because of the quality.

Advertising on blogs hasn’t taken off in
India the way it has in the West. Indian
advertisers are very reluctant to put

their money into blogs right now. Also, if you
were to compare the number of page views of
an Indian blog to a US blog, it is much lower. 

I would say the main reason blogs are not
that popular is due to a lack of awareness
among the general public. If you were to
compare, people in India took considerably
longer to adapt to e-mails than did their
European counterparts. Similarly, in due
course of time, when the market matures,
blogs in India will see more action.

Earnings from blogs form a very small
part of the revenue today. However, I am sure
this will change in the future. While blogs
have the advantage of being able to connect
to the right people, they also have the
constraint of not being able to reach remote
audiences. Here, the traditional medium still
has an edge.

Sunil Miranda
Vice-president, 
Mediaturf

C V S Sharma
GM and Country Head,
Tribal DDB India
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With blogs becoming a rage, can they be the next hot-spot for advertisements? 
Digit speaks to some people in the know
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Rohit Gupta
Blogger (www.desimedia-
bitch.blogspot.com)

Anish Sood
Blogger
(www.anishsood.tk)

Blogging in India is still at its nascent stage. The amount of
advertising happening online is also not high across Web sites.
Rediff and Yahoo! are among the few major names in online

advertising. Besides, how many serious Indian blogs do you know
of? I, myself, am familiar with just eight or ten. And even these
blogs have a diverse audience. 

Bloggers are an intelligent lot who don’t surf the Internet for
information alone. It’s possible that bloggers may find advertising
to be some kind of intrusion on their space. So, we need to
understand the pulse of the audience before we advertise. 

Also, the kind of advertisements made for blogs will have to be
very interesting; conventional ads may not appeal to the visitors or
bloggers themselves. The ad should be of such a quality that it
should be capable of turning the discussion on the blog to the
advert itself. Now that’s a real challenge! Ad networks in India also
don’t have a lot of blogs within the network, and therefore there is
a problem in terms of the supply of contacts in this area.

I am sure the option of blogs holds a lot of promise, but I would
personally be more interested in using blogs as an initial step in any
ad campaign, and then continuing with the regular media that are
currently in use.

Rajiv Gopinath
Media Director, 
Madison Media

India has 1.7 per cent Internet penetration, so potentially 18 million
bloggers, but in reality there are a few thousand blogs so far. Advertising
on blogs is still based on automatic services. However, the potential of blog

readership is far more than most leading newspapers. 
My blog has Google AdSense and Amazon referrals. The software

selects what ads to display based on the blog content, for instance C*S*F
(Chiens Sans Frontiers): http://desimediabitch.blogspot.com. We are giving
away our AdSense earnings as cash for blogging. Being inexpensive, blogs
are turning to be attractive for advertisers, and, you pay only if someone
clicks on your ad, so your budget is never wasted on what eyeballs the
blogger ‘claims’ to attract. Each and every cent spent is accounted for. Can
a print or outdoor ad offer such an honest deal? 

Blogs hold potential for future marketing, as product advertisers can
communicate directly with customers, bypassing middlemen. Word-of-
mouth and other direct media also come into play. A Google ad can come up
anywhere on any blog, based on Google’s automatic algorithm that selects
the ads for bloggers who subscribe to its revenue programme. As time passes,
the accuracy of this target-practice becomes more and more efficient.

As told to Preethi Chamikutty (preethi_chamikutty@thinkdigit.com)

Anyone?
Advertising on blogs in India is not popular at all. I have yet to see

private companies and multinationals approach bloggers
individually. The only advertising that’s popular is Google’s

AdSense—a unique programme that’s caught the eye of the blogger. 
I don’t have any ads on my blog since I don’t need any funds. I gave up

the idea as I felt the ads would clutter the interface of my blog, which I
wanted to keep slick and clean. However, the only option I had earlier was
AdSense. If I receive an individual offer again, I will certainly consider it. 

Blogging is newer than other forms of media, and yet has picked up
very fast. When you have blogs with about three to five thousand readers
per month, it makes sense to advertise. I feel advertising on blogs is the
cheapest method of advertising to a specific audience. Pay bloggers even
Rs 1,000 a month, and they will gratefully put up your ad.

It’s a good medium for advertising companies to exploit, but sadly,
they are yet to get hold of it. Advertising on blogs is extremely
lucrative, as readers begin to trust a blogger.
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Should You IT-enable Your Sales Force? 
Mobiles, PDAs, laptops, the works—do selling agents need them or not? 

MobiApps is a provider of hybrid terrestrial and satel-
lite technologies for commercial communications,
which allows companies to remotely monitor and

manage critical infrastructure assets such as fuel levels,
water resources and other utilities in real-time. The distri-
bution of MobiApps solutions across India is done by TACO
MobiApps Telematics (TMT) Ltd, a joint venture between
Tata AutoComp Systems (TACO) and MobiApps. 

“As a provider of solutions that include fleet manage-
ment, asset tracking, telematics, metering and security, ours
is not a tangible product that can be taken along and dis-
played to buyers. To showcase our solutions, we need to pro-
vide the sales team with a mobile computing system through
which customers can assess the features of the solutions. 

“Each and every person in the TMT sales team is
equipped with a PDA phone. The sales force is also pro-
vided with laptops—again, an instance of using wireless
technology—which helps them have continuous, unin-
terrupted access to data, and also enables synchronisa-
tion of the communication taking place, say, from the
central location to any other part of the nation. 

“Apart from being IT-enabled—such as being connect-
ed to a central fileserver—the sales team also responds to
e-mail queries. Moreover, there is a Customer Relation
Management (CRM) system in place, and a toll-free num-
ber for customers. 

“I can safely say that we have employed a higher
degree of wireless communications to showcase our
offerings. On an average, we have invested nearly
Rs 50,000 per head in order to achieve connectivity. 

“Having this kind of access to live data is crucial to
the sales force when interacting with potential cus-
tomers. We think technology is a necessity to doing busi-
ness in this day and age, and, it also increases the possi-
bility of closing a sale.

“In our case, without this kind of live connectivity we
would not have been able to close 30 to 50 per cent of the
sales we have hitherto achieved. Equipping the sales force
with technology is the need of the hour.”

Originally incorporated in 1984 under the name
Bookwing Publications & Trading Company Ltd,
the name was changed to Navneet Publications

India Limited in 1991. A private sector player in the
publishing industry, the company sells guides,
workbooks and general books under the Navneet, Vikas
and Gala brands. 

“I personally look after the sales for 16 states in India
(excluding Maharashtra) with a team of 138 sales
personnel. All our sales executives need to popularise
our products, regardless of which rung of the
management ladder they are at. 

“At present, only six members in the sales team who
are involved in the direct promotion of our educational

CD-ROMs have been given laptops. Apart from that, 22
junior managers have been provided with mobile phones. 

“One obviously cannot market books over the
phone—so tele-sales is a no-no. Nor can we simply
distribute brochures to buyers. A mere presentation
using a laptop will not do justice to the books we offer.
The customers need to see the actual book, academic or
otherwise, before they can purchase it.

“Our sales force visits educational institutes and
coaching classes in these states. Essentially, our sales
force does a physical sampling—we provide a sample
copy of a digest or guide to teachers, who first read the
copy, and then recommend its features to their students.
Based on that response, we launch the particular
product in the market. 

“It is only when marketing our electronic products,
such as our CD-ROMs, that we need to make a presentation
using a laptop. 

“We do not equip the majority of our sales force with
mobile phones or laptops, not because it would be a
financial overhead, but because equipping them with
those hi-tech gadgets is not really required. 

“Moreover, considering the kind of products we deal in,
I doubt if a requirement to equip the entire sales force with
hi-tech gadgets would arise in the near future.”

As told to Renuka Rane (renuka_rane@thinkdigit.com)

“IT-enabling the sales team is
essential to increase sales” 

“Majority of our sales force is not
IT-equipped since it’s not needed”

Pradeep Jadhav
Senior Area Sales Manager,
Navneet Publications

“To showcase our
solutions, we need to

provide the sales team with
a mobile computing system
to enable customers assess

our product features”

“A mere presentation 
using a laptop will not 
do justice to the books we
offer. Buyers need to see 
the actual book before 
they can purchase it”

Amitabh Satyam
Country Head, 
MobiApps 
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Digital Leisure l Touched by Tech

Renuka Rane

“Never before has teach-
ing science been so
joyful and innovative,

with students showing so much
enthusiasm for learning,”
exclaims Kamal Peter, who has
been teaching science at the
Kendriya Vidyalaya Malleswaram
(KVM) in Bangalore for almost 20
years. Peter is referring to using
Oracle’s Think.com programme,
a globally hosted online educa-
tional environment designed for
primary (ages 7 to 12) and
secondary (ages 13 to 16) school
students and teachers. 

Think. com makes use of
personal Web pages as well as

powerful communication and
collaboration tools—and it’s all
free of cost.

A New Paradigm
In Education
A member of the Educational Tech-
nology Focus Group for the
National Curriculum Framework
2005, Peter claims to be highly
involved in all sources that make
learning more interesting and
enjoyable for students. 

She says, “I feel Think.com
falls under the paradigm of ‘A3—
anytime, anywhere and anyone’
information. Thanks to the
training by Oracle, we teachers
are no longer techno-phobic, and
can now demystify technology
for children.”

Technology Beyond Work115 132
Leisure
Digital

The visually-rich Think.com
breaks the monotony of regular
chalk-and-blackboard teaching
by providing a highly interactive
interface. According to Peter, “A
bit of adapting is all that is
needed to get meaningful inter-
action from your students.”

Ease Of Learning 
Think.com is a part of Oracle’s
Education Initiatives programme.
Launched in 1999 in the UK,
Think.com now serves more than
1,50,000 students and teachers
around the globe.

Members have their own
personal Web space within a
protected online community,
where they can exchange e-mail,
create Web pages, upload images,

Touched By Tech

117How VoIP Is
Shaping Up

Illustration Pradip Ingale

Oracle’s Think.com is a pedagogical treat for students and teachers alike

A Think-Tank For Students

A Paradigm
Shift

Britney Tops
Virus Charts



master trainers selected by KVS.
The master trainers will, in turn,
train school administrators in the
KVS schools. The teachers trained
by the master trainers will imple-
ment, train and support other
teachers and students in their
respective schools.

The aforementioned  Kendriya
Vidyalaya Malleswaram was one
of the 25 schools to successfully
pilot the Think.com project.
Students at KVM continue to use
Think.com in their day-to-day
learning in both curricular and
extra-curricular areas.

“Oracle’s collaborative learn-
ing environment provides the
opportunities for our school to
be part of an increasingly highly-
connected world. Kendriya
Vidyalayas can now communi-
cate and collaborate with the
global student and teaching
community,” said R Jamuda,
Commissioner, KVS.

A Global Learning
Community
Essentially, Think.com uses the
Internet to create a protected
online environment where
unfavourable elements not
suited for young children are
eliminated or not given access. 

Through Think.com, primary
and secondary school students
and teachers from around 
the globe can communicate,
collaborate on projects, share
ideas, exchange information 
and enliven classroom-learning
experiences through real-
world discussions. 

Think.com provides a tool set
to easily create custom lessons
that simultaneously engage
students in technology, subject
area curriculum, and the power
of a global learning community.

Think.com provides global
online interaction, and thereby,
greater avenues for partnering
with teachers and students
worldwide. Akin to a Web-based
student community, each student
has an e-mail account and
personal Web pages. 

Students can post messages,
assignments, and even audio
and video clippings. They can
exchange information not only
with the other member schools
spread across the world.

Instant Interaction
Peter also co-ordinates with Janet
Damon, librarian of the Oakland
Elementary School in Colorado,
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in the USA. Damon is involved in
a project on Indian culture,
information on which she is
getting from Peter and her
students in Malleswaram.

“I have been interested in
Think.com since I saw the
programme demonstrated at the
International Society for Tech-
nology in Education conference
in the US last year. The project 
I am working on is a lesson 
in Indian culture and society for
my students in Denver, Colorado.  

“I teach in a very diverse
neighbourhood; my students live
in an urban community and
some do not travel very much to
other countries. 

“Through Think.com I taught
a unit to my students about the
culture, geography, and customs
of India. Ms Peter was a wonder-
ful resource and partner; she has
been enthusiastic about provid-
ing information on learning
about Indian weather such as
the monsoon when I taught that
portion,” says Damon.

She adds: “I asked my
students to write letters intro-
ducing themselves to Indian
students asking questions about
this incredible country. I am trav-
elling to India in July, and these
letters are travelling with me to
schools from Goa to Bangalore 
to Pondicherry.

“At the schools I visit, I plan to
present these letters and a digital
video of my school community
and students. I hope to create
partnerships with Indian teachers
and students and to use
Think.com as the medium for
connecting our students in a
human way that is only possible
with technology.”

In The Future 
Students get a wider platform to
express their ideas and inde-
pendent thinkers and curious
learners can learn more through
this live and happening
medium. With educators using
Think.com in the classroom, the
Internet is fast becoming a ubiq-
uitous learning tool. 

At the same time, a broad-
band connection is a must-have
to facilitate this catching
concept. India Inc needs to lever-
age its people, technology and
resources to promote meaning-
ful change and make education a
fun learning experience across
the nation. 

renuka_rane@thinkdigit.com

Oracle is
helping
students
meet the
challenges 
of the
information
age.”
Krishan Dhawan
Managing Director, 
Oracle India Pvt Ltd

and host collaborative learning
activities with other members. 

An added benefit is that
HTML is not needed at all for 
the Web site to function.
Powered by the Oracle Database
and Oracle Collaboration Suite,
it allows users to easily add text,
audio and video to their
personal pages, and interact
with other members.

Accessible from a standard
Web browser, members can stay
connected to their classrooms
from home, school or the library. 

Think.com In India
The Kendriya Vidyalaya
Sangathan (KVS) will roll out the
Think.com initiative to over 900
Kendriya Vidyalaya schools in
India in a phased manner. 

Krishan Dhawan, Managing
Director, Oracle India, says,
“Oracle Education Initiatives are
Oracle’s philanthropic efforts to
catalyse learning at all levels of
education by leveraging the
company’s core competencies in
information management and
Internet technologies. By invest-
ing in the education of today’s
students and partnering with
governments and academic
bodies, Oracle is helping
students counter the challenges
of the information age.”

A precursor to the rollout is
the successful Think.com pilot
projects conducted in two govern-
ment schools and 25 Kendriya
Vidyalaya schools in Delhi and
Bangalore in 2004. 

Dhawan adds: “The task of
rolling out Think.com to all the
900 KVS schools is already under-
way. By the end of 2006,
Think.com is expected to touch
over 50,000 people.”

As part of the rollout, Oracle is
training a core group of about 40

Think.com is visually rich with a highly interactive interface
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Punch cards were originally
designed for which of the

following machines?
a. Computers           
b. Cash registers
c. Printing presses  
d. Weaving looms

Which of the following 
companies’ computers ran

the Multics operating system?
a. Digital Equipment      b. IBM  
c. Honeywell                  d. Compaq

What is meant by the term
‘browser-safe colours’?

a. Colours that are seen the same
way in Windows and Mac
b. Black print on white background   
c. Colours that remain unchanged in
image editing programmes
d. Colours that are not variant of the
original colours

What does PIP stand for?
a. Private Internet Protocol

b. Program Initiation Procedure
c. Personal Internet Portal
d. Printer Integrated Plotter 

Which company has the
distinction of manufacturing

and marketing the first
commercial digital PC?
a. IBM             b. NCR
c. DEC             d. DG

What was the important
concept that DOS 2.0

introduced to computing?
a. Windows                b. Internet
c. Subdirectories       d. Mouse

Which of the following
devices were not used to

input data into computers?  
a. Telegraph keys
b. Reel-to-reel tapes
c. Paper tapes with holes punched 
in them  d. Telephones

What is meant by 
BT Fusion? 

a. BT’s wireless handset 
b. BT’s new broadband service 
c. The 2005 Seminar by BT 
on convergence 
d. British Telecom’s new 
mobile-cum-landline phone 

What does ADB stand for? 
a. Absolute Data Byte 

b. Apple Data Bus
c. Apple Desktop Bus 
d. Apple Data Byte

10

9

8

7

6

5

4

3

2

Across
7. 3.5-inch diskette hanging 
limply (6)
8. Unilateral (3,3)
9. Application-Specific Integrated Circuit (abbr) (4)
10. Favourite snack among 
hackers (7)
11. Hardware blows-up in 
hot vapour (5)
13. Change e-sachet to 
confiscate (7)                                                  
16. Terminated programme transforms red boat (7)
17. Distinguishing quality of 
a product (5)
19. Writing for the blind (7)
20. Maximum value of power on the highest point (4)
21. Man rig upsets space between text and the edge
of the page (6)
22. Web browser plug-in to view 
compressed files (6)

Down
1. Disorderly group of people from electronic media
(5,3)
2. Electronic Privacy Information Centre (abbr) (4)
3. Computer language ’Ada’ was named after this famous
mathematician (5)
4. An object oriented database management system (abbr)
(6)
5. Decode upsets rich deep (8) 
6. Start off hut to write programme code (4)

12. ‘K’ in K-map (8)
14. Draft of movie revolutionises a main tic (8)
15. Database of medical publications in the UK (7)
18. A component of Sun microsystems is a coffee seed (4)
20. DC deliberately made to flow (4)
20. Clickstream in a route (4)

Crossword 

Got an
interesting
question? 
Send it in with
the answer to
editor@thinkdigit.
com
Mark ‘TQ’ in the
subject area

Of PIPs And Punch Cards 
What is the name of the
first laptop that was sold by

IBM in April 1986?
a. PC-Portable       b. Convertible
c. Lapbook              d. PC-SX

1

May 2005 Solution 

Answers

Most numbers on a
phone keypad have

letters assigned to them.
For instance, the letters for the
number ‘2’ are a, b and c. But
there are no letters assigned to
the numbers 1 and 0.

These numbers remain
unassigned because they are
the so-called flag numbers,
kept for special purposes such
as emergency or operator
services. Previously, Q and Z
were also not included on the
keypad, meaning that you
could not dial a word such as
Quincy. Q is now assigned to
the number 7, and Z to
number 9.

Did you
know?

Send in your Crossword answers with
complete contact details to
TQ@thinkdigit.com.
One lucky participant
will win the ‘Webster’s
New World Computer
Dictionary’
by Bryan Pfaffenberger, 
published by IDG Books 
India (P) Ltd.

6.NCR
7.Subdirectories
8.Telegraph keys
9. British Telecom’s
new mobile cum
landline phone
10. Apple Desktop

Bus 

1.Convertible
2.Weaving looms
3.Honeywell 
4.Colours that are
seen the same way
in Windows and Mac 
5.Personal 
Internet Portal

Win!

There was no winner for the May 2005 
crossword. Better luck next time!
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The Age, Melbourne, June 7

A Bit More Focus On
Apple/Intel... Perhaps
GARRY BARKER, A columnist for the Melbourne daily
newspaper, The Age, has reported on wars, political
movements, coups and counter coups. But his true calling
was Technology. As the Technology Editor, his comments on
Apple’s move to Intel throw up some interesting comments

So, now that some of the dust is subsiding and the stampeding
herds are headed for the bars, may we offer a couple more
thoughts on the forthcoming change in processor suppliers
at Apple:

1. Jobs used Intel processors in the boxes he built at NeXT, the
computer company he founded after he was kicked out of Apple
(OK, he lost a palace revolution) in the mid-80s. Some say he was
replaced by John Sculley, which is not so, since Jobs was not at

the time the CEO. However, return the
mind to NeXT. It had Intel inside.

2. NeXT and its Unix-based
operating system were bought by Gil
Amelio during his brief and inglorious
period as Apple’s CEO. He also hired
Jobs as consultant, which resulted in
the departure of Amelio and the
rejuvenation, resurrection and
resurgence of Apple.

3. NeXT OS is the base on which
Mac OS X was built. As Jobs observed at the World Wide
Developer conference in San Francisco last night, Mac OS X has
always run on Intel processors. It’s just that at the time, and so
far, Apple used PowerPC a RISC chip designed by a team formed
by Apple, IBM and Motorola. Motorola dropped out, although
Freescale, a Motorola spin-off chipmaker, still makes the G4s that
are in PowerBooks and iBooks.

4. IBM has had big problems improving clock speeds and
reducing heat from its G5. Yields were also a problem, causing
delays in delivery of Power Mac G5 boxes.

5. Apple needs a 3 GHz PowerBook. Jobs said last night that
the PowerPC is unlikely to deliver that kind of performance, and,
more importantly, low power drain and low heat output, in time
for Apple to remain competitive in the important notebook
market. Somewhere around 30 per cent of Macs sold are
notebooks; maybe more.

6. With video becoming ever more important to consumer
electronics, and with competition looming from devices such as
the PlayStation, Xbox, and a heap of stuff already starting to
cascade from the mega-factories in China, Apple also needs
faster, more powerful computers, of whatever form the designers
and engineers next produce.

So, finally, what does it all mean? It is a change of
processor. It will require a lot of engineering work, but not so
much as you would think. And for the rest of us ... will we
notice? I doubt it.

These days it does not matter who makes the chip or how it
works. What is important is what it does. Mac OS X will run on the
Intel chip. It will still be Mac OS X. Version 10.4 (Tiger) will
continue to be upgraded, one supposes, and Version 10.5
(dare we suggest it will be called Leopard—because the story
goes the leopard can change its spots (processor)—will be out
in a year or so.

All of our much loved features (and the very few that bug us)
will be there. Life will go on.

Read more at http://snipurl.com/fq1h

CNET.com, June 2

Five Reasons Social
Networking Doesn’t Work
MOLLY WOOD, SECTION editor at CNET.com, engages in
ruthless industry analysis in the form of the Daily Buzz
and keeps track of tech interests in the Weekly Buzz
Report. Her take on why online networking sites won’t
work is indeed interesting

The word on the street lately is that social networking is in
trouble. Friendster has introduced its for-pay blogging tool as an
all-too-ironic money-making scheme. Business networking site
LinkedIn started charging for its job listings. Business 2.0 has an
article about how the indie music networking site MySpace is, for
all intents and purposes, the only successful site. 

Social networking is labouring under the inescapable
weight of the dot-com curse: you have to find the money. No
matter how cool your idea is, it’s dead on arrival without an
actual business plan. At least, that’s the theory. If that’s true,
though, why has blogging, which seems like a neat idea
dependent on interest but without a concrete revenue stream,

managed to not just
thrive, but really
dominate the Web? Is
it really true that
free services can’t be
effective business
plans? Or is it
possible that—gasp!—
social networking
isn’t really that
tenable an idea after
all? Here’s my list...

1. There’s nothing to do there
As Business 2.0 points out, a simple destination site won’t cut it.
My big beef with Friendster was always, "Well, what would I do
there?" Visiting most social networking sites is akin to getting
invited to a party where all the cool kids are going, then showing
up and finding out there’s no food, no drinks, no band...

2. It takes too much time
Yes, I know I can choose where to devote my time, but Orkut,
Friendster, and even LinkedIn are interesting but less
information rich than news sites, blogs, Google news, or...

3. Traffic alone isn’t enough
The reality of the new Web is that traffic alone just doesn’t cut it.
You can get all the visitors you want to your site, but you can’t
just blanket the thing with ads and hope to survive.

4. Strangers kind of suck (or, put nicely, the social
hierarchy is really not that attractive)
Getting to know people is, frankly, a less attractive proposal than
it first seems. Suddenly, you’re bombarded with date offers or
all-too-frequent postings about the unsavoury or just plain
uninteresting habits of the strangers you suddenly know. 

5. We already have the Internet
The only lasting argument about social networking is that these
networks are a valuable resource if you’re adrift in the sea of
online information. But the argument’s a little thin in a world
where search is the king of the hill. If I need information online, I
can find it.

Read the full article at http://snipurl.com/fq1j

MediaWise



eWeek, June 6

Don’t Punish VoIP—Or Its Users
EXECUTIVE EDITOR OF News at eWeek.com Chris Gonsalves
has been a strong advocate for the use of VoIP over the years.
But he’s not too happy with the way some of the products are
shaping up and, in his own inimitable style, makes it known

I didn’t switch to voice over IP at home because it was better. I went
to VoIP because it was cheap. What is it about that equation that
the FCC bureaucrats can’t fathom? Is it so complicated that hand-
wringing columnists and legislators who can’t spell “IP” just don’t
get it?

VoIP service is barely OK. It is marginally better than a military
field phone. I can tell when the anti-virus software on my PC is

updating in the middle of a
phone call. It doesn’t work when
the power goes out. It
sometimes doesn’t work when
the power comes back on.

What does it cost to buy my
acceptance of such
transgressions? Sadly, a mere
$24.99 a month. As with my boat
and my motorcycle and anything
I’ve ever bought at Wal-Mart, I
got what I paid for. The less I
pay, the crappier the stuff, and,

more often than not, the happier I am.
Accepting VoIP with all its rough edges was made easier by two

decades of passable cellular technology. Cell phones so degraded
my expectation of what a phone call should sound like that I’m now
willing to accept the clicks and echoes and dropouts on VoIP.

My grandfather would never have stood for the sound quality
most of us now find routine when we talk on any phone.

But now government agents want to take away my cheap,
crappy phone service. The reason, they claim, is because I’ve been
left in grave danger by unscrupulous VoIP vendors that are denying
me full access to 911. 

Forget about the fact that I agreed to VoIP’s method of routing
911 calls at least a dozen times during the sign-up process. 

You can even forget that a snippy Verizon rep berated me for
cancelling my land lines with the warning that I’d be cooked in an
emergency.

“Yeah, but $24.99 a month!”, I shouted.
“It’s your call,” the rep said.
The bottom line is I don’t care. And neither do most VoIP users

if my e-mail and the Internet forums are any indication. Everybody
knows what VoIP is and what it isn’t. Still, the FCC now says VoIP
service providers must solve the 911 location problem for the lowest
common denominator of VoIP users. 

If the FCC really just wanted to keep us safe, why couldn’t it
have pushed the Bells to make certain that all cancelled land line
jacks still support 911 calls? 

They can do that, you know, and, in some places, they do. I
could have a hot-line phone in my house for emergencies only,
courtesy of Verizon.  I’d buy a red phone and put it under a cake
dish. Alas, Verizon left me with DC power but no dial tone.

I have no doubt an answer will be found that saves VoIP in
some fashion. The service will be dumbed down. It’ll lose its
portability features. It will probably be more expensive, but it’s not
going away. The Bells will get a piece of the action.

Still, I wish the government would concern itself less with
the business model of the Bells and extend to me my right to
get exactly what I pay for, especially when I’m not paying
that much. 

Read more at http://snipurl.com/fq1l

115DIGIT JULY 2005

AdWise

Psst!
Things that are supposed to be private remain private.
That’s the message this great advertisement for Adobe
Acrobat 7 conveys. It shows how even in the most public of
places, one can maintain privacy. And the visual is nicely
shot as well.

Wrestlemania?
This Wired NextFest advertisement pits the HOAP-2 robot
against a sumo wrestler—flashbacks of Terminator anyone?
The future is upon us, robots are getting smarter—let’s just
“HOAP” it doesn’t happen too soon.
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FirstEscape

China seems obsessed
with what effect the

Internet is having on its
youth, as regular readers of
this section will recall. Now,
Chinese state media say the
country will soon release a
set of rules to critically eval-
uate the content of
online games
as part of a
campaign to
combat what
it sees as
harmful influ-
ences on the
young. Xinhua
news agency
said the move
“is part of the gov-
ernment’s efforts
to purify the con-
tent of online
games, prompted by strong
public pleas.”

Under new rules drawn
up by the Ministry of

Culture and the Ministry of
Information Industry,
released in June, game man-
ufacturers are required to
revise game rules that
might lead to addiction.

And the govern-
ment will even
endorse clean
games to young-
sters during the

summer
vacation! The
two min-
istries will
recommend
these as
healthy “pre-
mium

games”.
“Players of

online games are
mostly people under 35
years old,” Zhang Xinjian, a
cultural ministry official,
was quoted as saying on
June 7. “These people are

prone to the negative influ-
ences of sex, violence and
other types of unhealthy
content in online games.”

A report by the cultural
ministry quoted the bizarre
example of a 13-year-old boy
who jumped to his death
from a 24-storey building in a
flying posture, after leaving a
note saying he was joining
three friends, who were char-
acters in an online game.
We’re not sure if it was all
the games that led the boy to
do what he did, but the
report quotes this incident
just as though it was.

To put this report and
the new rules in perspec-
tive, Beijing launched a
nationwide crackdown on
online computer games last
year, banning foreign games
with sensitive political con-
tent. The Ministry of
Culture has already banned
50 electronic games earlier
this year, including FIFA
Soccer 2005 and Microsoft’s
Age of Mythology, ostensibly
because they are addictive.

And to put the extent of
the ‘problem’ in perspec-

tive: Xinhua said China
now has 23 million online
game players, a surge from
13.8 million in 2003. Also,
China saw sales of online
games in 2004 soar 47.9 per
cent to 2.47 billion Yuan
(Rs 1,300 crore).

Think you have the most beautiful,
most innovative desktop around?

e-mail with subject ‘My Desktop’
and your postal address to
mmyyddeesskkttoopp@@tthhiinnkkddiiggiitt..ccoomm,,  and
Digit will publish the most 
eye-catching of them each month.

Siddharth’s desktop is really easy on the eye
Sent in by Siddharth Agarwal, Bangalore

My Desktop

“There is no greater
imperative for any
business, than the

necessity of getting right
people, in the right jobs. All
value creation flows from
that.” That’s a great head-
line for a job site—but for
this job site, the headline is
an embarrassment: it’s got
no jobs to search through!

Even better is the fact
that right on the top banner
where it says “3P consult-
ants Pvt. Ltd.”, they claim
they’re “Corporate India’s
First Choice”. Huh? With a
Web site like this one, with
only two clickable links?

Oh yeah, the clickable
links. 3P consultants seems
to have liaisons of some sort
with Penrhyn International,
and there’s one link to them;
we’re also to suppose that
they’re a member of the
Association of Executive
Search Consultants, to which
there’s another helpful link.

And that’s about all
there is on the page. Well,
there are several other
links as well, such as “Our
firm”, “Our beliefs”,
“Clients” and so on, but
they’re, well, not clickable.

www.3pjobs.com

Podcasts: A Collector’s Passion
A filmmaker who has been collecting digital artefacts for 25
years is amassing the world’s largest collection of podcasts.
Jason Scott, a 34-year-old documentary filmmaker from the
Boston area, has saved and catalogued more than 340 GB of
online amateur radio since he started in February.

A Full Year On A Single Charge!
Logitech has launched a cordless notebook mouse that
promises to be powered for a whole year on a single AA
battery charge. The V200 features a battery-light indicator
that notifies the user when the batteries are running low. The
V200 will cost £34.99 (Rs 2,765).

The winner
receives a
copy of
‘Webster’s New
World Computer
Dictionary’
by Bryan
Pfaffenberger, 
published by IDG Books 
India (P) Ltd.

‘HARMFUL INFLUENCES’

China Will Vet Online
Games

Illustrations: Harsho Mohan Chattoraj
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DATA IN THE WRONG HANDS

Most eBay
HDDs Contain
Sensitive
Stuff

We reported earlier in
this space that a hard

disk containing sensitive
data belonging to the
German police had been
sold on eBay for �20 (Rs
1,100). And now, from a
survey carried out by the
O&O company based in
Berlin, called Data, Data
everywhere, it turns out that
of the 200 second-hand
hard disks bought on eBay

and scanned for stored
information, over 70 per
cent contained personal, or
accurate and detailed, busi-
ness data.

In some of the cases,
the discovered data was
very highly sensitive, seri-
ously jeopardising the secu-
rity and budget of the hard
disks’ previous owners. The
Berlin-based company also
announced by means of
this study the methods
used to recover the data
stored on these hard drives,
which are legal and avail-
able for interested parties.
Using the O&O UnErase
and O&O DiskRecovery
applications, the data was
quite easy to be tracked in
the case of over 70 per cent
of the cases tested.

It’s terrific: of the 3.3
millions files discovered,
the specialists from O&O
in the course of the survey
managed to recover almost
40,000 files generated by
Microsoft Word, 15,000
Excel files and the contents
of approximately 50 e-mail
accounts. The best part is, all
the information was found
in the same shape as used by
their former owners.

This is an area of seri-
ous concern, and experts
list a variety of ways using

which data should be erased
from a hard disk that’s about
to be chucked. These vary
from the straightforward,
like formatting the disk sev-
eral times over, to the
extreme, like physically
burning it.

YOU’RE NOT ALONE

E-mail
Addiction, A
Phenomenon

If you check your e-mail
several times a day,

including when you don’t
really expect new mail,
and even feel silly about it,
you’re not alone! It turns
out that e-mail ‘addiction’
is a pretty common
phenomenon.

The Opinion Research
Corporation conducted a
methodical study to find
out more about this. The
study, sponsored by AOL,
was conducted on about
4,000 adults in the 20
largest cities in the United
States, and revealed several
interesting facts. 

Forty-one per cent of
respondents start the day by
checking their e-mail—

This month’s winner is 
Ankur Varshney

Bjarne Stroustrup is to
programming what Steve
Jobs is to desktop
computing. He is credited
for making programming

more
logical,
rational
and
powerful.
Stroustrup
is the
inventor of
the C++

programming language,
widely regarded as the
most powerful
programming platform. 

With C++ as his tool,
Stroustrup revolutionised
the use of object-oriented
and generic
programming techniques
in application areas
where efficiency is of
the essence.

Apart from
implementing the object-
oriented paradigm in
programming, he has
made significant
contributions to
distributed systems,
design, programming
techniques and software
development tools.

Stroustrup has
shared his ideas about
C++ widely. His book, The
C++ Programming
Language, is one of the
most widely-read books
of its kind, and has been
translated into at least
18 languages. The book
has achieved cult status
in colleges worldwide.
He later released a book,
The Design And Evolution
Of C++, which offered
new insights into the
description of the way a
programming language
was shaped by ideas,
problems, ideals
and constraints.

Programming
Paradigm
Pioneer

People Who
Changed

Computing

He wins
‘Use Case Modeling’
by Kurt Bittner and 
Ian Spence
Published by
Pearson 
Education 
(Singapore)
Pte Ltd 

My Tech Kebabs!

WIN!
The ‘Professional DCOM Application Development’ book just by sharing an amusing picture with a tech
angle to it. The picture should be shot by you, and should not have been published anywhere earlier.
e-mail your picture with subject ‘Digi Pick’ and postal address to digipick@thinkdigit.com. The prize-
winning picture will be published each month.

B Stroustrup

Illustrations Harsho  Mohan Chattoraj



meaning the first thing
they do upon getting out
of bed is check their e-
mail! On an average,
respondents admitted to
checking their e-mail five
times a day. The average US
e-mail user has two or
three e-mail accounts and
spends about an hour
every day reading, sending
and replying to messages.
US residents are so hooked
on e-mail that some check
for messages in the
bathroom, in church and
while driving.

About a fourth of respon-
dents acknowledged being
so addicted to e-mail that
they can’t go more than two
or three days without check-
ing for messages. Now that is
addiction!

TOUGH NEW LAW

Sweden Bans
Net
Downloads

In the first such move that
we’ve heard of, Sweden’s

Parliament has passed a law
that will make it illegal to
download copyrighted mate-
rial from the Internet, effec-
tive July 1, and has approved
measures to discourage peo-
ple from burning copies of
CDs and DVDs. The law also
outlaws technology and soft-
ware used to circumvent
copy protections on copy-
righted material, including
music, movies and games.

Members of the
Parliament argued the
usual way—that musicians
and film-makers, for exam-
ple, have the right to
receive proper payment for
their work.

It happens that Sweden
has been plagued by one of
the highest rates of piracy
in the world, according to
industry officials. Until
now, it was only prohibited
to make copyrighted mate-
rial available for others to
download, while it was legal
to download it yourself. The

scope of the new law does-
n’t end there: it also makes
it illegal to copy an entire
book in a copying machine,
including textbooks 
in schools.

So how will the law ‘dis-
courage’ people from burn-
ing CDs and DVDs? There’s
been a tax slapped on
recordable CD and DVD-
discs. Consumers will have
to pay an extra tax of 1.75
kronor (Rs 10) for a 700 MB
disk. Also, the price of a 5
GB DVD is expected to rise
from 10 kronor (Rs 60) to 30
kronor (Rs 180).

An interesting aside to
all this is that a huge
Swedish torrent site, The
Pirate Bay, already has a
message on the main page
of the site saying “By the
way, we will NOT shut down
on the 1st of July.”

118

Escape

Wise men over the years have said,
“Change is the only constant”. We

couldn’t agree more. Living in the
technology world, we have to embrace the
changes that come about at a rapid pace
and a big change is currently taking place
in Team Digit. As we bid goodbye to our
executive editor Sachin Kalbag with a
heavy heart, it is time to welcome the new
Ed, Deepak Ajwani. “It’s been a great ride,
but as I had said in my last month’s
editorial- “Yahan Par Hamarai Kahani
offbeat ho jaati hai, this is where we part
ways,” said Sachin. So, as Deepak finds his
feet in the Digit-al world, let’s give him a
warm welcome, shall we?

Speaking of
changes, there are
some more that
have been made
to this issues’

DVD and CD. They both carry unique
content now and will also no longer need
a browser to install. Yes, we said it earlier
too, “change is the only constant”. A lot of
time and energy was spent debating ways
to improve the DVD/CD combo further and
the results are there for all to see. Kudos
to Robert and Ishan who have successfully
implemented it (and as usual, in a tight
timeframe). Be sure to let us know how
you like it.

This month was also a ‘sick’ month
given that three team members were down
and out of action for a while. Changes in
weather and the seemingly never-ending
wait for the elusive monsoon finally took a

toll. It could also have
been all the 4th
anniversary
celebrations that
happened, you know!

Move Over
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Networking
Every device you buy today

boasts of one or more ways
to network it. however, not all of
us are as comfortable with
networking terms. We hope this
will help...
CAT: CAT5/CAT6 are fifth and
sixth generation Ethernet
twisted pair cable standards
defined by the Electronics
Industries  Association and
Telecommunications Industry
Association (EIA/TIA). CAT has
nothing to do with felines.
Usage: Someone brought a cat
to the office, but unfortunately
the cat had a liking for CAT
cables. Now we're planning on
implementing a WLAN!
Network Address: A network
address is a unique identifier for
a computer on a network.
Computers determine the
addresses of other computers
on the network and then use
these to send messages to each
other. An example of a network
address is the Internet Protocol
(IP) address, or the Media
Access Control (MAC) address.
IP: An IP address uniquely
identifies computers on a
network. It can be private, for
use on a LAN, or public, for use
on the Internet. IP addresses
can be assigned as static IPs (by
a system administrator) or
dynamic IPs (on demand,
automatically, by another device
on the network).
MAC: Device manufacturers
permanently burn a Media
Access Control (MAC)
identification into networking
devices, so that they can be
identified easily. Using a MAC
address authentication,
computers can ensure that they
connect to the right destination
everytime, preventing fake
devices from claiming to be the
destination for data. 
Usage: There was a hack
attempt recently, some guy got
hold of a networked IP address
on our WLAN. He then used
that address to spoof himself
and identify with the WLAN
and started deleting files at
random. Chaos ensued, but our
systems engineer used a
lookup to find his MAC address,
which we then traced to his
internet IP address. His current
address is jail!
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.XXX OKAY

ICANN
Approves
Adult TLD

It’s been in the coming (no
pun intended) for quite

some time now, but the plan
for a .sex TLD (Top-Level
Domain), amongst others
has finally been approved. As
it turns out, it’s not to be
.sex, but .xxx. The Internet’s
primary oversight body,
ICANN (Internet Corporation
for Assigned Names and
Numbers) approved a plan
on June 1 to set the stage for
pornographic Web sites to
use new addresses ending
with .xxx. ICANN said it
would begin negotiations
with ICM Registry, run by
British businessman Stuart
Lawley, to iron out technical
issues and prices for the new
Web addresses.

Adult-oriented sites, a
$12 billion (Rs 52,200 crore)
industry, could begin buying
addresses with the .xxx TLD

as early as fall or winter
depending on ICM’s plans,
ICANN spokesman Kieran
Baker said. The new
pornography suffix was
among 10 under
consideration by ICANN,
which also recently approved
.jobs and .travel domains.

ICM contends, rightly we
may say, that .xxx Web
addresses, which it plans to
sell for $60 (Rs 2,600) a year,
will protect children from
online smut if adult sites
voluntarily adopt the suffix,
so filtering software used by
families can more effectively
block access to those sites.

But it’s in that
‘voluntarily’ that the
problems lie. “It will further
help to protect kids,” said
John Morris, staff counsel at
the Washington-based
Center for Democracy and
Technology. Morris, however,
predicted some adult sites
will choose to buy .xxx
addresses, but that others
will continue to use .com. 

Compiled by Aditya Kuber,
Ram Mohan Rao and

Renuka Rane

OK. We discovered there are a lot of sites out there that label
themselves as ‘useless’, but this one takes the cake. There

really is nothing up there on the site!
Of course, there is something. It’s all text and a couple of

screenshots, and it goes like this: “This site is basically about
nothing. You can’t buy anything or play games or look at dirty
pictures or read a dull blog...”

Fair enough. But the site’s creators also have a plan, as in
the following: “As the site has no real content, my challenge is
to see just how much interest we can generate.”

So what were they thinking? How did they expect the site to
generate traffic? Did they pepper the source code up with very
interesting keywords? There’s also a “How can I help” section,

where one is urged to spread
the news of the existence of the
site via word of mouth and
more. But why would one want
to promote their site for them?
Soul-searching questions.

The site’s creators say the
site has been mentioned on
istockphoto.com and jam-
sarts.com, and that they’ve
been receiving more hits as a

result. Now what were they thinking? We mean istockphoto and
jamsarts: why did they bother to mention this site? We’ll never
get to figure that one out, unfortunately.

Now here’s the most interesting part: since 22 August 2003,
the site has received 18,915 hits at the time of going to print.
We wonder how.

whatweretheythinking.com

Disconnected Life 
http://disconnectedlife.weblogs.us/

Nvidia, TWIT and G4
I plan on grabbing the new nVIDIA card later this
month. I hear that the new 7000 series are coming
out this month and the price of the 6800 I want
will drop considerably then. 

Twit... This Week in Tech! Yes they know the
acronym spells twit and they call people twits who
watch it... I guess it’s clever for nerds. It’s honestly
a great podcast show. In case you don’t know what
that is, it’s a Web radio broadcast that you can
download. Weekly, the guys from the old screen
savers (Pat, Leo, Yoshi, Kevin) and some times
other lesser known techies from the show, have an
hour long broadcast. Basically, it’s the screensavers
radio show. So for this I love it. I missed it when G4
(which apparently stands for girls, gaming,
gadgets, and gear) castrated the show then beat
it with a bat ‘til all the fanboys cried. I find it is
fun to listen to it while I work on my 3D studio
max stuff or just surfing the net for something
in particular.

1000 Degrees Below Zero
http://biohazard11.free.fr/

Techo-Starship modeller/Web resource
Here’s an enormous Web resource for scale spaceship
modellers. I’m not one, as I’m cheating and working 3D
most of the time. These guys take days (months) with

real materials when I can drop a few volumes with my
favourite CG (Computer Graphics) package. I’ve also
found there a guy who has made the Alien IV’s Betty
from scratch. And his looks better than mine.

AdSense Digest
http://adsense-digest.blogspot.com/

Alternative traffic sources
I had close to 33,000 clicks in May and around
600,000 AdSense impressions. My average pay per
click comes roughly less than 30 cents or so.
Unique visitors 187,000 according to my awstats.
Roughly 80% of my traffic referrals come from 7
major universities (4 American, 2 Canadian, and 1
Swedish) who included link to my site in various
journal/article references and abstracts on their
pages. I assume that most of my traffic is
comprised of students.

Techbook
http://sandeep.weblogs.us/

PyS60 Pre-Alpha links fixed on forum Nokia
A couple of days back, Christopher Schmidt was
trying out the pre-alpha release of Python for Series
60, and was surprised the camera module was not
working on his 6600 (the camera module is not
supported on 3650, but is supported on 6600 and
upwards). Well, the reason was apparently a broken
link on Forum Nokia’s download page… it’s fixed now.

Our hodgepodge of
blog postings this
month has it all—
from online resources
on scale spaceship
modellers to buying a
gaming machine and
other geeky
ramblings

www.anotheruselesswebsite.co.uk

www.anotheruselesswebsite.co.uk



Good Anniversary Issue 
I am 69 and a subscriber of Digit for the
last three years. I eagerly look forward to
its arrival every month during the first
week! As a part of my recent renewal I
got the three CD pack of Britannica and
it is giving me a useful time. So was the
CD ‘Greatest 102 Freeware’ that came
with June issue of Digit. A big ‘thank
you’ and hope you keep it up.

M S Ramachandran
Via E-mail

Dear Mr Ramachandran,
I am glad that people at your age too share a
passion for technology and read our
magazine for an update on tech-knowledge.
Thank you for your kind words. We will not let
up in our endeavour of giving our readers the
best.

—Editor

There’s Spyware In My
DVD/CD
I am a reader of Digit for over 4 years,
and as a concerned reader, I am deeply
disturbed that Digit is promoting
Spyware disguised as ‘Free Games’. In
your June issue, you gave 30 so-called
free games, but in reality, it contained
lot of Spyware and Adware, thanks to
Microsoft Anti-Spyware Beta 1, I was
able to detect it on time before it could
jeopardise my PC. I always thought that
Digit is a responsible and reliable IT
magazine. But to be
frank, sadly, this
once
responsible
magazine has
become
mockery and
for few bucks
from the
Spyware and
Adware sites, you
people are
promoting, showing no concern for the
security of the end-users of PC. You can
always take the plea that the was a
user agreement to be clicked ‘Yes’
before installing the Spyware games
but most of the PC users have habit of
overlooking these user agreements, I
honestly believe that it is your moral
responsibility to protect the interests of
your readers by not fiddling with the
security of their PCs. I know that you
guys will show this mail the way to

dustbin. I feel pained to write this, you
people have lost my faith in you, so to
be frank I am stopping to buy Digit
which I always bought from the nearby
newsstand.

Mahesh Parrikar
Goa

Dear Mahesh,
With the increase in the number of Anti-virus
and Spyware detectors, there are no
standards to define Spyware. What one anti-
virus programme considers harmless adware,
Microsoft’s Anti-spyware Beta 1 may detect it
as Spyware. The task has become increasingly
difficult to identify what is malicious, and
what isn’t. For example, Adware that Norton
Antivirus ignores shows up as a Trojan with
Avast or Kapersky anti-virus, and vice-versa.
A couple of the games distributed on the DVD
and CD in our June issue are Ad-Supported
freeware, while others are completely free. In
order to offer the best possible protection
from malicious code we scan all software to
be included in the DVD or CD with Norton
Antivirus (with high heuristic scanning), Avast
anti-virus, and Spybot Search and Destroy
Spyware cleaner. We think this is the ideal
combination of trusted software to test for
malicious code. 

We thank you for informing us of the
detection by Microsoft Anti-spyware, and, 
will look at including it in our testing process
as well.

— Editor

Broadband, Narrowband…
With reference to your editorial in May,
I would like to bring to your notice my
personal experience with broadband. I
have a 128 kbps Hathway connection at
home and one 256kbps BSNL
connection at office. Despite your
observation, I have no complaints
against my cable broadband where I
usually get speeds above 128kbps
throughput (checked through
ZDNETIndia website) in stark contrast
to a measly 30-40 kbps on BSNL. To rub
the salt on our wounds, the
representatives of the department are
busy blaming each other whenever we
try to register a complaint. 

It seems they don’t even have a
complaint cell; we need to call 198 and
they always send a telephone
technician who ends up saying
everything is fine with phone line. If
the government itself has such a
callous attitude, how can anybody even
think of getting broadband in India? At
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Digit Forum

To post your comments on Digit Forum, 
visit www.thinkdigit.com/forum

Difference Between C and C++

damnthenet
Analogue Novice
Location: Chennai
Even I’m only learner when it comes to
programming. The difference between C
and C++ technically is that the former is a
structure oriented language and the latter,
an object oriented programming language.
When it comes to usage in companies, it
entirely depends on the purpose. What the
company feels better enjoys the priority.
Daniel Moses
****************************************

devilhead_satish
Resident Techie
Location: Mumbai
Why i ask you Why? Why should you use
C++ in the age of Microsoft.net Tech and
loads of other futuristico programming
apps. If you cite speed as the reason. i’ll tell
you that it wont be long before everyone
has a GigaHertz Guzzler. Apps in C++ take
horrendously long to make. Even a simple
form will take you a day to build which is
readily available in .Net . 
****************************************

Calcatian
On A Warning
The throne at the royal palace of Smiley
Kingdom!

If there is one thing you guys are good at-
its making a thing as much complicated as
possible. Don’t worry imagineer_aman, here
is a simpler explanation. 

You see “C” has got no class, so if you
wanna be a digital majdoor and spend your
life away with humongous code-crunching,
then “c” is gonna be your tool. And belive
me, you will get a good job, people all over
the world will use firmwares and other
good stuff that you wrote but no one will
know your name.  

Now, C++ on the other hand is all classy
(not classic-that’s C), so if you are like me
you will learn C++ lingo (like I did when I
was your age) and quickly upgrade yourself
to its latest offspring VC++.net (which is a
gr8 thing contrary to what some bozos may
say as apps developed with it runs
noticably faster than any other RAD tool)
and earn your shot to fame. 

For example, if I disclose my real
identity in here, no matter who they are or
where they’re from, 99.99% of the
members will instantly recognize me .So
there you have it. 

(Now, I wonder why I tend to use lots
of parentheses whenever i’m typing
anything)
***********************************

escape7
Resident Techie
Location: New Delhi

Mathematically u can say: ‘c’ is a subset of
“c++”
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least these cable wallahas attend to
complaints; at BSNL, I don’t even know
till date (trying for two months now),
who the right person to take my
grievance to is. 

Pradeep
Via E-mail

Congratulations for completing four
successful years as India’s Best Tech
magazine. You guys are still unbeatable!
Convergence is truly going to be a part
of our lives, but I fear that factors like
cost, infrastructure for setting it up in
mass and compatibility will pose a
problem in the Indian market. 

It was a real disappointment for me
to read the editorial “Broadband, Narrow

minds”.  Right
now in India,
broadband
Internet is not
restricted only
through cable.
With BSNL
entering with
reasonable rates
and good
service, as well
no headache of
extra cable
laying and
wiring hassles, I
see no reason for

people to wait for ISPs to give Broadband
through cables. I live in a region of
Ahmedabad where none of the ISPs;
Satyam, Icenet, etc; provide broadband
service even after two years of their
existence in Ahmedabad. The option was
to go in for either for Tata or Reliance,
but their offers were not as attractive. 

BSNL, though, gave me a 256 Kbps
connection at Rs 500 per month (apart
from the initial cost of Rs 3,100) on my
telephone line within three days of
inception of its service. So I don’t get the
point as to why people living in big cities
like Mumbai should be at the mercy of
their MSO for a broadband connection. 

Nitin Gajjar
Ahmedabad

I read your columns that advocate ‘real’
broadband in India. The current
situation is pathetic. I have had a long
trail of interactions with Iqara. The
situation seems hopeless. I did not fall
for the stupid MB packages but even
with the unlimited connection, I am

stuck with a slow 40kbps line that rarely
works well. This is their ‘broadband’.

Considering how ignorant majority
of the net users are about what an MB
means, there should be laws on
minimum disclosure as regards MB
packs and what the meaning of
broadband really is.

Harshad Oak
Via E-mail

Dear Pradeep, Nitin and Harshad, 
You can yourselves compare the varied
reactions from different geographical areas and
judge the consistency (or the lack thereof) of
our broadband service providers. Moreover, the
MSO problem arises where the cable operator
has a large subscriber base that is potentially
also a subscriber to the Internet (broadband or
not in reality is a debate for another day)
service that the MSO may provide. Until the
MSOs actually start their service, they will not
let anyone else walk away with their potential
market! As for BSNL, the service is as unique as
your individual experience! 

—Editor

Problems with April Issue
DVD
I am regular reader of Digit and am
very happy about the fact that the Fast
Track series will be covering varied
subjects on computing. This is one of
the reasons I buy Digit.

But when I bought the April issue,
(with the book about Viruses), my
adrenaline rush was gone when DVD
was unable to run even a single file.

When I contacted news stand, I was
told he had nothing to do with this.
Since I was not a subscriber, I thought
you won’t be replacing the DVD.

When I was going through your
June issue, there was good news. In the
Digit Forum column, I found out that
even some of your other readers also
had the same experience and how they
got the fresh copy. 

I thought I might also try for it... 

Raghavendra Prabhu
Mangalore

Dear Raghavendra,
Yes, it’s widely acknowledged that there were
problems with April Issue DVD. Your address
details have been forwarded to our Helpdesk
and you should be receiving replacement DVD
for April within 15 working days.

—Editor

Inbox

Write to the Editor
E-mail: editor@thinkdigit.com

Snail Mail: The Editor, Digit, D-222/2, Om Sagar
Building, MIDC, TTC Industrial Estate, Nerul, 
Navi Mumbai 400 706

Digit will publish the best letters on these pages.
Letters may be edited for clarity. You must include your
complete address in all communication. 

For subscription queries, call the Help Desk at 
022-27629191/9200, Fax 022-27629224, or 
send an e-mail to help@jasubhai.com

Deep In The Core 
Of Technology
I have been a subscriber of Digit for as
long as I can remember. Your Anniver-
sary issue was par excellence and
expectations and the only thing you
now have to beat is yourself. 

In a Utopian society, which is pro-
jected by these thoughts, one is com-
pelled to think of trivialisa-
tion of all earthly pur-
suits, which today drive
mankind. In my under-
standing of the matter,
immortality would take
the juice out of human
life. The fact that our
days are numbered makes
us so special. The beauty of
life lies in the fact that it is limited.
Certainly immortality would end
reproduction, which in fact, would
mean the perpetual inhabitation of
this planet by the same set of people. 

Since we would be immortal, our
intellects would all be used up in fur-
ther perfection, and when the present
people set is out of ideas the society
would essentially become stagnant. 

When originally we were trying to
define Cyborgs as a convergence of
human and machine, and were dis-
cussing the fact that even a clothed
individual could be considered a
quasi-cyborg (majorly human, minorly
artificial), we would then actually
become the same quasi-cyborg (only
this time, majorly machine and
minorly human thanks to conversion). 

The notion that everybody will be
happy is ridiculous (and so is the
notion of Utopia). Human beings
derive happiness from the miserable
state of others. 

Yes, our present way of survival
has destroyed half the planet and our
brains work with body and senses in
compatibility mode. But the idea of a
totally sedated-mechanised-thought-
less-desireless-perfect society is just
too scary. I feel blessed that I shall die
in 70 years without having to experi-
ence this horror.

Still, thanks to Digit for the food
for thought. Under the shell of the
glitzy machinery, your articles have
the light of deep rooted wisdom.

Aritra Das
Via-Email

Letter 

of the

Month



People And Events That Grabbed Headlines—For Better Or For Worse

EMediaWire, a free online
press release service,
reports that Aishwarya

Rai is the most popular Indian
celebrity online.

In the latest results posted
by desifans.com, an Internet
popularity engine for Indian
celebrities, Aishwarya Rai led

the race with 90 points. Shah
Rukh Khan came second with
24, followed by Salman Khan
at 20, Kareena Kapoor at 16,
and Rani Mukherjee at 15.

More details, including a
comparison engine for various
desi celebrities is at
http://www.desifans.com.

Someone seems to have
discovered and unlocked
unused code in the game

GTA San Andreas. Apparently, in
the ‘hot coffee’ mod of the
game, apart from driving and
shooting people, you have to
keep your girlfriends satisfied
with your performance. It
seems when you drop in for
coffee at your girlfriends’
homes, you can ‘do’ them in a
number of positions.

A site, gtasanandreas. net, is
hosting a video clip of steamy
scenes that it says come from
the PS2 version of the game.

If you’re perverted enough
to want to watch sex videos
from a game, the video is
available for you to watch at
http://snipurl.com/fo3f.

It’s a .wmv clip with
additional screenshots. Viewer
discretion advised! You must be
18 or over to view that page!

132

Singapore frowns upon
anything vaguely
pornographic, but most

laws are for print and video—
the Internet is still a grey area.
And it’s in Singapore that sexy
19-year-old ‘Sarong Party Girl’
has hosted her blog, posting
nude pictures of herself on it.

The site is sexually
explicit, with the first few
words on the main page going
“Size does matter...”

Foreigners, too, are
discussing the blog, which
details Sarong Party Girl’s life
and sexual escapades. But Lee
Kin Mun, who writes under the
moniker Mr Brown, said the
online outcry put “unnecessary
focus” on what the girl did.

“The general response from
the blogging community is,
‘What’s the big deal? What's all
this fuss over a pair of
Singapore breasts?’”

Blogging Goes Naked

GTA San Andreas Sex Scenes!

Ash #1 With Desis

Spanish anti-virus firm Panda
Software has produced a
ranking of famous people’s

names used most often to spread
viruses. As an indicator of her
enduring popularity, pop star
and reality show vixen Britney
Spears’ name is used more often
than that of anyone else.

Panda Software says most
virus creators employ the
names of good-looking women
celebrities or other famous
people with which to send their
infected messages. Names often
used included Britney Spears,
Paris Hilton, Bill Gates, and
Osama bin Laden.

A recent ploy used to pass
along various infected messages

rumoured that Michael Jackson
had attempted suicide.

The top ten names on the
Panda Spam list are Britney
Spears, Bill Gates, Jennifer
Lopez, Shakira, Osama Bin
Laden, Michael Jackson, Bill
Clinton, Anna Kournikova, Paris
Hilton, and Pamela Anderson.

Virus writers use such
names to entice users into
clicking Web links or open up
files that infect their
computers, said Patrick
Hinojosa, CTO at Panda
Software’s US subsidiary. “It’s a
method of social engineering,”
he said. “A lot of the time it has
to do with the timeliness of a
current news event.”

Britney Tops
Virus Charts
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